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ABSTRACT 

The goal of this work is to better understand the relationship between the structure 

and function of biological cells by simulating their nonlinear mechanical behavior under 

static and dynamic loading using image structure-based finite element modeling (FEM). 

Vascular smooth muscle cells (VSMCs) are chosen for this study due to the strong 

correlation of the geometric arrangement of their structural components on their 

mechanical behavior and the implications of that behavior on diseases such as 

atherosclerosis. 

VSMCs are modeled here using a linear elastic material model together with truss 

elements, which simulate the cytoskeletal fiber network that provides the cells with much 

of their internal structural support. Geometric characterization of single VSMCs of two 

physiologically relevant phenotypes in 2D cell culture is achieved using confocal 

microscopy in conjunction with novel image processing techniques. These computer 

vision techniques use image segmentation, 2D frequency analysis, and linear 

programming approaches to create representative 3D model structures consisting of the 

cell nucleus, cytoplasm, and actin stress fiber network of each cell. These structures are 

then imported into MSC Patran for structural analysis with Marc. Mechanical 

characterization is achieved using atomic force microscopy (AFM) indentation. Material 

properties for each VSMC model are input based on values individually obtained through 

experimentation, and the results of each model are compared against those experimental 

values. This study is believed to be a significant step towards the viability of finite 
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element models in the field of cellular mechanics because the geometries of the cells in 

the model are based on confocal microscopy images of actual cells and thus, the results of 

the model can be compared against experimental data for those same cells.  
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CHAPTER 1  
 

INTRODUCTION  

1.1. SIGNIFICANCE OF CELLULAR MECHANICS 

MODELING IN MEDICAL RESEARCH 

The ability to model the mechanical responses of cells of physical stimuli presents 

many opportunities to the world of medical research. Chief among these is the ability to 

further our understanding of the ætiology of many diseases [1, 2]. There are a wide 

variety of diseases whose ætiology or clinical presentation are either known or suspected 

to be related to abnormal cellular mechanics, alteration of cellular mechanotransduction 

processes, or changes in tissue structure [2]. Because physical distortion can affect cell 

growth, differentiation, contractility, motility, and apoptotic tendency [2], the ability to 

predict the mechanical behavior of cells in response to pathological conditions and 

medical treatments may be critical to prevention and treatment of many of these diseases 

[2-6].  

1.2. COMMONLY MODELED CELLULAR MECHANICS 

TESTING INSTRUMENTATION 

There are many methods of probing the mechanical responses of cells to applied 

stimuli [4], several of which are commonly modeled. One of the most commonly 

modeled methods for subcellular region probing is AFM, a form of cytoindentation. As 

its name implies, cytoindentation involves indenting a region of a cell with a small probe 
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and can be used to perform indentation force measurement and creep experiments [7, 8], 

which provide information that can be used to calculate the elastic modulus, viscosity, 

and hysteresis of a cell. 

1.3. SINGLE CELL MECHANICS MODELS 

For as long as there have been observations of the mechanical properties of cells, 

there have been models put forth to attempt to describe those observations. At the most 

basic level, there are two categories of these models: continuum and structure-based. The 

first models of cellular mechanics as a “balloon full of molasses” [9] were continuum 

models which by definition lack internal structure [10]. Despite the overwhelming 

evidence in support of structural elements within cells, these types of models remain 

popular with bioengineers due to their relative simplicity and similarity with the earliest 

mechanical principles taught to young engineers. Structure-based models, on the other 

hand, are comprised of one or more networks of discrete structural elements which work 

in harmony to explain the mechanical responses of cells. These models have many 

benefits, but can quickly become computationally expensive. In order to become widely 

accepted by the scientific community, any complete model of cellular mechanics must 

likely take into account aspects of both models, namely the viscoelastic, nonlinear and 

heterogenic mechanical responses of cells as well as their numerous structural 

components and their ability to actively remodel those components in response to applied 

stresses. 
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1.3.1 The Hertz Model 

The most frequently used model of single-cell mechanics for analysis of atomic force 

microscopy (AFM) nanoindentation [11], the Hertzian linear elastic solid analytical 

model [12], is widely recognized as oversimplified because it cannot account for the 

viscoelastic, nonlinear, and nonheterogeneous properties of the cell, as well as its 

compound structure and ability to actively remodel itself [10, 11, 13]. In addition, for 

standard AFM pyramidal tips, the model does not accurately represent the tip geometry 

[14]. However, the Hertzian model’s frequency and ease of use make it an important tool 

for the purpose of comparison [14-16]. Eq. (1) shows the relationship between force and 

elastic modulus as described by the Hertz model for indentation of a semi-infinite 

substrate with a spherical indenter [17-19]: 

(1)   
 

 

 

(    )
 
 

  
 

  

Where F is measured force, E is elastic modulus, is Poisson’s ratio, R is spherical 

indenter radius, and d is indentation depth. In this model the contact radius, a, is 

calculated as: 

(2)   (
   

   
)

 

 
 

Where ER is the reduced elastic given by: 

 (3)  
 

  
 
(           

 )

         
 
(         

 )
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1.3.2. Viscoelastic Models 

Viscoelastic models are also commonly used for analysis of cell mechanics 

experiments. Although viscoelasticity is also a continuum model, and cannot therefore 

explicitly take into account the compound structure of cells, it also provides valuable data 

about the mechanical behavior of cells. The Kelvin model (also frequently referred to as 

the Standard Linear Solid (SLS) model of viscoelasticity) is the most frequently used 

model in the literature due to its relative simplicity, however it has been shown to be 

among the least accurate models of viscoelasticity for the representation of cellular 

mechanics [18, 20-24]. Other commonly used models of viscoelasticity include the 

Quasilinear Viscoelastic (QLV) model, the Generalized Maxwell or Weichert model, and 

the Power Law relaxation model [20, 21, 25-27]. The Kelvin element can be represented 

by a spring in parallel with a Maxwell element (a spring and dashpot in series), the QLV 

model is represented by an infinite series of Kelvin bodies, and the Generalized Maxwell 

model behaves similarly to the QLV model [27] and is represented by a spring in parallel 

with an infinite series of Maxwell elements. The Power Law relaxation model has no 

time constants, springs, or dashpots; it is a purely mathematical tool for fitting a 

relaxation curve. Each of these models is capable of describing experimental data from 

cell mechanics experiments with a reasonable degree of accuracy. Which model is 

selected appears in the literature to be based on the structural complexity of the cell being 

analyzed and the extent to which each researcher is willing to perform complex analytical 

techniques. 
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1.3.3. Tensegrity 

Tensegrity is a theory of cell mechanics that appears to be followed by a small but 

dedicated few researchers. It is based on the idea that structures can stabilize their shape 

by continuous tension, or ‘tensional integrity,’ (like a tent) rather than by continuous 

compression (like a stone arch) – a building principle which has been utilized to varying 

degrees since the day man first used rope to hold flint axe heads and spear tips in place on 

a stick but was not described as a single cohesive theory of mechanics until R. 

Buckminster Fuller coined the term ‘tensegrity’ in 1961 [28]. Fuller initially described 

two broad classes of structures as falling within the definition of tensegrity: geodesic and 

prestressed networks. Geodesic structures are composed of triangular structural members 

oriented along geodesics (minimal paths) to constrain movement, while prestressed 

structures constrain movement through the use of pre-existing tensile stress of isometric 

tension (‘prestress’). The definition of tensegrity has since been broadened and is now 

considered to include tensed networks that resist shape distortion and self-stabilize by 

incorporating other support elements that resist compression. All of these structures 

would fail to maintain their shape when mechanically stressed without continuous 

transmission of tensional forces [28-30]. There is a great deal of evidence of the 

principles of tensegrity at work within the cell, however the extent to which tensegrity 

plays a role in the mechanical behavior of cells remains a source of debate within the 

literature [10, 31-37]. 
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1.4. SINGLE CELL FINITE ELEMENT MODELS 

There has been much effort put into characterizing the behavior of cells using the 

models discussed above throughout the years, however there has not been quite as much 

effort put into utilizing those models in one of the most powerful analytical tools 

available to the engineer: the finite element model. This is largely due to the highly 

nonlinear geometric and material nonlinearity exhibited by cells which until recently was 

more computationally expensive than was feasible on the average personal computer 

[38]. There have been attempts to create 2D finite element models of cells since 

computing power began increasing in the 1990s [1, 8, 38, 39]; however, despite the ever-

growing availability of sufficient computing power for more complex models, only two 

full 3D confocal-based models have been published [1, 40]. Furthermore, of those models 

that have been published, only one has employed large deformations [1], only one utilizes 

a compound structure [1], neither is based on accurate geometries capable of representing 

an entire cellular phenotype, and neither model is validated by comparing its predictions 

against experimental data. If the aims of this application are achieved, finite element 

analysis may finally be able to become a mainstream tool within the field of cellular 

mechanics. The work proposed in this study could also eventually be incorporated into 

multiscale models, providing a key link between the prediction of mechanical responses 

to pathological conditions and medical treatments from the tissue level down to the 

molecular level. 
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1.5. DOCUMENT OUTLINE 

The content of each chapter will be as follows. Chapter 2 will state the aims of the 

current research. Chapter 3 will present the background and review the current literature 

related to the topics required to fulfill the aims stated in Chapter 2. Chapter 4 will present 

research fulfilling Aim 1 in which a 2D axisymmetric finite element model is established 

to investigate the relationship between geometry and mechanical properties. Chapter 5 

will present research fulfilling Aim 2 in which an algorithm is established which is 

capable of analyzing confocal image stacks of cells and automatically generating 

geometric meshes fit for use in a finite element model. Chapter 6 will present research 

fulfilling Aim 3 in which a 3D finite element model is constructed based on geometries 

of actual cells and their structural subcellular features and the model is validated against 

experimental data. Chapter 7 will present the overarching conclusions for the present 

study and outline the recommendations for future work. 
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CHAPTER 2  
 

RESEARCH AIMS 

The goal of this proposed research plan is to build a model composed of structural 

elements representative of those within cells which can be used to accurately predict the 

mechanical behavior of cells as measured by atomic force microscopy (AFM) 

measurements of cells on a 2D substrate. This model would enable accurate estimation 

from imaging data of the mechanical properties of cells in configurations where direct 

mechanical measurement may not be possible. The specific aims are as follows: 

2.1. AIM 1: DEVELOP THE FRAMEWORK FOR A SINGLE-

CELL FINITE ELEMENT MODEL 

The purposes of this aim are threefold. First, to develop a linear elastic finite element 

model (FEM) to show that the geometrical variations due to cell phenotypic differences 

in nanoindentation experiments can significantly alter the estimated elastic modulus 

obtained from the standard Hertz analytical model for AFM nanoindentation. Secondly, 

to incorporate viscoelastic properties observed in AFM studies into the finite element 

model. Lastly, to further develop the model by expanding it to 3D and incorporating 

simple structural elements such as beams and trusses to represent greatly simplified 

cytoskeletal networks. This model will be capable of reproducing AFM nanoindentation 

simulations more accurately than the linear elastic model; however, it will still be 

dependent upon geometric over-simplifications. 
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2.2. AIM 2: DEVELOP A TECHNIQUE TO CONVERT 

MICROSCOPE IMAGES OF STRUCTURAL SUBCELLULAR 

FEATURES INTO REPRESENTATIVE FEM ASSEMBLIES 

In order to incorporate cellular geometries based on microscope images of actual 

cells, we will develop a novel process to generate FEM structures representative of entire 

phenotypes. This will be accomplished by combining an average of AFM cell height data 

with averages of cell boundaries from confocal microscopy images of contractile and 

synthetic VSMCs to generate a representative plasma membrane. Cytoskeletal elements 

will then be analyzed using 2D FFTs to construct representative vector fields and 

statistical analysis tools such as Hough transforms and random walks will be used to 

convert those vector fields into generic representative model structures. 

2.3. AIM 3: INTEGRATE THE COMPUTER-GENERATED 

ASSEMBLIES INTO THE MODEL 

The ultimate objective of the research in this proposed work is to develop a novel 

finite element model composed of multiple networks of microscopy-based structural 

elements that is capable of reproducing data from AFM nanoindentation experiments 

based solely on representative images of the cytoskeletal organization of the synthetic 

and contractile phenotypes of VSMCs. Because the mechanical response of the model 

will be based on the material properties of each component, which are well characterized, 

we believe that such an automated model will function equally well for any phenotype of 

any cell. The results of this model will then be compared to AFM indentation tests 

performed on living VSMCs in media for validation. This type of single cell mechanics 
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model, comprised of a three-dimensional compound structure based on microscopy 

images of the nanoscale structural components of the cell is unprecedented in the 

literature and will be a good starting point for multiscale models of tissue that include not 

only cells but their nanoscale structures as well. Such models would have the potential to 

significantly increase the speed and decrease the cost of development of new 

pharmaceutical drugs and engineered tissue therapies, possibly paving the way for better 

and less expensive health care. 
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CHAPTER 3  
 

LITERATURE REVIEW 

3.1. INTRODUCTION 

 

“The current focus of medicine on molecular genetics ignores the physical 

basis of disease even though many of the problems that lead to pain and 

morbidity [which] bring patients to the doctor’s office result from changes 

in tissue structure or mechanics.” – Donald Ingber [1] 

 

In order to fully and properly understand the physiological mechanisms of diseases at 

the cellular level, it is necessary to have a thorough understanding of how changes in 

cellular structure affect their mechanical properties.  For the better part of the last half-

century, medical researchers and practitioners were under the belief that the cell had no 

internal structural features, but rather that it acted simply as a viscous ‘balloon full of 

molasses’ [1].  Advances in that time have led to the discovery of a complex cytoskeletal 

network that serves to balance and transmit forces throughout the cell thereby providing 

it with the stability required to maintain the complex phenotypes found in tissues 

throughout the body.  Research has also recently shown that the shapes generated by the 

cytoskeleton can influence cell fate, likely via energetic principles as shown in Figure 

3.1[2]. 
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Figure 3.1. (A) Regulation of cell fate by cell distortion and (B) theoretical 

energetic landscape representation of cell fate determination where the xy plane 

corresponds to some configuration of the cytoskeleton and the z axis corresponds 

to the energy required to maintain each configuration; the lowest points in the 

valleys represent specific cell fates and the yellow arrows show a potential path 

from cell growth to apoptosis [2] 

Deviations in the behavior of cellular mechanics and mechanotransduction (the 

process by which cells sense and respond to mechanical signals) have been connected to 

or are suspected to be linked with a wide variety of diseases [1] (a short list is shown in 

Table 3.1), likely through the pathways depicted in Figure 3.2 [3].  By developing 

accurate rheological models cell mechanics, it may be possible to broaden our 

understanding of cellular pathomechanics, leading to more sophisticated treatment 

protocols for diseases such as those listed in Table 3.1.  Furthermore, these models would 

likely be cheaper and faster than current experimentation methods, thereby allowing for 

high throughput of simulated testing which would speed development of new therapies 

(i.e. biomaterials, medical devices, or even engineered tissues) [1, 4]. These models could 

also potentially aid in predicting clinical effects of drugs before they go to market, 

leading to a reduction in harmful side effects. 
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Figure 3.2. Flow chart depicting possible pathways connecting cellular 

pathomechanics to disease states; adapted from [3]  

3.2. THE CYTOSKELETON 

The cytoskeleton was discovered by Kitching in 1954 [5], relatively recently given 

the nearly 350 years [6] of cellular observations.  As such, the precise roles it play in the 

life of the cell has remained a source of much debate to this day.  The cytoskeleton is a 

biopolymer network comprised of several components, including actin stress fibers, 

microtubules, and a variety of structures known as intermediate filaments, and it is the 

primary mechanism responsible for maintenance of cell shape.  The schematic in Figure 

3.3 shows how these structures are typically arranged within cells. 
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Cardiology Angina (vasospasm) C T 

 Atherosclerosis T M 

 Atrial fibrillation M 

 Heart failure C T M? 

 Intimal hyperplasia C T M? 

Gastroenterology Irritable bowel syndrome C M? 

Nephrology Diabetic nephropathy C T M? 

Neurology Facial tics C 

 Hydrocephalus T C? 

 Migraine C M? 

 Stroke C T 

Oncology Cancer C T M? 

 Metastasis C 

Opthalmology Glaucoma C T M? 

Orthopaedics Carpal tunnel syndrome C T  

 Chronic back pain C T  

 Osteoporosis T M 

Pediatrics Congenital deafness C T M 

 Musculodystrophies C T M 

Pulmonary medicine Asthma C T M? 

 Pulmonary hypertension C T M? 

Reproductive medicine Pre-eclampsia C T M? 

 Sexual dysfunction (male & female) C M? 

Urology Urinary frequency/incontinence C M? 

Partial list of diseases whose ætiology or clinical presentation likely results 

from abnormal cell mechanics (C), alterations in tissue structure (T), or 

deregulation of mechanochemical conversion (i.e. mechanotransduction, 

M); ‘?’ indicates that M has yet to be demonstrated experimentally 

 

Table 3.1. Partial List of Diseases related to cellular mechanics [1] 
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Figure 3.3. Schematic of typical cytoskeletal arrangement within an eukaryotic 

cell [7] 

3.2.1. Actin 

Actin microfilaments (f-actin) are 7 – 9 nm diameter polarized polymers comprised of 

globular actin (g-actin) monomers as shown in Figure 3.4.  These microfilaments exhibit 

a highly dynamic behavior regulated by the proteins profiling (+) and cofilin (-). The 

microfilaments are relatively stiff and have a persistence length of 15 µm in dilute 

solution and an elastic modulus of 1.3 – 2.5 GPa [3].  The cortical actin network shown in 

Figure 3.3 is a thin network of microfilaments that surrounds the cell along the plasma 

membrane and is the primary structural component of non-adherent cells such as 

erythrocytes and leukocytes.  In adherent cells, actin microfilaments are also found bound 

together by actin binding proteins to form closely packed arrays known as actin stress 

fibers.  These stress fibers orient themselves largely along the direction of the stress field 

applied to the cell by its surroundings.  A key feature of actin stress fibers is the prestress 
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that is actively exhibited upon them by the actomyosin complexes which are formed by 

the association of myosin motor proteins with the actin filaments [7]. 

 

 

Figure 3.4. Actin microfilament structure [3] 

3.2.2. Microtubules 

Microtubules are highly dynamic polarized hollow tube polymers formed by the 

spontaneous assembly [7] of alternating α and β tubulin subunits as shown in Figure 3.5.  

They often originate from the centrosome near the center of the cell.  These 

microfilaments have a 25 nm outer diameter/14 nm inner diameter, a persistence length 

of 6 mm in dilute solution and an elastic modulus of 1.9 GPa [3]. However, the 

persistence length of microtubules observed inside cells is several orders of magnitude 

smaller than the value measured in solution due to buckling under the stresses exerted 

upon them, [3].  
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Figure 3.5. Microtubule structure [3] 

3.2.3. Intermediate Filaments 

Intermediate filaments are so named due to the fact that their diameter (10 nm) is less 

than that of microtubules but greater than that of actin microfilaments.   Unlike f-actin 

and microtubules, intermediate filaments are not highly dynamic structures and form very 

highly stable structures in the cell. This stability allows them to play an important role in 

cell structure by providing lateral stabilization to buckling microtubules and connecting 

the cell nucleus to the plasma membrane.  There are seven types of intermediate 

filaments (Type I – VII), each expressed in different types of cells. The filaments are 

typically composed of a central α-helical domain of over 300 amino acid dimers that self-

assemble in a staggered anti-parallel array to form apolar tetramers. These connect end-

to-end to form protofilaments, that come together roughly 8 at a time to form a rope-like 

structure (Figure 3.6).  Intermediate filaments have a persistence length of approximately 

1 – 3 µm in dilute solution and an elastic modulus of 1 – 5 GPa [3].  
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Figure 3.6. Intermediate filament structure [3]  

3.2.4. Mechanotransduction 

The process by which cells sense and respond to mechanical signals is known as 

Mechanotransduction.  This process is regulated by the extracellular matrix (ECM), 

transmembrane integrin receptors, the cytoskeletal structures described above, and their 

associated signaling molecules [1].  A schematic of this process is shown in Figure 3.7 

where forces applied either to the ECM cell substrate (A) or directly to the cell (B) travel 

along the ECM   integrin   cytoskeleton pathway. 
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Figure 3.7. Mechanotransduction pathway [2] 

3.3. IMAGING TECHNIQUES 

3.3.1. Overview 

The mechanical properties of any structure are commonly known to be primarily 

dependent upon two factors: its shape and the material it’s made of.  Therefore, in order 

to model the mechanical properties of cells, it is essential to have knowledge of the 

shapes of the structures that form them.  The first images of cells were illustrated by 

Robert Hooke in 1665 and imaging technology has been developing ever since [6].  
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There are now many ways to image intracellular structures, with each making specific 

compromises between resolution and preservation of the live (i.e. in vivo, in vitro, etc.) 

structure of the cells (Figure 3.8).   

 

Figure 3.8. Common cellular imaging techniques and the types of structures and 

length-scales  for which they are primarily used; adapted from [8] 

3.3.2. Widefield Fluorescence Microscopy 

TECHNIQUES 

Visualization of intracellular structures is accomplished in fluorescence microscopy 

by utilizing the interaction of light with fluorescent molecules, known as fluorophores, 

which are capable of binding to the proteins those structures are composed of.  When 
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fluorophores are irradiated by light of a proper wavelength, they emit light at a longer 

wavelength, as seen in Figure 3.9 [9].   

 

Figure 3.9. Spectral profiles of traditionally popular fluorophores [10] 

Though fluorophores are capable of binding to some proteins directly, this is difficult 

to accomplish without some sort of mechanism directing specific fluorophores to specific 

proteins within the cell.  One widely acclaimed technique that has been used to achieve 

exquisite selectivity in biological fluorescence imaging since 1941 is 

Immunocytochemistry, or ICC [11, 12].  This is accomplished by tagging antibodies, 

usually IgG [13], with fluorophores and taking advantage of natural antigen-antibody 

interactions to label specific proteins [14].  Early attempts at ICC focused on tagging the 

specific antibody directly with a fluorophore, however this proved to be a largely 

ineffective method due to insufficient emission by the fluorophores [11].  The more 

sensitive indirect method of immunostaining was later developed in which two 

fluorescently labeled antibodies bind to each specific antibody, as seen in Figure 3.10 

[15].  This technique allows for the emission of twice as many photons as the direct 
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method and is therefore the current standard method of immunolabeling specific proteins 

within cells [16]. 

 

Figure 3.10. Illustration of indirect method of immunostaining  [17] 

3.3.2.1. LIMITATIONS AND SAMPLE PREPARATION 

The predominant limitations of fluorescence microscopy are resolution, the number 

of stains that can be used on any given sample, photobleaching, and background 

fluorescence.  Because fluorescence relies on the interaction of light waves with the 

sample, lateral resolution is limited to approximately 230 nm (based on Equation 3.1) and 

axial resolution to approximately 840 nm (based on Equation 3.2), though they can vary 

based on the wavelength of light used, the numerical aperture of the lens, and the 

refractive index of the medium [18].   

 

Equation 3.1. Lateral resolution (RL) of widefield microscopy, where λ is wavelength of 

light and NA is the numerical aperture of the lens [19] 
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Equation 3.2. Axial resolution (RA) of widefield microscopy, where n is the refractive 

index of the medium [19] 

   
   

   
 

 

Additionally, as seen in Figure 3.11, the absorption spectra of different fluorophores 

can easily overlap to some degree.  Because of this and the relatively long length of 

absorption spectra in relation to the length of the visible spectrum, it is traditionally held 

that only three fluorophores may be used before excitation overlap causes interference 

between signals.  Even with careful selection, it is extremely difficult to find more than 

four fluorophores that can be used synchronously without interference.   

Photobleaching, the photochemical destruction of a fluorophore, can also be an issue 

when using fluorescence microscopy since the entire sample area is typically illuminated 

for extended periods of time.  While photobleaching is a phenomenon common to all 

fluorophores, careful dye selection can aid in mitigating this problem.   

 

Figure 3.11. Illustration of fluorophore excitation overlap [10] 
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Background fluorescence can also often cause problems when using fluorescence 

microscopy.  Some biological proteins, e.g. collagen and elastin, are autofluorescent and 

are therefore naturally capable of fluorescent excitation [20].  Consequently, it would be 

imprudent if examining a specimen containing an autofluorescent substance to select a 

fluorescent dye with an excitation spectrum similar to that of said substance.  Since, as 

seen in Figure 3.9 and Figure 3.11, excitation spectra tend not to be narrow bands, an 

autofluorescent specimen would be limited to even fewer dyes than normal.  Another 

typical cause of background fluorescence is nonspecific binding of the secondary 

antibody in ICC, though this can be minimized by blocking the nonspecific antibodies 

within the sample using serum or albumin, typically from the same type of animal that 

the secondary was grown in [21]. 

Sample preparation for fluorescence microscopy is somewhat conducive to viewing 

cells in their living state.  Some stains, such as those in the CellMask line, are capable of 

being absorbed by living cells, though many stains and most antibodies are too large to 

pass through the cell membrane without first fixing and permeabolizing the cells [14, 22].  

Therefore, some proteins can be viewed in live cells via fluorescence but many cannot 

without the more complicated technique of gene transfection to produce a fluorescent 

version of the protein inside the cell.  However, even though cells may need to be fixed 

and permeabolized before the proteins of interest can be visualized, this process can be 

easily achieved with minimal change to the structure of the cells [23]. 
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3.3.3. Confocal Microscopy 

3.3.3.1. TECHNIQUES 

Confocal microscopes make use of fluorescence staining as well; however they 

provide both enhanced resolution over wide field microscopy and the ability to generate 

three-dimensional images by using a pinhole to block out-of-focus light from the 

detector, as seen in Figure 3.12(a) [1, 24-27].  There are two types of confocal 

microscopes: laser scanning and spinning disk.   

Laser scanning confocal microscopes use a laser to illuminate one very small section 

(of full thickness) of the specimen at a time.  Out of focus like is blocked using a pin-hole 

that is conjugated to the focal plane (hence “con-focal” imaging).  The emitted light from 

the sample is then collected on a photomultiplier tube (PMT), resulting in one pixel of the 

specimen image.  The complete image of the specimen is obtained by raster scanning the 

laser and PMT together very quickly across the entire sample area.  Because each point is 

scanned individually, laser scanning microscopy is capable of producing very high 

resolution images.   

A spinning disk confocal microscope, seen in Figure 3.12(b), uses a Nipkow disk ( 

Figure 3.13) spinning at a high speed to create a series of virtual pinholes.  This 

system allows for visualization of roughly 1000 points on the specimen at any given time, 

thereby allowing the entire sample area to be imaged instantaneously.  Consequently, 

spinning disk confocal microscopy allows for real-time confocal imaging of dynamic 
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systems which can be invaluable in observing biological phenomena [25].  Laser 

scanning confocal often takes more than 10 seconds per frame to obtain a high quality 

image stack, which is longer than most cells remain motion-free [28].  Since spinning 

disk confocal is capable of capturing an entire frame instantaneously, it is a powerful 

technique for high quality video and image capture of live cells. 

 

 

Figure 3.12. Diagram of the two types of confocal microscopes (a) laser scanning 

[26] and (b) spinning disk [27] 

 

Another important function of confocal microscopy is the ability to obtain three-

dimensional images.  This is possible because samples of sufficient thickness contain 

multiple focal planes; due to out-of-focus light getting blocked by the pinhole, each of 

these focal planes can be imaged individually (Figure 3.14).  When these images are 

subsequently combined through the use of deconvolution algorithms and tomographic 

techniques, the result is a 3D image (Figure 3.15).  However, in order to faithfully 

recreate a 3D image the sample must be imaged at least the Nyquist sampling rate; that is, 
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each image in the stack must be offset from its neighbors in the Z-direction by no more 

than half the thickness of the images [29].  For example, if each image is sampling a 

section of a tissue 10 µm thick, then sequential images must be offset by no more than 5 

µm.   

3.3.3.2. LIMITATIONS AND SAMPLE PREPARATION 

While confocal microscopy represents a significant advance from widefield microscopy, 

it too is not without pitfalls.  Being an optical technique as well, its resolution limits are 

still subject to the wavelength of light used.  The maximum lateral resolution (based on 

Equation 3.3) is approximately 180 nm and the maximum axial resolution (based on 

Equation 3.4) is roughly 500 nm, which is an improvement overwidefield microscopy but 

still leaves much to be desired when trying to visualize fine details within the 

microstructure of cells [18].   

 

 

Figure 3.13. Diagram of a Nipkow disk [25] 
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Figure 3.14. Confocal stack of images of dendrites in a rat brain [30] 

 

Figure 3.15. 3D Reconstruction of two confocal images of mouse axons [7] 

 

Equation 3.3. Lateral resolution of confocal microscopy [19] 

   
     

√   
 

 

Equation 3.4. Axial resolution of confocal microscopy [19] 

   
   

√    
 

 

Photobleaching is also still an issue in confocal microscopy.  While less of the sample 

is illuminated at any given time than in widefield (Figure 3.16) the laser light in the 

illuminated area is much more focused and therefore much more intense.  It is also worth 

noting that although only a thin section of the sample area is imaged at any given time, 



33 

 

the entire thickness is still illuminated and thus subject to photobleaching.  

Photobleaching can be limited in laser scanning confocal by scanning the sample at a 

faster rate than normal, though this leads to a great sacrifice in image quality. Fast 

scanning may not be possible in samples that have a weak fluorescent signal and is 

therefore reserved for image setup.  Multi-photon (or two-photon) microscopy techniques 

can achieve confocal resolution with less photobleaching since they only stimulate 

fluorescence of the fluorophores in the focal plane. Sample preparation for confocal 

microscopy is identical to that of widefield fluorescence microscopy.   

   

Figure 3.16. Illustration of widefield vs. confocal illumination patterns [25] 

3.3.4. Scanning Electron Microscopy 

3.3.4.1. TECHNIQUES 

Typically, if one wants to view the structure of a cell down to the molecular level one 

must resort to electron microscopy [18].  Rather than rely on the interaction of photons 

with a sample, electron microscopy instead utilizes the interaction of electrons.  There are 

two types of electron microscopes: the Transmission Electron Microscope (TEM) and 

Scanning Electron Microscope (SEM).   
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In Transmission electron microscopy, an electron beam passes through the sample in 

a vacuum (i.e. a particle-free environment) onto a fluorescent screen to produce a 

transmitted image (Figure 3.17(a)). The setup is very similar to standard transmission 

optical microscopy. Because the electrons must pass through the specimen, TEM requires 

a very thin section (40 – 90 nm thick) which is difficult to accomplish with biological and 

other elastomeric materials using the traditional ultramicrotomy methods of sample 

preparation [9, 31].  The major disadvantage of TEM with regards to mechanics 

modeling, however, is its limitation for creating a three-dimensional view [32].  While it 

is possible to create a 3D image using TEM, images must be captured at several angles; 

however, angular tilt is severely limited by a loss of resolution [33].  

Scanning electron microscopy by contrast utilizes the interaction of the electron beam 

with the surface of a sample in a vacuum to generate an image.  As shown in Figure 3.18, 

the incident beam (primary electrons) displaces orbital electrons from the atoms in the 

specimen thus causing the emission of secondary electrons.  When secondary electrons 

contact a positively charged detector, a point of illumination is generated on a connected 

CRT screen.  Before the primary electrons encounter the specimen, they are bent by 

deflector coils in order to raster scan the electron beam across the sample area.  In 

addition to being connected to the detector, the CRT screen is also connected to the 

deflector coils to allow synchronization of the screen with the scanning electron beam as 

it moves across the sample. 

Some electrons do not collide with orbital electrons, but instead pass near enough to 

the nucleus of the atom that their path is significantly altered (Figure 3.18).  The energy 
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of these backscattered electrons depends directly on the size of the nucleus with which 

they interact; therefore, backscatter detection can be used to distinguish between the 

elemental components of a sample. 

2.3.4.2. LIMITATIONS AND SAMPLE PREPARATION 

The primary limitation of SEM with regards to imaging biological samples is the 

harsh environment and sample preparation that is required to stabilize them.  This 

environment consists of the arid (i.e. non-aqueous), high vacuum chamber mentioned 

previously and radiation from the incident beam and scattered electrons [34].  In order to 

process the samples to make them electrically conductive, it is necessary to coat them in 

harsh chemicals such as heavy metal salts and silver or osmium [34].  While it is possible 

to image biological samples using these techniques, the sample preparation and imaging 

environment (in particular the non-aqueous nature of it) are capable of altering the 

structure of biological materials (i.e. producing artifacts) [34]. 
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Figure 3.17. Diagram of the two types of electron microscope (a) TEM and (b) 

SEM [31] 

 

Figure 3.18. Illustration of electron interactions in SEM [31] 
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3.3.5. Scanning Probe Microscopy 

3.3.5.1. TECHNIQUES 

Scanning probe microscopy techniques such as Atomic Force Microscopy (AFM) 

allow for the imaging of cellular topography with the potential for atomic-scale 

resolution.  This is accomplished by scanning a cantilever with a microfabricated tip 

across the sample using piezoelectric scanners as shown in Figure 3.19.  Measurement of 

cantilever deflection is achieved via reflection of a laser off the cantilever onto a 4-

quadrant detector.  Figure 3.20 shows an example of cells imaged by AFM. 

There are multiple modes of AFM use, the most common of which are contact, 

intermittent (aka tapping), and non-contact.  In contact mode the tip remains in contact 

with the sample and scans the sample at near constant force.  This mode is generally used 

for topographic imaging and force measurements of hard samples and is typically done 

with a sharp, pyramidal tip.  In intermittent mode (a.k.a. tapping mode on Veeco brand 

AFMs) the tip oscillates above the sample, coming into contact with it only briefly and 

intermittently. The tapping amplitude is kept constant as the tip is rastered over this 

surface.  This mode is generally used for topographic imaging and force measurements of 

softer samples, including cells and is typically performed with a pyramidal tip.  Data in 

tapping mode is derived from the height data obtained from the change in piezo distance 

that is required to keep the amplitude of the cantilever vibration constant.  In non-contact 

mode, the tip is brought very near to but not touching the sample.  Deflection of the 

cantilever is caused by van der Waals forces or electrostatic repulsion.  This method is 
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applicable only to topographical imaging and can be particularly useful for imaging very 

soft samples. 

 

Figure 3.19. Schematic of Atomic Force Microscopy  (AFM) [35] 

 

Figure 3.20. AFM images of calf chondrocytes adsorbed on mica substrates. (a) 

Freshly isolated chondrocyte (day 0), (b) chondrocyte released from alginate 

culture at day 11 where the pericellular matrix (PCM) is clearly distinguishable 

from the cell body, (c) chondrocyte released from alginate culture at day 18 shows 

single collagen fibrils emanating out of the dense fibrillar network of the PCM, 

(d) a higher resolution image of the dense network which exhibit fibril diameter 

characteristic of type II collagen fibrils [36] 
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3.3.5.2. LIMITATIONS AND SAMPLE PREPARATION 

As opposed to all previously discussed imaging techniques, sample preparation is 

actually a strength of AFM imaging since the only requirement for AFM sample 

preparation is that the sample (e.g., cell(s)) be be attached to a substrate [30].  Cells may 

be imaged in air or in fluid and can be imaged while alive.  Despite these advantages, 

AFM imaging does have some practical limitations.  First of all, the depth of field in an 

AFM image is restricted by the travel distance of the z-directional piezoelectric scanner.  

Secondly, the depth of field is also limited by the relationship between the tip geometry 

and the surface topography of the sample.  If a large spherical tip is used and small 

grooves are present in the sample, the tip will be unable to fit within the grooves and 

produce a true image of the sample.   

3.4. MECHANICAL TESTING INSTRUMENTATION 

3.4.1. Overview 

There are several methods of probing the mechanical responses of cells to applied 

stimuli, but most fit within two categories: those which probe the entire cell at once and 

those which are more focused and probe only a small portion of the cell at any given 

time.  A brief summary of the length scales and types of structures each of these 

techniques is useful for testing is presented in Figure 3.21. 
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3.4.2. Subcellular Region Probing Techniques 

3.4.2.1. CYTOINDENTATION 

3.4.2.1.1. GENERAL CYTOINDENTATION 

As its name implies, cytoindentation involves indenting a region of a cell with a small 

probe, as seen in Figure 3.22 and Figure 3.23.  There are two variations of this technique, 

general cytoindentation using a cylindrical probe and AFM indentation techniques.  In 

general cytoindentation experiments, a probe (typically made of glass [20]) is indented 

into the cell using a piezoelectric transducer.  Deflection is equal to the displacement of 

the piezo and force is calculated based on linear beam theory, given in Equation 3.5 [10, 

20].  Probe diameters can range from smaller to larger than the diameter of the cell [10, 

16, 17].  Cytoindentation can be used to perform indentation force measurement and 

creep experiments [16, 17]. 

 

Equation 3.5. Linear beam theory equation, where F is indentation force, E, I, and L are 

the elastic modulus, moment of inertia, and length of the probe, respectively, and U is its 

deflection 
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Figure 3.21. Common rheological testing techniques and the (a) force scales and 

(b) length scales for which they are primarily used within the field of cellular 

mechanics; AFM: atomic force microscopy, MTC: magnetic twisting cytometry, 

OT: optical tweezers, MS: microplate stretcher, mPAD: micro-post array 

deformation, MA: micropipette aspiration, SD: substrate deformation,  [3] 
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3.4.2.1.2. AFM MECHANICS 

In addition to its imaging capabilities, AFM is also capable of mechanical 

measurements.  Rather than dragging the tip across the sample, AFM mechanics 

measurements utilize the spring characteristics of the cantilever to measure the force of 

resistance when the tip is indented in the cell.  Atomic force microscopes can be used to 

perform stress relaxation tests that measure deflection of the cantilever over time at a 

constant displacement of the z-directional piezoelectric scanner and nanoindentation tests 

that measure the force of resistance as the tip is indented into the cell (Figure 3.24). 

3.4.2.2. MAGNETIC TWISTING CYTOMETRY 

In magnetic rheological experiments, one or more magnetic particles are either bound 

to the surface of a cell or internalized by it and the resulting displacement of the 

particle(s) in the presence of a magnetic field is measured to quantify their rheological 

response.  Magnetocytometry experiments have been conducted for more than 85 years, 

dating back to Freundlich and Seifriz in 1922 (Figure 3.25) [37].  Early experiments 

based on the work Crick and Hughes in 1950 [38] which build upon that of Freundlich 

and Seifriz used superparamagnetic, ferromagnetic, or ferrimagnetic particles in a 

magnetic field gradient to generate a translational force on cells [6, 29, 32, 33, 39]. 
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Figure 3.22. Cytoindentation [40] 

 

Figure 3.23. Cytoindentation of a single chondrocyte (A) before and (B) after 

indentation with a 5µm-diameter probe [10] 

 

Figure 3.24. Schematic of AFM nanoindentation force measurement [18] 
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Figure 3.25. The magnetic manipulation system used in the first 

magnetocytometry experiments by Freundlich and Seifriz in 1922 [37] 

Due to the inherent difficulty in producing well-controlled field gradients, more 

recent experiments primarily focus on magnetic twisting cytometry (MTC) [20].  In 

MTC, ferromagnetic particles are subjected to a homogeneous magnetic field, which can 

be easily produced.  The method most widely used was developed by Wang et al. in 1993 

(Figure 3.26) and consists of using a strong magnetic pulse to magnetize a large number 

of ferromagnetic particles already bound to a culture of cells and then inducing rotation 

by subjecting the particles to a weaker magnetic field oriented 90° to the earlier pulse 

[41].  The rotation is then measured either with video microscopy or with laser particle 

tracking, which is the more precise of the two [22]. 
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Figure 3.26. Magnetic twisting cytometry [23] 

Magnetic twisting cytometry is generally performed using particles of up to 5 µm in 

diameter that are coated with ligands to specific receptors within or on the periphery of 

the cells of interest.  A sinusoidal magnetic field is produced by Helmholtz coils (Figure 

3.27) which can generate a magnetic torque of 450 – 1200 pN × µm.  The torque is 

limited on the low end by the amount of signal required to overcome the magnetic noise 

of the measurement system and on the high end by the amount of current required to 

avoid excessive heating in the Helmholtz coils.  The resulting cell deformation is 

estimated based on the mean bead rotation angle, which is calculated using a theoretical 

formula (Equation 3.6) based on the change in the magnetic moment of the beads that 

assumes homogeneous bead rotation. MTC experiments are most often used to perform 

creep experiments [7, 42-45]. [44] 

Although most MTC experiments rely on Equation 3.6 and its assumption of 

homogeneous bead rotation, this assumption does not truly reflect reality.  However if 

small enough beads are used, multiple beads can be targeted to cytoskeletal structures 

within each cell.  When video microscopy is used to measure bead rotation, it is possible 

to create a map of bead rotation throughout the cell [7].   
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Figure 3.27. Finite element plot of magnetic field density produced by Helmholtz 

coils; image generated in COMSOL Multiphysics [46] 

 

Equation 3.6. Magnetic bead rotation angle formula used in MTC, where θ is bead 

rotation and B is magnetic moment of the beads [44] 

 (t)   arc cos (
B(t)

B 

) 

 

One advantage of MTC over AFM is that measurements of an entire population of 

cells can be taken at once providing instant homogenization of cell behavior rather than 

probing each cell individually.  Another advantage is that MTC has the potential to be 

adapted for future in vivo applications in humans by using helium-3 magnetic resonance 

imaging (MRI) technology or a superconducting quantum interference device (SQUID) 

to generate a map of the magnetic field [44].   

There are, however, several weaknesses of MTC.  The chief weakness is the difficulty 

in quantifying how the location of particle binding affects the results of each experiment.  

For example, a particle bound to receptors inside the cell will react less strongly to a 

magnetic field than will a particle in the same field that is bound to receptors on the 

outside of the cell membrane. [44] 
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3.4.3. Whole Cell Deformation Techniques 

3.4.3.1. MICROPIPETTE ASPIRATION 

Micropipette aspiration is a simple technique for measuring the mechanical properties 

of cells.  In this technique a constant negative hydrostatic pressure of 10
-1

 – 10
5
 Pa [7] is 

applied to a cell, either in suspension or attached to a substrate, using a micropipette of < 

1 – 10 µm diameter [8] as shown in Figure 3.28.  The resulting deformation of the cell 

into the micropipette is then measured using video microscopy to calculate the 

mechanical response of the cell.  Micropipette aspiration is primarily used for performing 

creep experiments on cells with relatively little more mechanical support than a thin 

spectral cytoskeleton adhering tightly to the cell membrane (generally non-adherent cells 

such as red blood cells (RBCs) and leukocytes) [7].  It can be used to calculate the elastic 

modulus, cytoplasmic viscosity, and Poisson’s ratio of cells, usually without considering 

the effects of friction between the cell and the walls of the micropipette [3, 20, 21, 47]. 

 

Figure 3.28. Micropipette aspiration [40] 

3.4.3.2. OPTICAL TRAP 
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 When a laser is focused through a high numerical aperture microscope objective and 

shined on a refractive particle whose refractive index is higher than that of the medium it 

is in, optical forces are generated.  A ‘gradient force,’ which scales linearly  with volume 

(i.e. has a d
3
 dependence) that pulls the particle toward the focal point of the laser and a 

‘scattering force,’ which scales squarely with volume (i.e. has a d
6
 dependence) [20] that 

pushes the particle away from the focal point of the laser.  These forces can be broken 

down into forces which act radially and axially to the direction of laser propagation.  

With careful selection of particle refractive index and size, the gradient force is capable 

of overcoming the scattering force resulting in the particle becoming trapped at the laser 

focal point.  When two micron-sized trapped particles are coated in ligands which bind to 

receptors on a cell are attached to diametrically opposing ends of the cell they can be 

used to mechanically deform the cell (Figure 3.29).  This technique is known as an 

optical trap.  It can also be performed with a single bead bound to the cytoskeleton of a 

cell that is attached to a substrate [3]. 

 

 

Figure 3.29. Laser/optical tweezers [48] 

Like micropipette aspiration, the optical trap method of cell rheology is generally 

used on very soft cells (e.g. RBCs) for analysis at the whole cell level; however it can 
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also provide valuable information about local mechanics of a cell if the beads are bound 

to the cytoskeleton rather than the cell membrane.  Through analysis of geometry changes 

resulting from oscillatory forces, optical traps can provide the viscoelastic responses of 

cells.  However, optical traps are only capable of generating forces of up to several 

hundred pN [3]; orders of magnitude smaller than AFM and micropipette aspiration are 

capable of [8].  Because of this, it only provides information about the viscoelastic 

response of cells in the low force linear regime [7, 20]. 

3.4.3.3. MICROPLATE STRETCHING 

Microplate testing involves growing a cell on a rigid plate and attaching a flexible 

plate functionalized with adhesion promoting proteins to the top of it as shown in Figure 

3.30.  The flexible plate can then be used to apply a known deformation or force to the 

cell using a piezoelectric translator.  The bending of the flexible plate can then be 

measured using an optic fiber technique.  Microplate stretching can be used to perform 

stress relaxation, creep, oscillatory, and shear experiments on cells with forces ranging 

from 10 nN to 10 µN [7, 20]. 
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Figure 3.30. Microplate stretcher [3] 

3.4.3.4. MICROPOST ARRAYS 

All of the mechanical testing techniques discussed so far have focused on how cells 

react to externally imposed forces.  In order to fully understand the cytoskeletal 

mechanics of cells however, it is also vital to understand the forces built into the 

cytoskeletal network by the cell itself.  This can be achieved by measuring the traction 

forces (i.e. using traction cytometry) of a cell against a patterned substrate of 

polydimethyl siloxane (PDMS) posts attached to a rigid plate as shown in Figure 3.31.  

Because the properties of the PDMS posts are well-known, a force-deflection curve can 

be easily generated in finite element software as shown in Figure 3.32.  This curve can 

then be used to correlate the deformation of the posts with the forces acting on them [49].  
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3.5. SINGLE CELL MECHANICS MODELS 

3.5.1. Overview 

 

Figure 3.31. Cell contraction on microarray substrate [3] 

 

Figure 3.32. Schematic of (A) FEM model for a micropost with a lateral force 

exerted on its top and (B) lateral force determined by FEM [49] 

For as long as there have been observations of the mechanical properties of cells, 

there have been models put forth to attempt to describe those observations.  At the most 

basic level, there are two categories of these models: continuum and structure-based.  The 

first models of cellular mechanics as a ‘balloon full of molasses’ [50] were continuum 

models which by definition lack internal structure [4].  Despite the overwhelming 

evidence in support of structural elements within cells, these types of models remain 

popular with bioengineers due to their relative simplicity and similarity with the earliest 

mechanical principles taught to young engineers.  Structure-based models, on the other 

hand, are comprised of a network(s) of discrete structural elements which work in 
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harmony to explain the mechanical responses of cells.  These models have many benefits, 

as will be discussed shortly, but can quickly become computationally expensive.  In order 

to become widely accepted by the scientific community, any complete model of cellular 

mechanics must likely take into account aspects of both models, namely the viscoelastic, 

nonlinear and heterogenic mechanical responses of cells as well as their numerous 

structural components and their ability to actively remodel those components in response 

to applied stresses. 

3.5.2. Continuum-Based Approaches 

3.5.2.1. THE HERTZ MODEL 

One of the earliest models relevant to cellular mechanics was described by Heinrich 

Hertz in 1882 [13].  Hertz was primarily concerned with describing the mechanics of 

contact between two elastic spheres and as such, built several assumptions into his model.  

These assumptions [51, 52] can be summarized as follows: 

1. Each body is a half space loaded over a small elliptical area 

2. The material properties of each body are homogeneous, isotropic, and linear 

elastic  

3. Deformations are infinitesimal (i.e. small strains) 

4. No plastic deformation occurs over the contact area 

5. The contact surfaces are frictionless 



53 

 

6. The stress resulting from contact vanishes at a distance far from the contact 

area 

7. The thickness (in the case of cylinders) and dimensions of each body are 

infinite 

The equation governing the relation of force of indentation to the elastic modulus of an 

indented sample according to the Hertz model is given below in Equation 3.7 [20, 31, 

53]: 

 

Equation 3.7. Equation governing the force, F, of a spherical indenter on a sample 

according to the Hertz model 
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where E and ν are the elastic modulus and Poisson’s ratio of the sample, respectively, δ is 

the depth of indentation, and R is the radius of the spherical indenter.  Contact area, a, is 

given by the Hertz model as shown in Equation 3.8 below [54]:  

 

Equation 3.8. Area of contact between a sample and a spherical indenter as defined by the 

Hertz model 
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The Hertz model is frequently used to analyze AFM measurements due to its 

simplicity, however this is often not a meaningful method of analysis based on the 

inability of any of the assumptions listed earlier to accurately describe the behavior of 

cells when indented [20, 51].  Despite its inaccuracy, the Hertz model is commonly used 

for comparison purposes since it is the most rudimentary form of analysis and more 

complex analytical methods may not correlate well with one another.  It should also be 

noted that the Hertz model is close to accurate at small strains (up to approximately 10%) 

[31]. 

3.5.2.2. VISCOELASTIC MODELS 

3.5.2.2.1. BASICS OF VISCOELASTICITY 

Cells often exhibit viscoelastic behaviors upon deformation.  Although there are 

many types, or models, of viscoelastic behavior, the same underlying mechanism of 

compound structure is responsible for each of them.  This behavior is most commonly 

described in polymers which derive their viscoelastic behavior from being able to deform 

based on both bond stretching and/or bond rotating (conformational shifts).  In cells, this 

compound mechanical structure consists of the cytoskeletal features discussed in Section 

3.2, which, as discussed earlier, all have different mechanical properties on their own.  As 

these structures work synchronously to resist forces acting equally upon them, each will 

contribute to the behavior of the cell to a different degree.  This accounts for two 

important characteristics of the stress-strain curves of cells.  
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Due to the viscoelastic nature of cells, they do not exhibit a linear region of elastic 

deformation as seen in Figure 3.33 (A), but rather a parametric one as seen in Figure 3.33 

(B).  Furthermore, the dissipation of energy upon loading leads to a different stress-strain 

curve upon unloading.  This effect is known as hysteresis and is characterized by the area 

between the loading and unloading curves. 

 

  

Figure 3.33. Examples of linear elastic and viscoelastic stress-strain curves 

 

In order to experimentally characterize viscoelastic materials, cells included, two 

types of tests are commonly employed: creep and stress-relaxation tests.  Creep tests are 

performed by application of a steady uniaxial stress and measurement of strain over time 

(Figure 3.34 [a]), while stress relaxation tests are performed by the application of a steady 

strain and measuring the resulting stress in the material over time (Figure 3.34 [b]) [55, 

56]. 

3.5.2.2.2. MODELS OF VISCOELASTICITY 

BASICS OF VISCOELASTIC MODELS 

Viscoelastic materials can frequently be thought to act as represented by a number of 

Hookean springs described by  
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Equation 3.9 [56] and Newtonian dashpots (viscous dampers) described by Equation 

3.10 [56] working together in some prescribed arrangement analogous to an electrical 

circuit.  There are an infinite number of possible configurations, however only a select 

few are commonly used to model the mechanical properties of cells.   

 

 

Figure 3.34. Characteristic (a) creep and (b) stress relaxation curves [55]  

 

Equation 3.9. Viscoelastic spring equation, where σ  is analogous to force, ϵ to 

displacement, and k to the Young’s modulus of the spring 

       

 

Equation 3.10. Viscoelastic dashpot equation, where η is viscosity and  ϵ̇  is the strain rate 

      ̇ 

 

Being analogous to the elastic modulus, the units of k are N/m
2
, while the units of η 

are N·s/m
2
.  It is often helpful to consider the ratio of viscosity to stiffness shown in 
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Equation 3.11, which is a constant value referred to as the relaxation time and has units of 

seconds, in the analysis of experimental data since time is a parameter that can be easily 

measured. 

 

Equation 3.11. Viscoelastic relaxation  time constant, τ 

  
 

 
 

 

Comprising the various models are two basic building blocks: Maxwell and Kelvin 

elements.  The first and most simple is the Maxwell element, represented by a spring and 

a dashpot in series as shown in Figure 3.35 (A).  In a “Maxwell solid,” the total strain is 

equal to the sum of the strain in each element, while the stress on each component is the 

same and equal to the applied stress as shown in the equations below, where the 

subscripts s and d represent the spring and dashpot respectively. 

 

Equation 3.12. Maxwell component stress  

σ   σs   σd 

 

Equation 3.13. Maxwell component strain 

ϵ = ϵs + ϵd  
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In order to develop a constitutive equation representing the complete behavior of a 

Maxwell element, it is useful to differentiate Equation 3.12 and then express the spring 

and dashpot strain rates in terms of the stress as shown in Equation 3.14. 

 

Equation 3.14. Constitutive equation for a Maxwell element [56] 

 ̇    ̇    ̇  
 ̇

 
 
 

 
 

 

Equation 3.14 can be simplified by multiplying by k and employing the use of the time 

constant τ as shown in Equation 3.15. 

 

Equation 3.15. Simplified constitutive equation for a Maxwell element [56] 
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When a sudden constant force σ is applied to a Maxwell solid (as in the case of a 

creep test), the elastic spring deforms instantaneously while the dashpot then deforms 

proportionally with respect to time (ϵ(0) = 0) as shown in Figure 3.35 (B).  The equation 

governing the deformation, or creep function, can be determined by solving for ϵ in the 

constitutive equation assuming  ̇ is equal to zero (Equation 3.16). 
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Figure 3.35. Maxwell model of viscoelasticity (a) representation of Maxwell 

model, (b) creep function of Maxwell model, (c) Relaxation function of Maxwell 

model; adapted from [55] 

 

Equation 3.16. Maxwell element creep function [55] 
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The ratio of strain to stress in creep tests is known as the “creep compliance” [56] and is 

defined by Equation 3.17.  Remembering that σ = σ0, this leads to a compliance function 

as given by Equation 3.18. 

 

Equation 3.17. Creep compliance 
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Equation 3.18. Maxwell element compliance function 
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When a sudden constant deformation ϵ is applied to a Maxwell solid (as in the case of 

a stress relaxation test), the spring again responds instantaneously while the dashpot 

responds over time (σ( )    ) as shown in Figure 3.35 (C).  The equation governing the 

relaxation can be determined by solving for σ in the constitutive equation assuming  ̇ is 

equal to zero (Equation 3.19).  Since σ0 is known and σ(t) is measured in stress relaxation 

tests, τ can be easily calculated. 

 

Equation 3.19. Maxwell element relaxation function 

 ( )     
 
 
  

 

The ratio of strain to stress in stress relaxation tests is known as the “relaxation 

modulus” [56] and is defined by Equation 3.20.  Remembering that σ0 = kϵ0, this leads to 

a compliance function as given by Equation 3.21.  Since ϵ0 is known and σ(t) is measured 

during the stress relaxation experiment, Equation 3.21allows for the calculation of k 

which after solving for τ leads to the calculation of η and therefore the complete 

characterization of the Maxwell solid. 

 

Equation 3.20. Relaxation modulus 
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Equation 3.21. Maxwell element relaxation modulus function 

    ( )    
 
 
  

 

VISCOELASTIC MODELS USED IN CELLULAR MECHANICS 

The Kelvin element (also frequently referred to as the Standard Linear Solid (SLS) 

model of viscoelasticity) can be represented by a spring in parallel with a Maxwell 

element as shown in Figure 3.36 (A).  The addition of the parallel spring to the Maxwell 

element provides a limitation of deformation to the Kelvin element which more closely 

represents the nature of biological materials [56].  This spring has a stiffness of ke, so 

named because it provides an equilibrium stiffness that remains after the extension of the 

dashpot in the Maxwell arm has relaxed away the stresses that element. 

In a Kelvin solid, the total stress is equal to the sum of the stress in each arm, while 

the strain on each arm is the same and equal to the applied stress as shown in the 

equations below, where the subscripts e and m represent the equilibrium and Maxwell 

arms respectively. 
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Figure 3.36. Kelvin model of viscoelasticity (a) representation of Kelvin model, 

(b) creep function of Kelvin model, (c) Relaxation function of Kelvin model; 

adapted from [55] 

 

Equation 3.22. Kelvin arm stress 

        

 

Equation 3.23. Kelvin arm strain 

        

 

In order to develop a constitutive equation representing the complete behavior of a 

Kelvin body Equation 3.15 can be substituted into Equation 3.22 for σm.  After 

rearranging terms, the constitutive equation for a Kelvin body is shown in Equation 3.24, 

where τϵ and τσ are the relaxation times for constant strain and stress, respectively.   

 

Equation 3.24. Kelvin body constitutive equation [55] 
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Solving this equation is awkward, however, due to the presence of both stress and strain 

and their time derivatives in the same equation.  It is useful then to use a Laplace 

transformation to change Equation 3.24 from a differential equation to an algebraic one in 

order to make it easier to solve [56].  Denoting the transformed functions with an overline 

and multiplying the time derivatives by the Laplace variable s gives  ( ̇)    ̅ and 

 ( ̇)    ̅ which leads to the transformed form of Equation 3.24 shown in Equation 

3.25. 

 

Equation 3.25. Laplacian Kelvin body constitutive equation [56] 

 ̅  (   
   

   
  

) ̅ 

 

Equation 3.25 can be rewritten to resemble Hooke’s Law (σ    ϵ) by introducing a 

parameter   as shown in the equations below.  This Laplacian version of Hooke’s Law is 

known as the associated viscoelastic constitutive equation and holds true for any model 

of viscoelasticity using the appropriate value of   for each model [56]. 

 

Equation 3.26. Kelvin body parameter,   

     
   

   
 

 

 

Equation 3.27. Associated viscoelastic constitutive equation 

 ̅    ̅ 
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When a sudden constant deformation ϵ is applied to a Kelvin body (as in the case of a 

stress relaxation test), the springs again respond instantaneously while the dashpot 

responds over time (σ( )    ) as shown in Figure 3.36 (C).  The equation governing the 

relaxation can be determined by solving for σ using the associated viscoelastic 

constitutive equation assuming  ̇ is equal to zero (Equation 3.28 through Equation 3.30). 

 

Equation 3.28. Laplace transform of ϵ(t) = ϵ 
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Equation 3.29. Laplacian Kelvin body constitutive equation based on Equation 3.28 
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The Kelvin body relaxation modulus can then be easily solved for by inverting Equation 

3.29 using the inverse Laplace transform    {  (   )}      . 

 

Equation 3.30. Kelvin body relaxation modulus function [56] 
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It is of interest to note that the Kelvin body relaxation modulus function is simply equal 

to the Maxwell element relaxation modulus shifted upward by the value of ke as apparent 

between Figure 3.35(C) and Figure 3.36(C). 

When a sudden constant force σ is applied to a Kelvin body (as in the case of a creep 

test), the springs deform instantaneously while the dashpot then deforms proportionally 

with respect to time (ϵ(0) = 0) as shown in Figure 3.36(B).  Since using the associated 

viscoelastic constitutive equation to solve for strain generated by a given stress is 

awkward due to the parameter   appearing in the denominator, it is easier to determine 

the equation governing the deformation, or creep function, by solving for ϵ in the Kelvin 

body constitutive equation assuming  ̇ is equal to zero (Equation 3.31). 

 

Equation 3.31. Kelvin body creep function [55] 
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The Kelvin, or SLS, model is the most frequently used model in the literature due to 

its relative simplicity, however it has been shown to be among the least accurate models 

of viscoelasticity for the representation of cellular mechanics [14, 21, 53, 57-59].  Other 

commonly used models of viscoelasticity include the Quasilinear Viscoelastic (QLV) 

model, the Generalized Maxwell or Weichert model, and the Power Law relaxation 

model [14, 21, 55, 56, 60].  The QLV model is represented by an infinite series of Kelvin 

bodies as shown in Figure 3.37.  The reduced relaxation function for the QLV model is 

shown in Equation 3.32, where c is a dimensionless constant.   
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Figure 3.37. Quasilinear Viscoelastic (QLV) model 

 

Equation 3.32. QLV reduced relaxation function, G(t) [55] 
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The Generalized Maxwell model behaves similarly to the QLV model [60] and is 

represented by a spring in parallel with an infinite series of Maxwell elements as shown 

in Figure 3.38.  The associated viscoelastic constitutive equation and relaxation modulus 

function are given in Equation 3.33 and Equation 3.34, respectively.  For both the QLV 

and Generalized Maxwell models, it is important to note that by employing the use of a 

large number of elements any relaxation curve can be fit with great accuracy; however 

this situation is rarely representative of the underlying mechanisms governing the actual 

relaxation behavior.  In choosing the appropriate number of elements to incorporate into a 

model, it is necessary to interpret the number of rates of decay in the relaxation curve.  If 

the number of rates of decay is unknown, the constitutive equations can be simplified to 

integral relationships with a small number of fitting parameters by using an infinite 

number of elements.  However, cells often exhibit a fast and slow rate of relaxation [14]; 
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therefore it is often acceptable to incorporate however many elements are required to 

obtain two time constants. 

 

Figure 3.38. Generalized Maxwell model 

 

Equation 3.33. Associated viscoelastic constitutive equation for the Generalized Maxwell 

model [56] 
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The final viscoelastic model of note is the Power-law structural damping model.  The 

Power-law has no time constants, springs, or dashpots.  It is a purely mathematical tool 

for fitting a relaxation curve.  The relaxation function for the Power-law is given in 

Equation 3.35, where A corresponds to the relaxation curve and α governs the rate of 

decay. 
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Equation 3.34. Relaxation modulus function for the Generalized Maxwell model [56] 

    ( )     ∑   
 
 
  

 

 

 

Equation 3.35. Power-law relaxation function 

     

 

These viscoelastic models are commonly used to analyze data from each type of 

experiment described in Section 3.4 [21].  Each of these models is capable of describing 

experimental data from cell mechanics experiments with a reasonable degree of accuracy.  

Which model is selected appears in the literature to be based on the structural complexity 

of the cell being analyzed and the extent to which each researcher is willing to perform 

complex analytical techniques. 

3.5.3. Structure-Based Approaches 

3.5.3.1. MOLECULAR NETWORKS 

The most simplistic model of cellular mechanics which accounts for the internal 

structures of cells is the molecular network model.  These models consist of networks of 

an infinite number of filaments that distort in an affine manner [61, 62] as the network is 

deformed as shown in Figure 3.39.  Molecular networks are useful for analyzing cellular 

cytoskeletal components, namely actin stress fibers [63] and microtubules [64] as Euler-

Bernoulli beams to determine the contribution of each of these structures to the 
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rheological behavior of cells.  However, since these models have the aforementioned 

strict assumptions that do not match experimental observations of cells, do not account 

for the contribution of more than one cytoskeletal filament type, and are modeled as 

networks floating free in solution rather than anchored to a substrate, they are useful 

primarily for gaining inputs for parameters in more realistic models. 

3.5.3.2. TENSEGRITY 

Tensegrity is a theory of cell mechanics that appears to be followed by a small but 

dedicated few researchers.  It is based on the idea that structures can stabilize their shape 

by continuous 

 

Figure 3.39. Deformation of a 3D molecular network model of cross-linked actin 

stress fibers [63] 

tension, or ‘tensional integrity,’ (like a tent) rather than by continuous compression (like 

a stone arch) – a building principle which has been utilized to varying degrees since the 
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day man first used rope to hold flint axe heads and spear tips in place on a stick but was 

not described as a single cohesive theory of mechanics until R. Buckminster Fuller 

coined the term ‘tensegrity’ in 1961 [65].  Fuller initially described two broad classes of 

structures as falling within the definition of tensegrity: geodesic and prestressed 

networks.  Geodesic structures are composed of triangular structural members oriented 

along geodesics (minimal paths) to constrain movement, while prestressed structures 

constrain movement through the use of pre-existing tensile stress of isometric tension 

(‘prestress’).  The definition of tensegrity has since been broadened and is now 

considered to include tensed networks that resist shape distortion and self-stabilize by 

incorporating other support elements that resist compression.  All of these structures 

would fail to maintain their shape when mechanically stressed without continuous 

transmission of tensional forces [65-67]. 

There are two a priori predictions of tensegrity structures based on the principle of 

virtual work [68] that must be satisfied in cellular behavior to be able to even consider the 

possibility that cellular mechanics is governed by tensegrity.  The first and most critical is 

that their level of prestress should be a major determinant of their stiffness [69].  This 

prestress is generated both passively by the extracellular matrix and actively by the 

contractile actomyosin apparatus [4].  Through the use of traction cytometry to quantify 

the prestress of various cell types, several experiments [43, 70-73] have been conducted 

by the Wang and Ingber groups showing that this is indeed a phenomenon observed in 

cells.  Wang et al. have demonstrated that cell shear stiffness, G, increases in direct 

proportion to the prestress in the cytoskeleton, P (G   1.04P) [74, 75].  It is important to 
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note that, as with much of the evidence in support of cellular tensegrity, this relationship 

may have other explanations but is a necessary characteristic of any tensegrity structure. 

The second a priori prediction of tensegrity structures is that cells must behave like 

discrete mechanical networks rather than as a mechanical continuum.  One characteristic 

difference between the two is the ability of local stresses to produce global strains.  This 

property of discrete networks is due to the ability of the structural elements to change 

their orientation and relative spacing due to an applied load until a new equilibrium 

position is achieved and is in direct contradiction with continuum models of cell 

mechanics, in which the strains generated by a local stress have no structural elements to 

travel along and therefore dissipate rapidly away from the point of contact [4].  A number 

of research groups have shown experimentally [41, 76-83] using magnetic twisting 

cytometry, optical and magnetic tweezers, traction cytometry, and cytoindentation 

techniques that this is the case.  In one example of this, Kumar and Ingber showed this by 

surgically severing a single actin stress fiber with a femtosecond laser nanoscissor and 

using traction force microscopy and embedded fluorescence microscopy to observe 

changes is stress within an adherent cell as shown in Figure 3.40 [83]. 
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Figure 3.40. Results of severing a single actin stress fiber on displacement and 

traction forces within an adherent bovine capillary endothelial cell on both 

flexible and rigid ECM substrates [83] 

CORTICAL MEMBRANE MODEL OF CELLULAR TENSEGRITY 

Donald Ingber introduced the concept of a tensegrity model for cellular mechanics in the 

early 198 ’s [84, 85].  There are three different tensegrity models which have been 

proposed by Ingber and others in efforts to accurately model cellular rheology.  The first 

of these is the Cortical Membrane model.  This is a geodesic tensegrity model (Figure 

3.41) that assumes the main load-bearing elements of the cytoskeleton are confined to the 

thin spectral cytoskeleton that adheres tightly to the cell membrane.  Under the conditions 

of this model, the cortical membrane is considered to be under sustained tension which is 

balanced by the compressive forces of cytoplasmic pressure and traction forces provided 

by extracellular adhesions in the case of adherent cells [20].  This model has been able to 
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successfully describe the mechanics of non-adherent cells [86, 87], but has had only 

limited success in modeling the behavior of adherent cells [88].   

 

Figure 3.41. Visualization of expansion and contraction behavior of a 

geodesically structured Hoberman Sphere (Hoberman Toys, Inc.) representing the 

cortical membrane model of cellular tensegrity [4] 

The constitutive equation for adherent cells in this model has been developed using 

magnetic twisting cytometry [89], as shown in Figure 3.42.  In this study, 4.5 µm 

ferromagnetic beads were bound to integrin receptors on the apical surface of adherent 

human airway smooth muscle cells and twisted by a magnetic field.  It was found that the 

shear stiffness, G, of the cells (Equation 3.36) is directly proportional to the prestress of 

the membrane as observed experimentally.   

 

Equation 3.36. Constitutive equation of adherent cells as governed by the cortical 

membrane model of cellular tensegrity [89] 

  
 

 
  
 

 

    

 
 

 

When experimentally based values for h (100 nm), D (4.5 µm), and Pm (10
4
 – 10

5
 Pa) are 

substituted into Equation 3.36, values of G on the order of 10
2
 – 10

3
 Pa are obtained.   
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These values are consistent with experimentally obtained values [75], however there are 

several aspects of this model that are not consistent with experimental observations. 

 

Figure 3.42. Free body diagram of a magnetic twisting cytometry experiment, 

where M is the applied moment, Pm is the prestress in the membrane, h is the 

membrane thickness, D is  the bead diameter, and θ is the measured angle of 

rotation of the bead (equivalent to angular strain of the membrane) [20] 

Firstly, Equation 3.36 predicts that G is inversely proportional to the angular strain θ 

which is equivalent to strain softening behavior whereas Wang [41] and Fabry [43] have 

shown that cells exhibit either stress hardening behavior or constant stiffness in MTC 

experiments.  Secondly, this equation predicts that G in also inversely proportional to 

bead diameter, D, however Wang and Ingber [70] have shown the opposite behavior in 

cultured endothelial cells.  It is thought that these discrepancies arise from the faulty 

assumption of the cortical membrane model that the cortical layer carries only tensile 

force and cannot support bending, as is routinely exhibited by erythrocytes, and that the 

cytoskeleton is limited to the cortical membrane which as has been shown extensively is 

not the case for adherent cells. 
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TENSED CABLE NETWORK MODEL OF CELLULAR TENSEGRITY 

The second of the cellular tensegrity models is the Tensed Cable Network model.  

This model postulates that the cytoskeleton behaves as a reticulated network composed 

entirely of tensile cable elements [69].  In this model, the prestress of the cables is either 

balanced externally by adhesions to the extracellular matrix or internally by osmotic 

forces in the cytoplasm.  Using the assumptions that local strains follow the global strain 

field and all cable orientations in the network are equally probable, Stamenović [90] has 

shown that the shear modulus behaves in accordance with Equation 3.37 

 

Equation 3.37. Constitutive equation for the tensed cable net model of cellular tensegrity 

[90] 

  (        )  

 

where P is the prestress and B is a nondimensional cable stiffness parameter (  

 (     ) (   )).  This constitutive equation has been shown to be moderately accurate 

based on measurements of isolated stress fibers, overestimating G by approximately 20 % 

[20].  Like the cortical membrane model, the tensed network model has been shown to 

describe the behavior of suspended cells very well [87] but incapable of accurately 

describing the properties of adherent cells [88].   

CABLE-AND-STRUT MODEL OF CELLULAR TENSEGRITY 

The final cellular tensegrity model, favored by most tensegrity enthusiasts, is the 

Cable-and-Strut model.  In this model, a prestressed cable net is balanced by 
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compression-supporting struts as shown in Figure 3.43(A) rather than by inflating 

pressure.  As with the previous models, the compression can be balanced by adhesions to 

the extracellular matrix as well.  Unlike the previous two models microtubules are 

modeled as semi-flexible struts which act as compressive elements within the cell by and, 

the tensile elements in this model are represented by actin stress fibers (rather than the 

cortical actin network) as shown in Figure 3.43(B).  Intermediate filaments may also be 

incorporated as additional tensile elements utilized for lateral stabilization of the 

compressive microtubules and connection of the nucleus with the cortical and internal 

cytoskeletal networks for a more complete model.  A useful analogy for this type of 

system is a camp tent.  In this analogy, the microtubules are analogous to the tent poles, 

the prestressed actin stress fibers are analogous to the taut tent fabric, the extracellular 

matrix is analogous to the ground on which the tent is planted and any overhead branches 

to which it may be tethered, integrins are analogous to the tent pegs, and the intermediate 

filaments represent the guy wires used for stabilization of the tent poles.  If a lantern were 

hung in the tent representing (note: not analogous to) the nucleus, the intermediate 

filaments would also be analogous to the guy wires used to secure it in place. 
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Figure 3.43. (A) Cable-and-strut model of cellular tensegrity, (B) Schematic 

showing the force balance between actin stress fibers (or microfilaments), 

microtubules, and the ECM [2, 4] 

One readily identifiable advantage of this model is that it can predict the global 

deformation of a cell due to a local force (as required by the second a priori prediction 

discussed earlier; Figure 3.44[A]) and further that attachment of a round cell to a 

substrate at just a few points of contact results in cell spreading as is commonly observed 

in cell cultures (Figure 3.44[B]).  This model can also be made multi-modular to 

incorporate structures such as the nucleus (shown in Figure 3.44[B]) and the cortical actin 

network (modeled as either a geodesic cortical membrane or a tensed cable net).  One of 

the most prized abilities of the cellular tensegrity model over other mechanics models is 

the ability for stresses applied at the cell periphery to be transmitted to and deform the 

nucleus as shown in Figure 3.44(B) [41]. 

Another advantage is that this model supports the experimental observations that 

stresses induced anywhere along the cell membrane other than at a point of integrin 

attachment to the extracellular matrix forces are not transferred globally throughout the 

structure but rather dissipate locally [29, 41, 70, 91].  Furthermore, this model supports 
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the counterintuitive phenomenon of a tensed member of one size scale to be able to resist 

compression on a smaller size scale [4].  To illustrate this concept, imagine a mouse 

running along the tensile guy wires in our tent analogy.  This is accomplished by 

compression of the guy wire between the front and rear feet of the mouse, but is only 

possible if the guy wire is tensionally stiffened (pre-stressed).  This phenomenon is 

enhanced by crosslinking of tensile filaments into larger bundles which stabilizes the 

lateral connections between filaments to prevent buckling, as is the case for actin stress 

fibers in the filipodia that create the leading edge of migratory cells [92].  Similar 

stabilization of crosslinked microtubules is thought to stabilize cilia and long neurite cell 

processes [93].   

 

Figure 3.44. Cable-and-strut tensegrity models illustrating (A) global 

displacement due to a local force and (B) cell spreading when attached to a rigid 

substrate and becoming spherical when detached from a substrate [41] 
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The theory of cellular tensegrity was initially a purely intuitive model [85], however 

Stamenović determined [90] that the constitutive equation governing the behavior of the 

cable-and-strut model of cellular tensegrity can be expressed as 

 

Equation 3.38. Constitutive equation of the cable-and-strut model of cellular tensegrity 

[90] 

     (    )     (       ) 

 

where P is the prestress of the cables, PQ is the portion of P that is counteracted by the 

struts, B is the dimensionless cable stiffness parameter introduced in Equation 3.37, and 

BQ is a similar dimensionless strut stiffness (    (     ) (   )) determined based 

on the buckling behavior of microtubules [94].  The portion of P that is balanced by the 

substrate is given as 

 

Equation 3.39. Portion of cable prestress that is balanced by the substrate, PS [90] 

        

 

and is the parameter that is measured in traction microscopy [75].  It was shown in [20] 

that this constitutive equation is reasonably accurate, overestimating G by only ~ 14 %.  

Interestingly, if PQ = 0, as is the case when microtubules are disrupted, Equation 3.39 

reduces to Equation 3.38.  This may help explain yet another experimental observation: 

the decreased role of microtubules and increased role of the extracellular matrix at 

resisting compressive stresses in highly spread cells [93, 95].  As PQ decreases PS must 
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compensate, assuming a constant value of P.  This situation is analogous to using a using 

tent poles that are an order of magnitude shorter in length than the length of the tent; the 

tent poles will not bear as much of the compressive force as they would if they were on 

the same length scale as the tent but the tent pegs will compensate by bearing more of the 

force.  This lack of softening, and even occasional stiffening, of highly spread cells such 

as smooth muscle cells adhered to a rigid substrate has been used to contradict the theory 

of cellular tensegrity [96], however, as just shown this is not the case when a 

mathematical analysis of the system is considered. 

Detractors of cellular tensegrity primarily focus on three issues.  The first and most 

troubling to detractors is the presence of compression struts inside the cell [4].  This is 

due to the long-held dogma of biologists that the cell is like a balloon full of molasses.  If 

this were true, however, cell shape would be independent of substrate stiffness [50], yet 

this is not what is observed experimentally [97].  Furthermore, the cell would have no 

mechanism with which to explain the observed “compression wrinkles” that adherent 

cells create on a soft substrate between adhesion points [4, 98].  The second main concern 

that has been raised focuses on the ability of long microtubules that extend throughout the 

cytoplasm to bear compression.  Their ability to do so has, however, been demonstrated 

by Wang et al [74] who showed that a straight, elongated microtubule buckles when it 

impinges head-on with the stiff actin cortex surrounding the cell (Figure 3.45).   
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Figure 3.45. Sequential images of a microtubule, indicated by the arrowhead, 

approaching the actin cortex and buckling upon head-on impingement with it [74] 

The third reason given by detractors for ruling out the relevance of cellular tensegrity 

is that disruption of one element within a single tensegrity module causes the collapse of 

the entire structure, which is not what is observed in cells [83, 91, 99, 100].  This can be 

explained, however, by the multimodular tensegrity structure of cells proposed earlier 

that allows for modeling of the internal cytoskeleton together with the nucleus and the 

cortical actin network.  In multimodular tensegrity structures, destruction of one element 

results only in a local response [4].  This is analogous to the severing of the Achilles 

tendon in which foot stability is lost but the stability of the rest of the body remains 

unaltered.  It is also important to note that although there are alternatives which can 

account many of the controversial aspects of cellular tensegrity, only tensegrity is able to 

provide an explanation for all of the behaviors discussed above (e.g. strain hardening, 

nuclear deformation, prestress, etc.) together [4].   

Despite all the controversy over the issue however, even the most strident critics of 

the cellular tensegrity theory are willing to admit that certain aspects of tensegrity 

behavior may be applicable to cellular mechanics along with the more traditional 

continuum behaviors [99].   
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3.6. EPILOGUE: MULTISCALE MODELING 

Tensegrity architecture can be used to explain the behavior of structures all the way 

from the macro-scale [65, 66, 101] to the molecular scale [2, 4, 102].  The variety of 

tensegrity structures combined with the ability to combine different structures into a 

single multimodular tensegrity structure at each of and between these scales is reflected 

in the structure of living organisms as systems within systems within systems.  For 

example, bones and muscles comprise a cable-and-strut tensegrity system [103, 104], the 

heart and lungs are also comprised of prestressed tissues balanced by blood and air 

pressure, respectively, and even the extracellular matrix throughout the body is 

comprised of prestressed fibers (e.g. crosslinked collagen and elastin bundles) balanced 

by the incompressible hydrophilic glycosaminoglycans (GAGs).  It is this balance that is 

responsible for the spontaneous retraction of wound edges when a tissue is incised by a 

scalpel [105, 106].  It has even been shown that tensegrity may be responsible for the 

behavior of biological polymers such as actin microfilaments, individual proteins, and 

even RNA and DNA molecules [67, 107, 108].  This ability of tensegrity principles to 

describe such fundamental elements of life has led some to postulate that these same 

principles, known since the dawn of civilization yet still not completely understood [99], 

may be able to finally explain the origin of life on Earth [107].  It is evident, therefore, 

that any single model (tensegrity or otherwise) which is capable of fully describing cell 

behavior (e.g. viscoelasticity, nonlinearity, heterogeneity, active remodeling, and 

numerous structural components) will likely also be able to elucidate the mechanisms 
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responsible for mechanics at every length scale and point in the life cycle (e.g. from 

prenatal morphogenesis to geriatric pathology) relevant to life [109, 110].   

Although the tensegrity model shows great promise for modeling the mechanics of 

life, it would simply be much too computationally intensive to create a single model 

which incorporates tensegrity structures at every level from the nano to the macro scale.  

Rather, if these mechanics are to be fully characterized and modeled in a realistic manner, 

multiscale models must be utilized which are each capable of building upon the 

principles of the more fundamental models below them.  Any future model which would 

be capable of taking into account accurate representative cytoskeletal geometries in order 

to elucidate the complex mechanical behaviors (i.e. viscoelasticity and tensegrity) which 

cells routinely exhibit, would be a good starting point for these multiscale models of 

tissue that include not only cells but their nanoscale structures as well.  This type of 

model would finally provide a means to bridge the gap, testified to in the quote that opens 

this review, which spans between the current focus of medical research and the molecular 

basis of disease.  
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CHAPTER 4  
 

EFFECTS OF GEOMETRIC VARIANCE  

IN MODELING OF CELL INDENTATION  

(AIM 1) 

4.1. INTRODUCTION 

Because physical distortion can affect cell growth, differentiation, contractility, 

motility, and apoptotic tendency [1], the ability to predict the mechanical behavior of 

cells may be critical to prevention and treatment of many diseases [1-5]. The most 

frequently used model of single-cell mechanics for analysis of atomic force microscopy 

(AFM) nanoindentation [6], the Hertzian linear elastic solid analytical model [7], is 

widely recognized as oversimplified because it cannot account for the viscoelastic, 

nonlinear, and nonheterogeneous properties of the cell, as well as its compound structure 

and ability to actively remodel itself [6, 8, 9]. In addition, for standard AFM pyramidal 

tips, the model does not accurately represent the tip geometry [10]. However, the 

Hertzian model’s frequency and ease of use make it an important tool for the purpose of 

comparison [10-12].  

In our previous studies, the mechanical properties of adherent vascular smooth 

muscle cells (VSMCs) were characterized using AFM indentation with a spherical probe 

indenter. The spread-out VSMCs exhibiting a synthetic (or proliferative) phenotype were 

found to be significantly softer than elongated contractile VSMCs [13]. To estimate 

elastic modulus and to facilitate comparison with other groups, Hertzian linear elastic 

theory was applied to the data. Equation 4.1 shows the relationship between force and 
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elastic modulus as described by the Hertz model for indentation of a semi-infinite 

substrate with a spherical indenter:  

 

Equation 4.1. The Hertz contact model 
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Where F is measured force, E is elastic modulus, is Poisson’s ratio, R is spherical 

indenter radius, and d is indentation depth. In this model the contact radius, a, is 

calculated as shown in Equation 4.2. 

 

Equation 4.2. The Hertz contact radius 
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Where ER is the reduced elastic modulus, given by Equation 4.3. 

 

Equation 4.3. The Hertz reduced elastic modulus 
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While there have previously been studies investigating the effect of probe tip 

geometry on the validity of the standard Hertzian models for AFM measurements [14, 

15], the diversity of cell shapes and sizes suggests that approximating the cell as either a 

semi-infinite plane [16] or a sphere [17] may also need to be inspected. In this study, we 

used a linear, elastic, solid finite element model (FEM) of VSMC geometries capable of 

reproducing AFM nanoindentation data to determine how variation in cell size and shape 

can affect elastic modulus estimates obtained using the standard linear Hertzian analytical 

formulation.   

4.2. METHODS 

4.2.1. Finite Element Model Formulation 

Contractile and synthetic VSMCs were modeled as axisymmetric structures 

(COMSOL 3.5a) (Figure 4.1). Geometries were based on averages of reported AFM [13] 

and confocal images of the vascular cells with cell heights of 2.0 μm, a contractile cell 

width of 10 μm, and a synthetic cell width of 50 μm indented by a spherical indenter of 5 

μm diameter (Figure 4.1). Cell widths were taken from confocal images as the cross-

sectional width of each cell type at the area of nanoindentation (Figure 4.2).  The model 

was given isometric material properties matching the assumptions of the Hertzian 

analytical model. Previously reported results from the same study were used for the input 

elastic moduli: 15.3 kPa for contractile and 11.1 kPa for synthetic cells. A Poisson’s ratio 

of 0.49 was chosen because it was within literature values [18]. The indenter was 
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assigned the elastic modulus and Poisson’s ratio of borosilicate, 62 MPa and 0.22 

respectively.  

To replicate experiments, the probe was prescribed a displacement of 350 nm (15% of 

cell height) towards the cell at 5 nm increments for the first 60 nm (3% of cell height) and 

at 50 nm increments from 100 to 350 nm. Using Equation 4.1, elastic modulus 

calculations were then performed based on the output force of the model at an indentation 

depth of 200 nm (10 % of cell height), as reported previously [13]. 

4.2.2. Geometric Dependence Testing 

Three sets of simulations were run to determine the susceptibility of the model to the 

geometric inputs (Figure 4.3). In the first set, the diameter of the spherical indenter was 

held constant at 5 μm, while the estimated modulus was determined for cells with widths 

varying from 5 – 100 μm. The second set of simulations varied the indenter diameter 

from 1 – 20 μm while the cell width was held constant at 20 μm. The third set of 

simulations matched the Hertzian condition of a sphere in contact with a semi-infinite 

substrate (i.e. the cell) and the indenter diameter was varied between 1 – 20 μm.  

For all three sets of geometric dependence simulations, an input elastic modulus of 

13.2 kPa was used. This value was the average of the moduli of contractile and synthetic 

cells [13]. Cell heights and all other properties of the model were held constant 

throughout the different simulations at the same values discussed in Section 4.2.1. 
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Figure 4.1. Axisymmetric finite element mesh of a representative contractile 

VSMC (bottom) and AFM probe (top); Inset: representative synthetic VSMC 

(bottom) and AFM probe (top). The contractile AFM probe geometry was given a 

radius of 2.5 µm, the contractile VSMC geometry a half-width of 5 µm, and the 

synthetic VSMC geometry a half-width of 25 µm. Both contractile and synthetic 

VSMC geometries were given a height of 2 µm. The model is meshed using an 

element growth rate of 1.05 from the initial point of contact with a maximum 

element size of 5 nm along boundaries intersecting with the point of initial 

contact. 

 

Figure 4.2. Confocal microscopy images of a single representative (a) contractile 

VSMC and (b) synthetic VSMC.  Cells were stained with Alexa Fluor
®
 488 

phalloidin to stain filamentous actin. Dashed line denotes the cross section used to 

assign the radius used in the finite element mesh geometries based on average 

AFM and confocal images of each phenotype. Scale bars correspond to a length 

of 20 µm. 
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Figure 4.3. Diagram showing the three simulations that were used to determine 

the susceptibility of the model to geometric inputs: (a) constant AFM probe 

diameter of 5 µm with cell widths ranging from 5 – 100 µm, (b) variable AFM 

probe diameter ranging from 1 – 20 µm with a constant cell width of 20 µm, and 

(c) variable AFM probe diameter ranging from 1 – 20 µm with a cell width much 

larger than the probe diameter representing the Hertzian condition of contact with 

an infinitely large sphere. 

4.3. RESULTS 

4.3.1. AFM Replication 

The overall agreement between the model and the AFM nanoindentation data was 

good (Figure 4.4). Over the entire range of depths simulated by the model (350 nm), the 

model agreed more closely with data for contractile cells (R
2
 = 0.993) than for synthetic 

cells (R
2
 = 0.988). Agreement between the model and AFM data for both phenotypes was 

closer over the first 60 nm of indentation, with R
2
 values of 0.999 for both contractile and 

synthetic cells.  
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Figure 4.4. Force-indentation curves comparing experimental AFM 

nanoindentation data and finite element model results for contractile and synthetic 

VSMC phenotypes. 

4.3.2. Geometric Dependence 

By modifying only the relationship between the size of the cell and the indenter, it 

was found that as the contact radius (Equation 4.2), increased, so did the estimated 

modulus predicted by the analytical Hertz equation (Figure 4.5), as expected. This effect 

shows that the estimated Hertzian modulus was highly dependent upon cell width up to a 

width of ~40 μm, at which point the estimated Hertzian modulus plateaued and became 

nearly independent of cell size (Figure 4.6). Notably, while the synthetic phenotype lies 

at the edge of the geometrically insensitive range, the contractile phenotype is in the 

highly geometrically sensitive range (Figure 4.6). 
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Figure 4.5. Plot showing the relationship between the contact radius and the 

estimated modulus predicted by the Hertzian analytical model. In each simulation, 

cells were given an input elastic modulus of 13.2 kPa. If the Hertzian analytical 

model were geometrically insensitive, it would predict the same value (13.2 kPa if 

it were fully accurate) under every condition in each simulation. 

 

Figure 4.6. Plot showing the relationship between the cell radius and the estimated 

modulus predicted by the Hertzian analytical model. Cells of each width were 

given an input elastic modulus of 13.2 kPa. If the Hertzian analytical model were 

geometrically insensitive, it would predict the same value (13.2 kPa if it were 

fully accurate) for cells of any width. The + symbol denotes a width of 10 µm 

which corresponds to the contractile VSMC geometry. The × symbol denotes a 

width of 50 µm which corresponds to the synthetic VSMC geometry. 
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4.4. DISCUSSION 

The FEM model more closely matched the data for contractile VSMCs than for 

synthetic VSMCs (Figure 4.4). Synthetic VSMCs show an increased amount of hysteresis 

in indentation experiments compared to contractile VSMCs [13]. Therefore, the purely 

elastic model does not match the more viscous cell data as well.  

 Our FEM model shows that the Hertzian linear elastic solid analytical model for a 

spherical indenter over a semi-infinite plane (Equation 4.1) overestimates the elastic 

modulus for cells with different geometries by different amounts. When the Hertz 

analytical model was used for modulus calculation, the moduli for the contractile and 

synthetic VSMC phenotypes were overestimated by 2.62 % and 18.93 %, respectively. 

This suggests that the difference in elastic modulus between contractile and synthetic 

phenotypes was underestimated in [13]. Based on these error margins, the elastic moduli 

for contractile and synthetic VSMCs are in fact closer to 14.9 kPa and 9.0 kPa, 

respectively, rather than the previously reported values of 15.3 kPa and 11.1 kPa. This 

nearly 19% over-estimation in the modulus of the synthetic cells is greater than the 

variation due to the experimental measure.  

Obviously, different cell types can have large difference in geometry [19] and, as 

with the VSMCs, even cells of one type can vary significantly in shape and size 

depending on their phenotype. The analytical Hertzian model was insensitive to the size 

of the cell when the cell width was 5 – 10 times larger than the indenter diameter. 

However, it should be noted that this condition does not always hold true in experiments 
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[5, 12, 13]. Therefore, special care should be taken when using the standard formulation 

of the Hertzian model to those data sets. 

The Hertz analytical model is often maligned in the field of cell mechanics due to its 

incorrect assumptions about biological material properties (i.e. linear elasticity). In 

addition, previous groups have commented on the effect of indenter geometry changes on 

the accuracy of the Hertzian modulus estimates for cell indentation data [14, 15].  Here, 

we have noted that the model also yields incorrect estimates due to its inability to 

compensate for the geometry of the cell; the assumption that adherent cells are planar 

compared to the AFM probe tip during indentation is not correct in every instance. More 

importantly, the semi-infinite plane assumption can sometimes lead to errors in 

estimation of apparent cell elastic moduli that are on the order of the variability found 

between cell types [20]. Cellular geometry differences must therefore be taken into 

account when comparing indentation data from different cell types. Consequently, it is 

essential to properly model geometry to obtain accurate estimates of mechanical 

properties, particularly when making comparisons across groups of cells with varying 

sizes and shapes. 
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CHAPTER 5  
 

AUTOMATED SEGEMENTATION OF SUBCELLULAR 

STRUCTURES FROM CONFOCAL IMAGES FOR 

GENERATION OF STRUCTURALLY 

REPRESENTATIVE 3D GEOMETRIC MODELS OF 

SINGLE CELLS  

(AIM 2) 

5.1. INTRODUCTION 

The goal of this study is to create a fully automated algorithm capable of 

reconstructing the cell membrane, nucleus, and actin stress fiber network of single cells 

in 3D based on fluorescent confocal microscopy images of each of those cellular 

components in such a way that they are optimized for structural analysis using finite 

element methods. If generated, such geometries could be utilized in various types of 

multiscale models to bridge the gap between the nano- and macro-scale models currently 

in use. The use of 3D computational models to simulate experimental techniques could 

significantly increase the efficiency of experimentation, leading to reduced times for 

discovery of mechanobiology principles as well as translation of those principles from 

bench top to bed side in clinically relevant devices and medications.  

The traditional primary focus of modern medical research is the investigation of 

molecular biology and genetic factors in disease, which sometimes leads to a tendency to 

ignore changes in tissue structure and mechanics that can also lead to pain and morbidity 

[1]. However, that lack of focus on the physical basis of disease has been changing in 

recent years with the growing emphasis on evidence-based medicine in U.S. hospitals [2, 
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3] together with the substantial growth and maturation of the field of mechanobiology 

over the past decade [4]. Indeed, there has been a great deal of effort to develop and 

utilize geometrically accurate 3D structural models at both the tissue and molecular levels 

[5, 6]. However, there has been much less effort focused at the single-cell level and 

therefore comparatively little progress has been made toward generation of equally 

accurate 3D representations of the structural components of single cells.  

The ability to predict the behavior of cells from their sub-micron and nanoscale 

structures could elucidate the mechanisms behind many tissue mechanical properties [7]. 

For as long as there have been observations of the mechanical properties of cells, there 

have been models put forth to attempt to describe those observations. At the most basic 

level, there are two categories of these models: continuum and structure-based. 

Continuum models, which lack internal structure, were the first type of model utilized to 

describe the mechanical behavior of cells and generally consider the cell to be equivalent 

to a simple “balloon full of molasses” [7, 8]. These types of models therefore make 

predictions with minimal use of geometric variables [9, 10]. Despite the growing amount 

of overwhelming evidence in support of the existence of structural elements within cells 

that has been published throughout the past several decades [1, 7, 11-29], these types of 

models remained popular with bioengineers due to their relative simplicity and ease of 

implementation.  

Structure-based models, on the other hand, are comprised of one or more networks of 

discrete structural elements that work in harmony to determine the mechanical responses 

of cells. These models tend to utilize Finite Element Analysis (FEA) to allow for analysis 
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of complicated cellular and sub-cellular geometries. Many single-cell Finite Element 

Models (FEMs) rely on idealized geometries [10, 30, 31], however recent efforts have 

incorporated geometries obtained from image segmentation. The first efforts to generate 

accurate 3D representations of subcellular structural components using image 

segmentation techniques focused primarily on nuclei [32, 33], and the most advanced 

structure-based cellular mechanics models to date utilize stacks of confocal 

photomicrographs of a cell to generate 3D model structures. There have been a small 

number of these types of models proposed in the last several years [34, 35], each of 

which has taken important steps towards the development of a fully representative 3D 

model of single cell mechanics. However, none of those models has been constructed 

with entirely non-idealized geometries for all mechanically relevant components of a cell.  

Few 3D single cell models have included any form of cytoskeletal elements inside the 

cells [35]; yet even though these models represent a significant step towards reality, they 

still rely on the manual addition of a limited number of cytoskeletal components. There 

has not yet been a system put forth in the literature that is either fully automated or 

capable of reconstructing any elements of the cytoskeletal networks of cells in a 

representative manner. The goal of this study is to present such a fully automated cellular 

geometric reconstruction system based on 3D confocal microscopy images of single 

subconfluent cells.  
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5.2. METHODS 

5.2.1. Data acquisition: Cell culture, staining, and imaging 

Primary rat aortic vascular smooth muscle cells (VSMCs) obtained from female 

Sprague Dawley rats are used in this study. The cells are cultured in high glucose 

Dulbecco’s Modified Eagle’s Medium (DMEM) (HyClone Laboratories, Logan, UT 

USA) with an antibiotic solution of penicillin and streptomycin (HyClone Laboratories) 

added to a concentration 0.5 percent, and an antimycotic solution of amphotericin B 

(HyClone Laboratories) added to a concentration 0.5 percent. Cells are cultured in T75 

cell culture polystyrene flasks and maintained in an incubator at 37 °C and five percent 

CO2 with fresh media being exchanged every other day. VSMCs are utilized between 

passages five and eight. Once the cells reach about 90 % confluency, they are trypsinized 

with a solution of 0.25 % trypsin and 0.02 % ethyldiaminetetraacetic acid (EDTA) in 1X 

HBSS without sodium bicarbonate, calcium, or magnesium (Mediatech, Manassas, VA, 

USA) and seeded at 7,000 cells/cm
2
 on 25 mm diameter glass coverslips (VWR, Radnor, 

PA, USA) that has been coated with 50 µg/mL type I rat tail collagen (BD Biosciences, 

Bedford, MA, USA) 24 hours prior to seeding. The cells are then cultured for three to 

five days to reach about 25 % confluency. 

Upon reaching 25% confluency, cells are fixed with four percent paraformaldehyde 

(Sigma-Aldrich, St. Louis, MO, USA) at 37 °C for ten minutes. After fixation, cells are 

treated with 130 nM AlexaFluor 488 phalloidin (Invitrogen, Eugene, OR, USA) at room 

temperature for 15 minutes to visualize filamentous actin (F-actin), rinsed three times 
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with phosphate buffered saline (PBS) (MP Biomedicals, Solon, OH, USA), and then 

mounted onto glass slides using SlowFade
®
 Gold antifade reagent with DAPI 

(Invitrogen) to visualize the nucleus. The cells are then imaged using an Olympus 

PLAPON60XO 60x oil objective (NA = 1.42) on an Olympus IX81 inverted microscope 

equipped with a DSU spinning disc confocal unit and a Hamamatsu ImagEM CCD 

camera (Hamamatsu Photonics K.K., Hamamatsu City, Japan). Image stacks are taken 

using a Nyquist step size of 200 nm between image planes for maximum resolution in the 

Z-direction as calculated by the microscope controller software (MetaMorph
®
 for 

Olympus Basic, Version 7.7.1.0, Molecular Devices, Sunnyvale, CA, USA).  

It should be noted that several types of microscopy were originally considered for this 

study. Atomic Force Microscopy (AFM) is capable of atomic-level resolution, but was 

eliminated from consideration due to its topographical nature and therefore inherent 

inability to image intracellular structures more than a few nanometers below the apical 

surface of a cell. Scanning Electron Microscopy (SEM) and Transmission Electron 

Microscopy (TEM) also provide more-than-sufficient levels of resolution for imaging 

sub-cellular structures; however, each was ultimately eliminated from consideration due 

to limitations of the imaging environment and sample preparation. Electron microscopy 

usually requires samples to be imaged in an arid (i.e. non-aqueous) vacuum chamber and 

bombarded by an incident electron beam. Because electrons must pass through the 

specimen, TEM requires a very thin (40 – 90 nm thick) section which is difficult to 

accomplish with biological materials using traditional ultramicrotomy methods of sample 

preparation. In order to process the samples to make them electrically conductive for 
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SEM, it is often necessary to coat them in harsh chemicals such as heavy metal salts and 

silver or osmium.  While it is possible to image biological samples using electron 

microscopy techniques, the sample preparation and imaging environment (in particular 

the non-aqueous nature) are capable of producing artifacts (i.e. altering their structure) 

[36] that could cause 3D reconstruction of those images to be inaccurate using the image 

processing techniques utilized in this study. Confocal microscopy does not provide the 

same level of resolution as any of the aforementioned techniques; however, with a 

maximum lateral resolution of approximately 180 nm and maximum axial resolution of 

roughly 500 nm [37] it is still sufficiently capable of imaging the structurally relevant 

sub-cellular components at the whole-cell level. Ultimately, confocal microscopy was 

chosen for this study due to its ability to image cells in their native aqueous environment, 

its non-destructive nature, its relative low-cost compared to electron microscopy, and the 

fact that it is generally considered to be the standard modality for cytoskeletal imaging. 

An additional benefit of this imaging technique is that it may be utilized to image live 

cells. This allows for imaging a cell for which mechanical characterization is also 

obtained, thus enabling direct validation of eventual models. 

5.2.2. Image Pre-Processing  

All images are saved and analyzed as 8-bit grayscale images in TIF format, at a size 

of 256 x 256 pixels. For each image, the f-actin data and the data for the nucleus of the 

cell are stored in separate image stacks. Each image stack is then deconvolved using 

MetaMorph
®
 for Olympus Premier Offline (Version 7.7.0.0) using a 3D deconvolution 
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algorithm based on measured point spread functions using a single iteration. For all 

further image processing, pixel intensities for each image stack are loaded into MATLAB 

(Release 2010b, MathWorks
®
, Natick, MA, USA) as a 3D matrix, creating a voxel map 

of each image channel. The matrix is then scaled in each dimension to match the 

dimensions of the sampled volume in cubic micrometers, so that each voxel is 1 m x 1 

µm x 0.2 µm.  

5.2.3. Construction of Nucleus and Cell Boundary Meshes 

Segmentation of the cell nucleus is achieved similarly to previously reported 

techniques for nucleus segmentation [38-40]. We begin by first thresholding the nucleus 

voxel map using 5 % of maximum voxel intensity as an empirically chosen cutoff value. 

The matrix is then dilated to remove boundary gaps and interior gaps in the matrix were 

filled. All objects lying along the xy border of the voxel map are then removed and the 

image matrix is smoothed with a diamond shaped erosion element. The final step of 

nucleus segmentation is to identify all connected components of the image matrix and 

retain only the largest one. This is accomplished by first creating a label matrix of the 

same size as the image voxel map with each voxel assigned an integer value 

corresponding to its component label and then retaining only the component with the 

largest number of voxels.  

Segmentation of the cell boundary from the data is conducted in almost the exact 

same manner, with the following exceptions. First, rather than constructing the image 

voxel map from only one image, the cell boundary is constructed using the data from 
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both the actin and nucleus images from each plane. This ensures that any slight errors in 

the data set due to chromatic or spherical aberration that may be present in the 

microscope do not cause any subcellular component to end up being located slightly 

outside the segmented periphery of the cell in the final product. After combining both 

images from each of the planes into a single image voxel map, a 3D Gaussian filter is 

applied to the resulting matrix to smooth out any extraneous small geometric details 

(those two or more orders of magnitude less than the scale of the entire data set). 

Secondly, due to the nature of the 2D cell culture techniques employed in this study it is 

assumed that there is no empty space underneath any part of the cell that is not part of the 

cell. To account for this assumption, the image matrix is filled downward with equal 

intensity. 

In order to create isosurfaces of the cell boundary and nucleus, each image matrix is 

down-sampled using an empirically chosen percentage of matrix size and smoothed using 

a 3D Gaussian filter. Down-sampling is necessary at this stage as an additional method of 

smoothing in order to reduce the size of elements in the mesh to a range that allows for 

accurate geometric representation of the data without unnecessarily increasing 

computational intensity or generating elements of poor quality to make the mesh fit 

unnecessarily minute geometric details. Three-dimensional isosurfaces composed of 

three-node triangular faces are then generated for the cell boundary and nucleus. On 

average, the time required for generation of the cell boundary and nucleus isosurfaces is 

approximately one minute on an Intel® Xeon® 5160 dual core CPU at 3.00 GHz with 

4.00 GB RAM. 
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The simplistic segmentation approach above is amply sufficient for the segmentation 

of the images used in this study, since the generation of representative actin fibers is our 

primary objective. Of course, more sophisticated techniques from the literature could be 

used to make the segmentation more robust (e.g. to handle multiple cells per image) if 

necessary. 

5.2.4. Generation of Representative Actin Fibers 

In this section, we describe a novel method for generating a representative network of 

actin fibers, based on an algorithmic framework.  Due to the limited resolution of 

fluorescence confocal microscopy preventing high resolution visualization of individual 

f-actin fibers together with the inherent complexity of the actin stress fiber network, the 

strategy presented is not to reconstruct the exact fibers in the original image, but rather to 

generate a statistically representative reconstruction of entire fiber network. 

We begin by generating a set of candidate fibers.  We assume all fibers are straight 

line segments, although our methods can in principle all be generalized to handle more 

complicated geometric fiber shapes at the expense of additional computational cost.  We 

say a fiber is geometrically feasible if it lies entirely within the cytosolic space of the cell 

(which we define as inside the cell boundary mesh but outside the nucleus boundary 

mesh).  If the nucleus and cell boundary meshes are stored in appropriate spatial data 

structures (e.g. binary space partition trees), then feasibility of any fiber can be tested 

efficiently.  Let E denote the set of all possible fiber endpoints – we currently take E to be 

the set of all nodes on the cell boundary mesh, although more elaborate options are also 
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possible; for example, we could identify through immunocytochemical staining and 

further image analysis a more specific set of “integrin” sites at which fibers are likely to 

attach.  The set of candidate fibers for our actin network now consists of all geometrically 

feasible fibers with endpoints in E.  We denote these fibers f1 … fn.  It will be prohibitive 

to generate all such fibers, since n can easily range into the millions; in these cases, we 

take f1 … fn to be a randomly-sampled subset of 10,000 geometrically feasible fibers.  Our 

goal is to select a small number of these fibers to represent the actin stress fiber network. 

All of our methods discretize the interior of the cell into a 3D volumetric grid of 

regularly-spaced voxels (currently separated by five pixels from their neighbors).  Each 

voxel is further subdivided into 8 directional voxels (dvoxels), each representing a “bow 

tie” shaped angular range of 45° of directionality in the xy plane of the voxel (Figure 

5.1). Directionality is measured only in the xy plane due to the limited z resolution 

inherent in confocal microscopy.  We denote the set of all dvoxels d1…dm.  For each 

dvoxel dj, let aj denote its intensity in the confocal image; that is, aj reflects the amount of 

2D textural directionality in the angular range of the xy plane and 3D location 

corresponding to the dvoxel dj. We measure aj as follows: we first isolate the z image 

plane of the dvoxel and apply a 2D Gaussian filter of size 33 x 33 centered at its (x, y) 

location, thereby extracting a 33 x 33 image of the local 2D neighborhood surrounding dj 

(Figure 5.5[a-b]).  We then perform a 2D FFT on this image (Figure 5.5[c]), and sum the 

magnitudes of all the points in the FFT image corresponding to dj’s angular range (Figure 

5.5[d]).  It is important to note that due to the way the 2D FFT produces its output, the 

dvoxel represents textures internally at a 90 degree rotation to their original orientation. 
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Additionally, the middle point of the image, being shared between all 8 angular ranges, 

contributes 1/8 to each of them.  Figure 5.5(e-m) shows the angular contribution of all 

dvoxels co-located at a single voxel.  

 

Figure 5.1. Illustration of a dvoxel. Note that the directions associated with a 

dvoxel form a symmetric pair of sectors each representing 22.5° of the circle. 

Now that we have defined our candidate fibers f1…fn and discretized the cell into 

dvoxels d1…dm, we build a sparse n x m matrix A for which Aij reflects the “influence” of 

candidate fiber fi on dvoxel dj.  Aij is small if fi either lies far from dj or does not run in a 

direction compatible to those represented by dj. We compute Aij just as we computed aj 

above, only starting with a “synthetic” confocal image consisting of a black background 

on which only fiber fi is drawn, modeled as a cylinder of diameter 1 pixel, with the 

intensity of each voxel along its path set to the volume of the cylinder passing through the 

cubical volume represented by the voxel.  Since we measure Aij and aj the same way, 

these two values are directly comparable. 
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5.2.4.1. GENERATING REPRESENTATIVE ACTIN FIBERS: A LINEAR 

PROGRAMMING APPROACH 

We can regard the problem of computing a representative actin fiber network as an 

inverse problem, where we seek to find a linear superposition of candidate fibers ∑       

(with 0 ≤ xi ≤ 1 for each i   1…n) that best matches the confocal image.  The decision 

variable xi allocated to each fiber fi represents the extent to which fiber fi is present in the 

solution. This can be regarded as a “fuzzy” measurement of fiber presence or 

equivalently as the probability of fi being present. For a particular linear combination of 

fibers, the total contribution to each dvoxel dj is given by    ∑       , and the error 

between this and the actual intensity of dj in the confocal image is    |     | .  Our 

goal is to minimize the total error ∑    , yielding the following optimization problem: 

  

  Minimize: ∑     

  Subject to:           for all j   1…m 

          for all j   1…m 

    ∑          for all j   1…m 

0 ≤ xi ≤ 1   for all i   1…m.  

 

As the objective and all constraints above are linear, this is a linear program, which 

can be solved relatively efficiently in practice, even for large instances.  Another natural 

objective might be to minimize the quadratic error function ∑   
 

 , but this is much more 
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computationally prohibitive given the extremely large instances we are dealing with.  

After solving the linear program above for x1…xn, we must choose which fibers to 

include in our actin network. The ideal method for this task is to flip a biased coin for 

each fiber fi, including fi in the final network with probability xi.  This approach gives a 

set of fibers that matches, in expectation, the distribution output by the linear program.  In 

several applications, however, we may wish to limit the number of fibers present in the 

final network; for example, if the network is to be used in a finite element model, then it 

may prove computationally intractable to include too many fibers.  In this case, two 

different approaches can be used: we can either select all fibers fi for which xi is at least 

some specified threshold T, or we can regard x1…xn as a probability distribution and 

randomly sample some specified number K of fibers (where fiber fi is sampled with 

probability    ∑   . The difficulty with the former approach is picking an appropriate 

threshold T, and with the latter approach the difficulty lies in choosing an appropriate 

value for K.  We set the threshold in order to limit the generated actin network to only the 

most representative fibers and limit the computational complexity of the finite element 

models ultimately generated from our geometry. The threshold value we used typically 

resulted in the acceptance of approximately 135 – 450 fibers per cell. 

An advantage of the linear programming framework above is that we can place length 

constraints on the fibers in our solution.  Ideally, we would like the actin network to 

consist of relatively long fibers, say of average length at least some threshold L (we set L 

to the length of the minor axis of the cell).  Letting Li denote the length of fiber fi. We can 
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write this constraint as (∑      ) (∑    )   , which can be re-written as the linear 

constraint ∑ (    )       

 

5.3. RESULTS 

5.3.1. Cell Imaging 

The deconvoluted images of the cell used in the analysis are shown in Figure 5.2 with 

the actin shown on the left in each pane, the nucleus shown on the right in each pane, and 

a distance between image planes of 200 nm. Note that a portion the nucleus still clearly 

appears in the upper-most image planes whereas the actin network, though present, is 

much more difficult to distinguish. This is a result of “bleed-through” in the z direction 

due to the intense brightness of the DAPI stain coupled with the limited axial resolution 

of the spinning disk confocal microscope. Figure 5.3 shows a 3D reconstruction of the 

cell generated in MetaMorph
®

 displaying orthogonal views of the cell with the actin 

network shown in green and the nucleus shown in blue for use as a comparison to the 

image processing results. 
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Figure 5.2. Image stack of deconvoluted confocal images. Actin shown on left in 

each pane, nucleus shown on right in each pane. The distance between image 

planes is 200 nm. Scale bar = 20 µm. 
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Figure 5.3. Orthogonal views of 3D reconstruction of the actin stress fiber 

network (green) and nucleus (blue) of the cell generated in MetaMorph
®

 

5.3.2. Nucleus and Cell Boundary Meshes 

The results of nucleus and cell boundary segmentation are shown in Figure 5.4. Note 

in the front and side views, that the synthetic cell is taller in the z direction than the 

original data shown in Figure 5.3. This phenomenon is a result of an extra dilation of the 

actin image data in the z direction to ensure sufficient cytosolic space above the nucleus 

for the elements above the nucleus to be of sufficient quality for eventual use in finite 

element models. 
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Figure 5.4. Results of image analysis showing cell periphery and nucleus (shown 

in blue). 

5.3.3. Generation of Representative Actin Fibers 

The results of dvoxel processing are shown in Figure 5.5. Figure 5.5(a) shows the 

location of the 33 x 33 pixel sampling unit on the original image. Figure 5.5(b) shows the 

result of negating the influence of neighboring sampling units using a Gaussian filter, and 

Figure 5.5(c) shown the result of the 2D FFT applied to Figure 5.5(b). The mask of a 

single dvoxel is shown in Figure 5.5(d), and Figure 5.5(e-l) show the result of the 

application of the mask for each dvoxel to Figure 5.5(c) with the sum of all intensity 

magnitudes for each dvoxel shown in brackets. The angular contributions of all dvoxels 

co-located at a single voxel are shown in Figure 5.5(m). 
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Figure 5.5. Dvoxel processing. (a) Original image with 33 x 33 pixel sampling 

unit shown. (b) Gaussian filter applied in sampling unit. (c) 2D FFT of Gaussian 

filter. (d) Mask applied at one dvoxel. (e – l) Results of 2D FFT multiplied by the 

mask of each dvoxel with the sum of all intensity magnitudes shown in brackets. 

m) Angular contribution of all dvoxels co-located at a single voxel; note that the 

dvoxel represents textures internally at a 90 degree rotation to their original 

orientation, due to the way the 2D FFT produces its output. 

The final results of our image processing are shown in  

Figure 5.6, showing the cell periphery (gray), the nucleus (blue), and a representative 

actin stress fiber network (green). The intensity of the color of each fiber correlates to the 

decision variable xi, with brighter fibers having higher scores. Results of our image 

processing algorithm are shown for VSMCs of a variety of shapes and sizes in Figure 5.7. 

The generation of actin fibers takes on average 11.75 ± 7.5 hours to complete on an Intel
®
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Core
®
 i7 CPU 860 at 2.80GHz with 8 cores and 16 GB RAM. The maximum time 

required for generation of actin fibers for the cells in Figures 5.6 and 5.7 was 15.0 hours. 

 

Figure 5.6. Results of image analysis showing cell periphery, nucleus (shown in blue), 

and representative actin stress fiber network (shown in green). Intensity of fiber color 

correlates to decision variable xi, with brighter fibers having higher scores.  
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Figure 5.7. Results of image processing on multiple VSMCs with original 

confocal images shown on right of each subset; all scale bars are 20 µm. 

5.4. DISCUSSION 

5.4.1. Potential Applications 

As mentioned above, the synthetic actin stress fiber networks generated in this study 

do not exactly match those of the original images they were generated from. This is 

intentional due to the fact that the geometries generated in this study are produced with 

the primary goal of utilization in finite element models for structural analysis. Therefore, 

it is imperative that the geometries be both an accurate representation of the original 

geometry yet sufficiently simple that the models can be solved in a reasonable timeframe 

on the average high-end consumer PC workstation. It is with this criterion in mind that 
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we choose to generate a representative reconstruction of the actin stress fiber network 

rather than an exact replica. This strategy also lends itself toward the potential for the 

generation of “average” synthetic cells that may be able to represent an entire phenotype 

in structural finite element models. 

The principles used in the fiber generation algorithm may also be applicable for the 

generation of representative tissue-level structures as well, especially in non-invasive 

imaging techniques. One such example is the potential reconstruction of representative 

muscle fibers from ultrasound images, where resolution limitations can make exact 

reconstructions difficult, for structural or dynamic finite element analysis, where exact 

reconstructions are not a necessity. 

5.4.2. Limitations 

The linear programming method for actin fiber generation used in this study is 

currently somewhat slow.  The computation time is dependent on the size of the cell 

being solved. Therefore, smaller cells will tend to take less time than larger ones to 

process. Increasing the level of downsampling will speed up the computation. In addition, 

this algorithm could be made faster through the utilization of more efficient spatial data 

structures. 

The final, and most significant limitation identified by the authors lies in the imaging 

modality. Because the resolution of confocal microscopy being approximately 840 nm in 

the z-direction [41], it is much easier to distinguish the directionality of subcellular 

components laterally than axially. For instance, if an actin stress fiber were oriented in 
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exactly the z-direction, it would appear in the data only as a series of disjointed dots 

rather than a solid line and would be ignored by the 2D FFT that sets the basis for 

directionality within the present algorithm. Therefore, this technique is best suited for 

analysis and representation of adherent cells in 2D culture which tend to be much wider 

than they are tall. In order to modify the present algorithm to best analyze and reconstruct 

the components of cells in 3D culture, a 3D FFT would likely need to be utilized, which 

would be both more computational expensive and require greater axial resolution in the 

original image data set than the current 2D FFT approach. 

5.5. SUMMARY AND CONCLUSIONS 

An automated method for generation of structural components of single cells based 

on 3D stacks of confocal microscope images for use in structural finite element analysis 

is presented. The major contribution of this study is the novel technique presented for 

generation of a representative actin stress fiber network. 

Cell and nucleus boundaries are segmented using simple thresholding techniques. 

Generation of a representative actin stress fiber network is achieved by analyzing a 

random distribution of all geometrically feasible fibers within the segmented geometries 

and using a linear optimization problem to select appropriate fibers based on the 

directionality of the image stack at each point as measured by a 2D FFT. For qualitative 

validation, analysis of 13 3D confocal image stacks of adherent vascular smooth muscle 

cells grown in 2D culture is performed. The method used in this study is currently slow, 

taking on average 11.75 ± 7.5 hours to complete on an Intel
®
 Xeon

®
 5160 dual core CPU 
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at 3.00 GHz with 4.00 GB RAM; however it could be made faster through the utilization 

of more efficient spatial data structures or further down-sampling of the confocal images. 

Recent models have been proposed that allow for near-realistic representation of 

single cell geometries for finite element analysis. The method presented here is the first 

of its kind, however, that is able to both segment 3D geometries of the cell boundary and 

nucleus, as well as generate a representative F-actin network of a cell that are fit for 

direct importation and implementation in structural finite element models for analysis of 

the mechanics of a single cell in a fully automated fashion. Models of this type are 

currently uncommon in biomedical research due to several factors, but could potentially 

be used to speed discoveries in the fields of regenerative medicine, mechanobiology, and 

drug discovery. This method promises to lower a substantial hurdle toward the use of 

such models – the ability to reconstruct cytoskeletal networks in an automated and 

representative manner. 

Future directions of research include investigation of the use of a random sampling 

approach using the Metropolis algorithm to sample fibers using a random walk and the 

use of a mixture modeling approach for fiber generation based on the Expectation 

Maximization algorithm. Either of these methods, as well as the presented method, could 

also potentially be used for generation of representative networks of more geometrically 

complex cytoskeletal components such as microtubules or intermediate filaments. 
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CHAPTER 6  
 

STRUCTURAL MODELING OF VASCULAR SMOOTH 

MUSCLE CELL MECHANICS USING MSC MARC  

(AIM 3) 

6.1. INTRODUCTION  

The goal of this study is to construct a representative 3D inverse
1
 finite element 

model (FEM) of a biological cell based on the sub-cellular structures that provide the cell 

with its mechanical properties. The geometries for the model are constructed in 

MATLAB from photomicrographs of cells using the proprietary analytical algorithms 

presented in Chapter 5, imported into MSC Patran for pre-processing, and submitted to 

MSC Marc for analysis. 

The ability to model the mechanical responses of cells to physical stimuli presents 

many opportunities to the world of medical research. Chief among these is the ability to 

further our understanding of the ætiology of many diseases [1, 2]. There are a wide 

variety of diseases whose ætiology or clinical presentation are either known or suspected 

to be related to abnormal cellular mechanics, alteration of cellular mechanotransduction 

processes, or changes in tissue structure [1]. Because physical distortion can affect cell 

                                                
1 An inverse finite element model is a model that is based on something that already exists for the 

purpose of reproducing existing results. In contrast, a standard FEM generally refers to a model based on 

computer-aided design (CAD) drawings of something that doesn't exist yet for the purpose of predicting 

results. The distinction between the two is typically used when defining a model, but not when referring to 

a model.  
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growth, differentiation, contractility, motility, and apoptotic tendency [1], the ability to 

predict the mechanical behavior of cells in response to pathological conditions and 

medical treatments may be critical to prevention and treatment of many of these diseases 

[1, 3-6]. 

There has been much effort put into characterizing the behavior of cells throughout 

the years, however there has not been quite as much effort put into utilizing those models 

in one of the most powerful analytical tools available to the engineer: the finite element 

model. This is largely due to the highly complex geometries and material nonlinearity 

exhibited by cells which until recently was more computationally expensive than was 

feasible on the average personal computer (PC) [7]. There have been attempts to create 

2D finite element models of cells since PC computing power began increasing in the 

1990s [2, 7-9]; however, despite the ever-growing availability of sufficient computing 

power for more complex models, only two 3D confocal-based models have been 

published [2, 10]. Furthermore, of those models that have been published, only one 

employs large strain mechanics [2], only one utilizes a compound structure [2], neither is 

based on accurate geometries capable of representing an entire cellular phenotype, and 

neither model is validated by comparing predictions against experimental data. The 

model presented in this study provides the next step toward allowing finite element 

analysis to become a widely used tool within the field of cellular mechanics. The work 

proposed in this study could also eventually be incorporated into multiscale models, 

providing a key link between the prediction of mechanical responses to pathological 

conditions and medical treatments from the tissue level down to the molecular level. 
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6.2. MATERIALS AND METHODS 

6.2.1. System Considered 

Blood vessels are composed of three different layers of cells. The most predominant 

cell type in the thickest layer is the vascular smooth muscle cell (VSMC). These cells are 

constantly under dynamic load due to arterial pressure in normal healthy conditions. In 

response to injurious mechanical loading, VSMCs can undergo significant cytoskeletal 

remodeling, leading to changes in mechanical properties that may eventually contribute 

to atherosclerosis [11]. The cytoskeleton is the primary mechanism responsible for 

maintenance of cell shape and determination of the mechanical properties of cells [1]. It 

is a biopolymer network comprised of several components, including actin stress fibers, 

microtubules, and a variety of structures known as intermediate filaments. Actin 

microfilaments (f-actin) are 7 – 9 nm diameter polarized polymers comprised of globular 

actin (g-actin) monomers.  These microfilaments exhibit a highly dynamic behavior 

regulated by the proteins profilin and cofilin. The microfilaments are relatively stiff and 

have a persistence length of 15 µm and an elastic modulus of 1.3 – 2.5 GPa in dilute 

solution [12]. In adherent cells, actin microfilaments are found bound together by actin 

binding proteins to form closely packed arrays known as actin stress fibers.  These stress 

fibers orient themselves largely along the direction of the stress field applied to the cell 

by its surroundings.  A key feature of actin stress fibers is the prestress that is actively 

exhibited upon them by the actomyosin complexes which are formed by the association 

of myosin motor proteins with the actin filaments [13].  
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VSMCs in this study are cultured on glass coverslips following previously reported 

methods (Chapter 5.3.1). Three cells are highlighted in this study: the cell from Figure 

5.6. (heretofore referred to as Cell A), the cell from Figure 5.7(a) (heretofore referred to 

as Cell B), and the cell from Figure 5.7(b) (heretofore referred to as Cell C). The image in 

Figure 6.1 shows how the actin stress fiber network (left) and nucleus (right) are arranged 

within Cell B.  

6.2.2. Mechanical Characterization of Live Cells 

Atomic force microscopy (AFM) is utilized in this study to characterize the 

mechanics of the VSMCs. AFM indentation utilizes the spring characteristics of a 

cantilever to measure the force of resistance when a conical, pyramidal, or spherical tip is 

indented into a sample.  Atomic force microscopes can therefore be used to perform 

nanoindentation tests that measure the force of resistance as the tip is indented into the 

cell. Figure 6.2 shows an average force-indentation curve for the type of VSMC used in 

this study [14]. As has been noted by prior studies [14], however, there is a great deal of 

heterogeneity in the mechanical properties of individual cells even within a single 

sample; therefore, the curve shown in Figure 6.2 should be taken simply as a 

representative case. Cells are indented here to a depth of approximately 1 µm (Figure 6.3) 

at 0.5 µm/sec using a 5 µm diameter spherical tip on a cantilever with a spring constant 

of 0.18 nN/nm. For indentation, the AFM probe is placed above the estimated center of 

the nucleus (Figure 6.4[b]); however due to the difficult nature of observation of the cells 

and their nuclei before fluorescent labeling (Figure 6.4[a]), this placement is not exact. 
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Figure 6.1. Montage of image planes used to create the geometry of the model for 

Cell B: each frame represents one plane of the cell of 200 nm thickness that has 

been processed using a 3D deconvolution algorithm. The left half of each frame 

shows the f-actin distribution within the cell and the right half shows the nucleus 

of the cell (Scale bar = 20 µm). 
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Figure 6.2. Typical force-indentation curve for a VSMC of the type used in this 

study indented with a 5 µm spherical probe at 0.5  µm/s in standard cell culture 

media [14] 

 

Figure 6.3. Raw AFM Indentation data; the red line shows deflection of the 

cantilever upon indentation, the blue line shows deflection of the cantilever upon 

retraction, and the distance between the circle and square along the abscissa 

represents the approximate indentation depth 
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Figure 6.4. Cell B as viewed through AFM camera with 60X oil objective (a) 

prior to indentation and (b) during indentation 

6.2.3. Confocal Imaging of Cells 

Following mechanical characterization of cells, the cells are fixed in place on the 

microscope using 4% paraformaldehyde and permeabolized using a solution of 0.1% 

Triton-X and 0.01 M Glycine (to quench the excess aldehyde). They are then treated with 

solutions of 130 nM AlexaFluor 488 phalloidin and 350 nM DAPI to fluorescently label 

the actin stress fiber network and nucleus, respectively (Figure 6.1). The cells are then 

imaged in accordance with the methods described in Chapter 5.3.1. 

6.2.4. Analysis of Mechanical Characterization 

The Hertz contact model is used to estimate the apparent elastic modulus of the cell. 

The equation governing the relation of force of indentation to the elastic modulus of an 
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indented sample using a spherical indenter according to the Hertz model is given in 

Equation 6.1. 

 

Equation 6.1. The Hertz contact model 

   
 

 

 

(    )
 
 
  
 
  

 

where E and ν are the elastic modulus and Poisson’s ratio of the sample, respectively, δ is 

the depth of indentation, and R is the radius of the spherical indenter. The Hertz model is 

applied at a depth of 200 nm indentation, or approximately 10 % of cell height, as this is 

within the range that the Hertz model remains accurate [14].  

6.2.5. Finite-Element Model of System 

6.2.5.1. MODELING ASSUMPTIONS 

The microtubule network of VSMCs is highly complex, with no common, easily 

discernible patterns typically present. Therefore, in order to reduce the complexity of this 

model the microtubule network is assumed to be distributed homogeneously throughout 

the cell and can therefore be modeled as a continuum. Additionally, it is highly difficult 

to discern from confocal microscopy images the number of actin microfilaments 

comprising a single actin stress fiber. It is therefore assumed that each stress fiber has a 

radius of 100 nm based on previously reported values [15]. As described in Chapter 5, all 

fibers that are determined to have a fiber score of T > 0.001 in the solution of image 
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analysis are accepted for finite element analysis, resulting in the incorporation of 361 out 

of a possibly 945 fibers into the model presented here. See Appendix C.2 and Appendix 

C.3 for data showing dependence of results on fiber parameters. 

6.2.5.2. GEOMETRIC MODEL 

Three-dimensional confocal microscopy image stacks are analyzed using an 

algorithm capable of generating representative model geometries consisting of the cell 

body, nucleus, and actin stress fiber network as described in Chapter 5. The algorithm 

uses simple thresholding techniques to generate the cell body and nucleus, and 2D 

frequency analysis combined with linear programming approaches to generate the actin 

stress fiber network. The resulting geometries are shown in Figure 6.5, with the grey 

surface representing the cell periphery, the blue surface representing the nucleus 

periphery, and the green lines representing the actin stress fibers for each cell. Using the 

fiber score threshold value ascribed in Chapter 5, Cell A was generated with 361 fibers, 

Cell B was generated with 615 fibers, and Cell C was generated with 291 fibers. It should 

be noted that in order to replicate physical conditions and ensure the ability of the model 

to solve successfully, the actin stress fibers are not allowed to intersect with either the cell 

or nucleus periphery and are therefore contained completely within the cytoplasmic 

volume of the model cell. 
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Figure 6.5. Geometry of (a) Cell A (361 fibers), (b) Cell B (615 fibers), and (c) 

Cell C (291 fibers) as generated by MATLAB image processing: grey represents 

the cytoplasm, blue represents the nucleus, and green represents the actin fibers 

The geometry created in MATLAB is composed of two-dimensional 3-noded triangle 

(Tria3) and one-dimensional 2-noded bar (Bar2) elements in 3D space and is imported 

into Patran via a session file written in MATLAB. The session file builds the mesh into 

Patran from the ground up by generating each individual node and element. It 

automatically creates meshes constructed of 10-noded tetrahedral (Tet10) elements for 

the nucleus and cytoplasm, meshes the actin stress fibers with Bar2 elements of average 

length approximately consistent with the persistence length of actin filaments (15 µm 
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[12]), and constructs the spherical cap representative of the AFM probe directly above the 

highest node of the cell (Figure 4). Positioning the AFM probe in such a manner typically 

ensures proper probe placement to match the experimental condition of indenting the cell 

at the approximate center of the nucleus. 

 

Figure 6.6. Mesh of (a) Cell A, (b) Cell B, and (c) Cell C with Geometry of AFM 

Probe in Patran After Importing From Matlab 
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6.2.5.3. MATERIAL MODELS 

The VSMCs modeled herein are composed of three separate linear isotropic 

materials, each with a Poisson’s ratio of  .49 [14]. Two types of simulations are 

performed in this study – models with actin, and models without actin. The nucleus and 

actin filaments (where appropriate) are modeled using Young’s moduli of  .  kPa and 1.9 

GPa, respectively, based on literature values [12, 16]. For the models with actin, the 

cytoplasm is given a Young’s modulus of 2.25 kPa based on experimental data of 

VSMCs treated with cytochalasin D to depolymerize actin filaments. For the models 

without actin, the cytoplasm is given a Young’s modulus based on the apparent elastic 

modulus estimate obtained via Equation 6.1 from the AFM indentation data of that 

particular data set.  

The actin filaments are represented in the model as truss elements, and the cell body 

and nucleus are both constructed of Tet10 elements. It should be noted that truss elements 

do have two primary limitations relative to general beam elements for this type of model. 

First, they only transmit forces axially and therefore do not exhibit any bending 

characteristics. Secondly, trusses elements in Marc are incapable of supporting prestress; 

however, prestress values in actin stress fibers vary throughout the cell [17] and therefore 

would be highly difficult to incorporate accurately even if supported. Despite their 

limitations, truss elements are chosen for this study because they are the most stable 1D 

embeddable element type in Marc and are therefore highly recommended for this type of 

analysis by the developers of the software.  
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6.2.5.3.1. EMBEDDING FIBERS IN MARC 

All pre- and post-processing of the model is performed in Patran 2010. However, 

Patran 2010 is not capable of embedding 1D elements into 3D solids as needed for a 

model of this nature. Therefore, the model was submitted to the Analysis Deck in Patran, 

and an INSERT card is manually written into the resulting .dat file in order to define the 

host and embedded elements before submission to Marc (Appendix D.1.1.).  

6.2.5.4. LOADS AND BOUNDARY CONDITIONS 

Two sets of boundary conditions are applied to the model to match experimental 

conditions. First, the bottom-most layer of nodes is fixed in position to represent the 

physical attachment of the cell to its substrate. Second, a rigid spherical cap is plunged 

into the deformable cell body using contact parameters to represent the indentation of the 

AFM probe into the cell, as described in the Analysis section below. 

6.2.6. Analytical Parameters 

Analysis is performed using MSC Marc 2010.2. In order to simulate contact between 

the AFM probe and the cell, each component is defined as a separate contact body with 

the former being rigid and the latter being deformable. Global remeshing is utilized for 

the analysis, with a strain of 0.25 used as the threshold to trigger remeshing, however it 

should be noted that the 0.25 strain threshold is not reached in any of the simulations 

performed in this study. To match experimental conditions, the probe is prescribed a 
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displacement of 1 µm into the cell in 25 nm increments at 0.5 µm/sec. For all models, the 

Large Displacement/Large Strains solution parameter is utilized. 

6.3. RESULTS AND DISCUSSION 

6.3.1. Indentation 

The distribution of von Mises stresses throughout the model cell with actin at a probe 

indentation depth of 1 µm is shown in Figure 6.7.  The maximum value of stress 

experienced by the cytoplasm and nucleus of the cell is 0.95 kPa and the maximum value 

of stress experienced by the actin stress fiber network is 78 kPa. While these values are 

meaningless on their own since there are no experimental methods to measure 

intracellular stresses with which to compare them against, they do provide a promising 

demonstration of two different principles. First, the fact that the stresses experienced in 

the actin stress fiber network are approximately two orders of magnitude higher than 

those in the rest of the cell body suggests that the load exerted upon the cell is primarily 

distributed through the actin, which matches physical expectations. Secondly, the stresses 

are carried throughout the entirety of the cell through the actin stress fiber network, 

matching observations of cell behavior obtained experimentally [18]. Of note, Figure 6.7 

shows an anisotropic distribution of stresses throughout the cell, emphasizing the 

importance of the geometric arrangement of the actin stress fibers within the cell on the 

mechanical characteristics of the cell. 
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Figure 6.7. Representative von Mises stress distribution (shown in Cell B) 

The force-indentation curves of AFM nanoindentation and both FEM cases (models 

with and without actin) for all 3 cells are shown in Figure 6.8. The AFM curve is 

presented with error bars displaying the 99 % confidence interval (n = 5). As shown in 

Figure 6.9, both FEM cases match the experimental data very well (average R
2
 > 0.99) up 

to an indentation depth of 250 nm and still match the experimental data reasonably well 

(average R
2
 > 0.9) at an indentation depth of 500 nm, however there is a precipitous drop-

off in the correlation between the experimental data and the model at or beyond 750 nm 

of indentation (with average R
2
 values ranging between -0.15 and 0.45). As such, it is not 

recommended that the current model be used to predict AFM nanoindentation data 

beyond 500 nm of indentation. Multiple analyses were performed on the sensitivity of the 

model to the number of fibers and fiber diameter and neither was found to be a primary 
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determinant of the results of the model (see below in Chapter 6.3.2.1 and Chapter 

6.3.2.2.), thus reinforcing the importance of geometry determined in Chapter 4. In 

addition, Chapter 6.3.2.3. shows how the difference between indentation curves in live 

VSMCs with and without actin corresponds to the difference between indentation curves 

of model VSMCs with and without actin. 

On average, the model with actin incorporated into it matches the experimental data 

more closely than the model without actin for all depth ranges. This demonstrates that the 

cytoskeletal geometries generated by the novel image processing techniques presented in 

Chapter 5 are successful at replicating AFM nanoindentation experiments more 

accurately than traditional finite element model techniques. The apparent elastic modulus 

estimates of the cells based on the AFM and FEM indentation curves are shown in Figure 

6.10 with error bars displaying the 99 % confidence interval. 
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Figure 6.8. AFM and FEM force-indentation curves for (a) Cell A, (b) Cell B, and 

(c) Cell C; error bars display 99 % Confidence Interval (n = 5)  
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Figure 6.9. R
2
 Values of FEM indentation curves at various indentation depths 

relative to AFM data; error bars show 99 % Confidence Interval (n = 3) 

 

Figure 6.10. Hertzian stiffness estimates of the cell as measured via AFM and 

FEM indentation curves; error bars show 99 % Confidence Interval (n = 5) 
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6.3.2. Sensitivity Analyses 

6.3.2.1. FIBER NUMBER SENSITIVITY ANALYSIS 

Fiber density sensitivity analysis was performed on a 3D axisymmetric model in 

Patran/Marc, with results of the model compared when varying numbers of synthetic 

actin stress fibers are utilized (Figure 6.11). The “% Change” line in Figure 6.11 denotes 

the percentage change relative to the model with the previous number of fibers. Error 

bars show 99% confidence intervals (n = 3). A diameter of 200 µm was used for all 

models in this analysis. The Apparent Elastic Modulus was calculated using the Hertz 

Analytical Model (Chapter 1.3.1.) at an indentation depth of 200 nm, and values were 

normalized to the stiffness of the model with zero fibers. As expected, the number of 

fibers is roughly proportional to the stiffness of the cell, however the amount of variation 

in these results suggests that the number of fibers used in the model is not the primary 

determinant of the stiffness of the model. 
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Figure 6.11. Fiber diameter sensitivity analysis; error bars show 99 % Confidence 

Intervals (n = 3). 

6.3.2.2. FIBER DIAMETER SENSITIVITY ANALYSIS 

Fiber diameter sensitivity analysis was performed on a 3D axisymmetric model in 

Patran/Marc, with results of the model compared when varying diameters of synthetic 

actin stress fibers are utilized (Figure 6.12). The “% Change” line in Figure 6.12 denotes 

the percentage change relative to the model with the previous diameter of fibers. Error 

bars show 99% confidence intervals (n = 3). The number of fibers utilized was 500 for all 

models in this analysis. The Apparent Elastic Modulus was calculated using the Hertz 

Analytical Model (Chapter 1.3.1.) at an indentation depth of 200 nm, and values were 

normalized to the stiffness of the model incorporating 7 nm diameter fibers (the diameter 

of a single f-actin filament [12]). As expected, the diameter of fibers does impact the 
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stiffness of the cell, however the amount of variation in these results suggests that the 

diameter of the fibers used in the model is not the primary determinant of the stiffness of 

the model. 

 

Figure 6.12. Fiber diameter sensitivity analysis; error bars show 99 % Confidence 

Intervals (n = 3). 

6.3.2.3. EFFECT OF ACTIN FIBERS 

In order to determine if the addition of actin fibers to the model has a similar effect on 

the mechanical properties as the addition of actin stress fibers does to a live cell, the 

force-indentation curve of a control VSMC was normalized against the force-indentation 

curve of a VSMC treated with Cytochalasin D to depolymerize f-actin. A similar curve 

was generated for a FEM indentation curve of cells with and without actin (Figure 6.13). 
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Although the two lines are nearly isometric, it is interesting to note that the curves 

intersect very near an indentation depth of 200 nm, suggesting that apparent elastic 

modulus estimates obtained using the Hertz contact model as done in Chapter 6 would 

indicate a similar relationship between the stiffness of the FEM models with and without 

actin as exists between the live treated and untreated cells. 

 

Figure 6.13. Effect of actin fibers on force-indentation curves; A(+)/A(-) denotes 

that the normalized force is equal to the force for the curve with actin normalized 

against the curve without actin. 

6.3.3. Advantages and Limitations 

The approach taken here represents a new paradigm for the construction of a cellular 

mechanics model. All previous attempts to model the mechanical behavior of cells have 
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focused on altering the material parameters of the model to match experimental data. This 

model, however, utilizes only material parameters taken from experimental data (either 

directly from the cell modeled or from literature values) and relies on the geometric 

arrangement of the structural components of the cell to provide the model with realistic 

results. It is important to note that the results above could easily be made to match the 

experimental data better by altering our material parameters. However the major 

advantage of this new paradigm of model construction is that because the material 

parameters are based on physical reality and not simply altered to try to match the data as 

closely as possible the results are therefore more meaningful and are more likely to be 

predictive across samples and potentially even across cell types. 

However, although this novel approach is more ideal than the previous paradigm, it 

does still have some limitations. Primarily, it is reliant on two factors relating to how the 

material parameters from the literature were obtained.  

The first of these factors is that the material parameters for actin taken from the 

literature were obtained from single filaments of f-actin in dilute solution. This therefore 

relies on two assumptions for the presented model about actin stress fibers. The first is 

that actin stress fibers (which are composed of many actin filaments) have the same 

tensile modulus as a single filament, which is highly unlikely. Secondly, because the 

fibers in the model are all independent of one another, the model relies on the assumption 

that the cross-linking of actin stress fibers observed in VSMCs does not alter the 

mechanical properties observed from actin filaments in dilute solution.  
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The second limiting factor is the assumption that the Poisson’s ratio taken from the 

literature was obtained using micropipette aspiration on non-adherent cells. This 

therefore relies on the assumption that the Poisson’s ratio of cells is independent of their 

geometry – specifically, that it is independent of the arrangement of the points of 

attachment of the cell to its substrate. Because the Poisson’s ratio is a definition of how a 

material deforms in multiple directions this assumption of geometric insensitivity is 

unlikely to be fully realistic. Nevertheless, the value used here is used extensively 

throughout the literature and therefore remains the most appropriate value to use until a 

method to measure the Poisson’s ratio of an adherent cell is proposed. 

It is also noteworthy that the model proposed herein is similar in nature to the 

multiphasic models commonly utilized to characterize the mechanical responses of 

biological tissues. However, these are not appropriate for this model because, in the case 

of mixture models they assume that the material is a superimposed continua of two 

materials where each point within the material is occupied simultaneously by a material 

point of each phase and in the case of biphasic models such as poroelasticity, they assume 

that the mechanical properties are dominated by factors such as fluid flux and 

permeability. Mixture models could potentially be incorporated into a model of the type 

proposed here to describe the mechanics of the cytoplasm but to use them to describe the 

mechanics of the entire system would be to neglect the geometric arrangements that we 

have shown to play a crucial role the mechanics of cells. Poroelastic models, however, 

are not appropriate for use in a model of single vascular smooth muscle cell mechanics 

because although there is fluid flow within the cell during deformation, previous 
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unpublished studies in our lab have shown that deformation of VSMCs does not result in 

fluid flux between the cell and its extracellular environment. This phenomenon may not 

be the case for all cell types, however, and therefore should be further investigated to 

determine the applicability of poroelastic models across all cell types. 

Finally, the most important limitation of a finite element model of this type is that 

cells are living systems capable of active responses which this type of model cannot 

replicate. This limitation, however, does have benefits. Primarily, the lack of active 

responses in the model can provide crucial data to aid in better understanding the field of 

mechanotransduction. If we are one day able to eliminate the assumptions listed above to 

improve the accuracy of the model to the point that we are entirely confident in its ability 

to model the inactive mechanical responses of cells, we may then be able to use the 

model to better distinguish the difference between the active and inactive responses of 

cells. Such an understanding would potentially have many far-reaching effects on the 

field of drug discovery where researchers would be better able to target the appropriate 

mechanisms to elicit the desired responses for new pharmaceutical therapeutics. It would 

also potentially have consequences for the fields of tissue engineering and regenerative 

medicine, where mechanical stimuli at the cellular level are critical toward directing 

tissue development and remodeling. 

6.4. CONCLUSIONS AND FUTURE WORK 

The inverse finite element model presented in this study represents an important step 

toward the ability to use finite element analysis for accurately modeling biological cells 
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and provides a solid foundation from which to build an even more representative model. 

It is capable of both construction of entirely representative geometries produced in a 

completely automated manner and validation of its results using experimental data taken 

from the same cell that was modeled on the same day that the images of the cell were 

obtained. In future studies, we plan to incorporate viscoelastic material properties based 

on AFM stress relaxation data. 

Future studies will also incorporate multiphysics modeling approaches. 

MSC.Software offers a wide variety of computer aided engineering (CAE) modeling 

software packages that can work in conjunction with Marc. XFlow is a particle-based 

computational fluid dynamics (CFD) software package that could conceivably be used to 

model protein movement inside a cell during deformation. Adams is claimed by MSC to 

be the most widely used multibody dynamics and motion analysis software in the world 

and could conceivably be used to model motion of cytoskeletal networks due to applied 

strains. SimXpert is an umbrella software that ties the various MSC software packages 

together as a multiphysics platform. Pairing of Marc, Adams, and XFlow could one day 

potentially lead to the development of models capable of reproducing complex passive 

cellular behavior such as the tensegrity dynamics observed during cytoskeletal fiber 

severing experiments [18] or even active cell responses such as cell migration. 

The work presented in the current study represents an important step toward the 

ability to use finite element models to accurately predict the mechanical behavior of 

biological cells and provides a solid foundation from which to build even more 

representative models. Such models could potentially be utilized to elucidate the 
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mechanisms of mechanotransduction or even increase the speed and decrease the cost of 

drug development, tissue engineering, and regenerative medicine therapies, thereby 

possibly increasing the quality and longevity of millions of lives across the current and 

future eras of modern medicine.  
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CHAPTER 7  
 

CONCLUSIONS AND RECOMMENDATIONS FOR 

FUTURE WORK 

7.1. CONCLUSIONS 

The present research is motivated by the desire to further our understanding of the 

ætiology of many diseases through the ability to model the mechanical responses of cells 

of physical stimuli. The wide variety of diseases whose ætiology or clinical presentation 

are either known or suspected to be related to abnormal cellular mechanics, alteration of 

cellular mechanotransduction processes, or changes in tissue structure are primary 

motivators, and the ability to predict the mechanical behavior of cells in response to 

pathological conditions and medical treatments may be critical to prevention and 

treatment of many of these diseases. 

It was shown in Chapter 4 that the ability to model the mechanical behavior of cells 

using finite element analysis is dependent upon incorporating appropriate geometries, as 

results were shown to change when the only parameters that were varied were 

geometrical. Chapter 5 presented a novel, fully automated image analysis algorithm 

which utilizes image segmentation techniques for the reconstruction of 3D geometries for 

the periphery and nucleus of a cell together with a linear programming approach to 

optimize the superposition of cytoskeletal fibers, for the generation of a representative 

actin stress fiber network of the cell that can all be incorporated into finite element 

models for structural analysis. A 3D inverse finite element model is presented in Chapter 
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6 which is the first model of its kind that utilizes representative cytoskeletal structural 

components in addition to accurate cell boundary and nucleus all constructed 

automatically from confocal images of actual cells. This model is also the first of its kind 

to be validated directly against experimental data taken from the exact cells used in the 

model within minutes of their imaging. The model shows good agreement with the 

experimental data up to 500 nm of indentation by a 5 µm diameter spherical AFM probe. 

The work presented here represents an important step toward the ability to use finite 

element models to accurately predict the mechanical behavior of biological cells and 

provides a solid foundation from which to build even more representative models. Such 

models could potentially be incorporated into multiscale models for use in elucidating the 

mechanisms of mechanotransduction as well as increasing the speed and decreasing the 

cost of both drug development and tissue engineering/regenerative medicine therapies, 

thereby possibly increasing the quality and longevity of millions of lives throughout the 

current and future eras of modern medicine. 

7.2. RECOMMENDATIONS FOR FUTURE WORK 

1. Expand the model to different cell types. The techniques presented in the current 

work show great promise for the establishment of a useful finite element model to 

predict the mechanical responses of vascular smooth muscle cells, however VSMCs 

are the only cell type studied here. We predict that the techniques presented here will 

be applicable across a wide variety of cell types, so it is recommended that future 

studies focus on many other types of cells.  
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2. Expand the model to different physical experiments. As shown in Chapter 3, there 

are many techniques that can be used for mechanical characterization of cells, 

however only one (AFM) was used for these studies. We predict that the techniques 

presented here will translate across many other types of physical experiments It is 

recommended, therefore, that future studies utilize additional mechanical 

characterization techniques. Suggested techniques include Shear Flow, Micropost 

Arrays, Whole-Cell Compression, Cell-Stretching, and Magnetocytometry. 

3. Live Cell Actin Imaging. G-actin monomers are able to polymerize into 100 nm of f-

actin in 1.5 ms [1], yet the static and dynamic mechanical tests performed in this 

work ranged from 1 to 120 seconds and fixing of those cells was performed up to 5 

minutes after mechanical characterization. Therefore, it is unknown the degree of 

cytoskeletal rearrangement which takes place during mechanical characterization. 

Because of this, it is recommended that studies be performed in which mechanical 

characterization takes place on live cells which have had their cytoskeletal networks 

and nuclei fluorescently labeled. This will provide a better ability to reconstruct the 

actin stress fiber network of the cell as it is at the exact moment of testing and a better 

understanding of how the cells respond to mechanical stimuli. Live cell staining could 

be achieved using gene transfection, which is expensive and time-consuming or 

alternatively, studies have shown promise in using established inkjet printing 

techniques to permeabolize cell membranes enough to allow for fluorescently-labeled 

antibodies to enter the cytosol. 
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4. Integrate Viscoelasticity. The mechanical behavior of VSMCs is well characterized 

by the Generalized Maxwell model of viscoelasticity. Finite element models which 

can successfully incorporate this model of viscoelasticity are expected to be more 

accurate than the model presented in Chapter 6. 

5. Generate Average Phenotype Geometries. The image analysis techniques presented 

in Chapter 5 could conceivably be expanded to the analysis of multiple confocal 

image stacks of multiple cells at a time. If those images could be merged into an 

“average” geometry, it would then be possible to generate cell geometries that were 

capable of statistically representing an entire phenotype. Such geometries would be 

more meaningful for predictive finite element modeling techniques than the inverse 

finite element modeling technique presented in Chapter 6. One long-term result of 

this work could be the generation of a cell database, not unlike the Protein Database, 

from which users around the world could download any of the cell types relevant to 

their work. 

6. Incorporation of Additional Structural Components. The actin stress fiber 

network is just one of many structural networks inside and outside the cell that affect 

its mechanical behavior. Future models would potentially benefit from the 

incorporation of other cytoskeletal features such as microtubules, integrins, and 

intermediate filaments. 

7.  Expand the Model to a Multiphysics Platform. MSC.Software is one of the 10 

oldest software companies on the planet. As such, they offer a wide variety of 

computer aided engineering (CAE) modeling software. XFlow is a visually exciting 
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particle-based computational fluid dynamics (CFD) software package that could 

conceivably be used to model protein movement inside a cell during deformation. 

Adams is claimed by MSC to be the most widely used multibody dynamics and 

motion analysis software in the world. Adams could conceivably be used to model 

motion of cytoskeletal networks. SimXpert is an umbrella software that ties the 

various MSC software packages together as a multiphysics platform. Pairing of Marc, 

Adams, and XFlow could one day potentially lead to the development of models 

capable of reproducing complex passive cellular behavior such as the tensegrity 

dynamics observed during cytoskeletal fiber severing experiments [2] or even active 

cell responses such as cell migration. 

8. Integrate the Model into a Multiscale Model. The ultimate fulfillment of the work 

presented in this dissertation would be its incorporation into a multiscale model, 

leading to the ability to more easily tie macro-scale behaviors to nano-scale 

phenomena. Such a multiscale model could potentially be used to increase the speed 

and decrease the cost of drug development and tissue engineering/regenerative 

medicine therapies, thereby possibly increasing the quality and longevity of millions 

of lives over future eras of medicine. 
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APPENDIX A 

IMAGE ANALYSIS MATLAB CODE 

The MATLAB .m files used for image analysis are presented below in the order in 

which they are utilized. Notes for use are presented at the beginning of each section 

where appropriate. 

A.1. reconstruct_whole_cell.m 

NOTES 

This function is the top-level function used for image analysis. All other functions 

presented in this appendix are called through this function. The function is called by 

typing “reconstruct_whole_cell(id)” in the MATLAB command window, where 

“id” is the identification number of the cell desired for reconstruction. All parameters 

required for analysis are given at the beginning of the file in the “% INPUT PARAMETERS” 

section. 

MATLAB CODE 

function reconstruct_whole_cell(id) 

  

timecount = tic; 

  

% Cell to visualize 

%id = 1; %%[no need for this?] -- only useful if you run it by clicking 

">" 

%above, rather than from the matlab command prompt 

  

% INPUT PARAMETERS 
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patran_dir = 'c:\MSC.Work\Research\111024';  % don't add a \ to the 

end... 

downsample = [0.1 0.1 .25]; % x y z downsampling -- reduce to coarsen 

mesh 

inflation_factor = [1 1 1];  % just to make cell look a bit bigger than 

it is, ideally set to [1 1 1] 

  

frad = 100e-3; % radius of actin fibers, in um 

fcross = pi * frad^2; % cross-sectional area of actin fibers, in um^2 

avg_fiber_len = 20; % for the fiber generation, in microns, generally 

set to ~minor axis width 

generate_actin = 0; % set to 0 if we just want to generate meshes, but 

no actin 

voxel_density = 5;  % skip by this many pixels to form lattice of 

voxels 

num_potential_fibers = 10000; % delete fiber_cache_"id".txt if this 

changes 

probe_speed = 0.5; % indenter speed, in um/s 

probe_indent = 1; % depth of indentation into cell, in microns 

fiber_sample_cutoff = 0.001; % score above which we keep fibers (range 

0..1) 

%Nfibers = 0; % number of actin fibers to generate (used before 

implementation of cutoff) 

  

% READ IN CELL IMAGE DATA AND SEGMENT NUCLEUS AND MAIN CELL BOUNDARY 

[nucleus, actin, membrane, dims] = acquire_image_data(id); 

disp(sprintf('Image stack has dimensions %d x %d x %d voxels', 

size(nucleus,1), size(nucleus,2), size(nucleus,3))); 

[nfaces, nverts, nvoxels] = extract_nucleus(nucleus, downsample); 

if size(nverts,1)==0 

    disp('Error -- no nucleus segmented.  Maybe it got downsampled out 

of existence?'); 

    return; 

end 

disp(sprintf('Nucleus mesh has %d vertices and %d triangles', 

size(nverts,1), size(nfaces,1))); 

  

[cfaces, cverts, cvoxels] = extract_cell_boundary(actin, membrane, 

nvoxels, downsample); 

disp(sprintf('Cell boundary mesh has %d vertices and %d triangles', 

size(cverts,1), size(cfaces,1))); 

disp(sprintf('Cell volume made up of %d total voxels', 

sum(sum(sum(cvoxels))))); 

  

% TRANSLATE AND RESIZE COORDINATES TO APPROPRIATE DIMENSIONS AND MERGE  

% NUCLEUS + CELL MESHES INTO COMBINED LIST 
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rescale_factor = ones ./ (size(nucleus) .* downsample) .* dims .* 

inflation_factor; 

cverts = cverts * diag(rescale_factor); 

nverts = nverts * diag(rescale_factor); 

translate_amt = min(cverts); 

nverts = nverts - ones(size(nverts,1),3) * diag(translate_amt); 

cverts = cverts - ones(size(cverts,1),3) * diag(translate_amt); 

for i=1:size(cverts,1) 

    if cverts(i,3) < 1.1 * rescale_factor(3); 

        cverts(i,3) = 0; 

    end 

end 

rescale_factor = rescale_factor .* downsample; 

  

if generate_actin > 0 

  

    % COMPUTE INTEGRINS AND ACTIN FIBERS 

    [fibers, fverts] = compute_actin_fibers(id, cfaces, cverts, nfaces, 

nverts, num_potential_fibers); 

  

    write_lp(id, cvoxels, nvoxels, actin, fibers, fverts, 

avg_fiber_len, rescale_factor, translate_amt, voxel_density); 

    solve_lp(id); 

     

    filename = sprintf('actin%d.sol', id); 

    sol = load(filename); 

else 

    filename = sprintf('actin%d.sol', id); 

    f = fopen(filename, 'r'); 

    if f < 0 

        disp(sprintf('No fibers yet; cannot open %s', filename)); 

        sol = []; 

        fverts = []; 

    else 

        disp(sprintf('Cached fiber solution was read from %s', 

filename)); 

        fclose (f); 

        sol = load(filename); 

        filename = sprintf('fiber_coordinates_%d.txt', id); 

        fverts = load(filename); 

    end 

end 

     

write_stl('nucleus.stl', nfaces, nverts); 

write_stl('cell.stl', cfaces, cverts); 

  

%sampled_fibers = sample_actin_fibers(sol, Nfibers); 
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sampled_fibers = sample_actin_fibers_bycutoff(sol, 

fiber_sample_cutoff); 

  

volmesh_size = dims(1) / 256; % Volume mesh edge length roughly 2 

pixels wide 

write_patran_session(patran_dir, nfaces, nverts, cfaces, cverts, 

fverts, volmesh_size, sampled_fibers, probe_speed, probe_indent, 

id, fcross, frad); 

  

% DRAW EVERYTHING 

cell_3d_vis(nfaces, nverts, fverts, cfaces, cverts, sampled_fibers, 1); 

h = get(1, 'CurrentAxes'); t = get(h, 'CameraTarget'); 

set(h, 'CameraPosition', t + [0 0 1000]); 

set(h, 'CameraUpVector', [-1 0 0]); 

set(h, 'View', [89.999999 90]); 

set(h, 'View', [90 90]); 

set(1,'Position',[50 50 600 900]); 

p = get(1,'Position'); 

p2 = get(h, 'Position'); 

aspect = get(h, 'PlotBoxAspectRatio'); 

ysize = p(3) * p2(3) * aspect(1) / aspect(2); 

  

cell_3d_vis(nfaces, nverts, fverts, cfaces, cverts, sampled_fibers, 4); 

h = get(4, 'CurrentAxes'); t = get(h, 'CameraTarget'); 

set(h, 'CameraPosition', t + [1000 0 0]); 

set(h, 'CameraUpVector', [0 0 1]); 

p = get(4, 'Position'); 

p(3) = 600; 

set(4,'Position',p); 

  

cell_3d_vis(nfaces, nverts, fverts, cfaces, cverts, sampled_fibers, 5); 

h = get(5, 'CurrentAxes'); t = get(h, 'CameraTarget'); 

set(h, 'CameraPosition', t + [0 1000 0]); 

set(h, 'CameraUpVector', [-1 0 0]); 

p = get(5, 'Position'); 

p(4) = 900; 

set(5,'Position',p); 

p = get(5,'Position'); 

p2 = get(h, 'Position'); 

p2(4) = ysize / p(4); 

set(h, 'Position', p2); 

set(h, 'YTickLabel', []); 

set(h, 'YTick', []); 

  

print_cell(sprintf('figure_%da.png', id), 6, 8, 1); 

print_cell(sprintf('figure_%db.png', id), 6, 8, 4); 

print_cell(sprintf('figure_%dc.png', id), 6, 7, 5); 
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disp(sprintf('Finished generating Cell%d', id)); 

toc(timecount); 

end 

 

A.2. acquire_image_data.m 

NOTES 

This file accomplishes two purposes: 1) assign an identification number (id) to each 

cell, and 2) assign the stack of images that define that cell (through use of the term, 

level). For ease of use, each image stack is given its own subfolder inside the base 

folder, base_dir. The file is constructed in such a way that the nucleus is assigned based 

on one set of images and the actin and membrane are assigned based another set of 

images, however it could be easily modified to accommodate different cellular 

components (e.g. incorporation of microtubules, integrins, or a separate image channel 

for the plasma membrane) if desired. 

MATLAB CODE 

function [nucleus, actin, membrane, dims] = acquire_image_data(id) 

  

disp(sprintf('Reading image stack')); 

  

base_dir = 'C:\Users\finou\Documents\Scott\Research\Image 

Conversion\Images for Conversion'; 

  

if id==1 

    image_downsample = 1; 

    for level = 25:70 
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        filename = sprintf('%s\\cell_001\\contractile vsmc 

40x_1x2.68x_107xtot_focused separatedz%03dc1.tif', base_dir, 

level); 

        I = imresize(imread(filename),image_downsample); 

        nucleus(:,:,71-level) = double(I(:,:,1) + I(:,:,2) + I(:,:,3)) 

/ 256 / 3; 

        filename = sprintf('%s\\cell_001\\contractile vsmc 

40x_1x2.68x_107xtot_focused separatedz%03dc2.tif', base_dir, 

level); 

        I = imresize(imread(filename),image_downsample); 

        actin(:,:,71-level) = double(I(:,:,1) + I(:,:,2) + I(:,:,3)) / 

256 / 3; 

        membrane(:,:,71-level) = double(I(:,:,1) + I(:,:,2) + I(:,:,3)) 

/ 256 / 3; 

        dims = [118 118 0.15*size(nucleus,3)]; 

    end 

end 

  

if id==2 

    image_downsample = 1; 

    for level = 1:28 

        filename = sprintf('%s\\cell_002\\STW01-02 100414 Synthetic 

VSMC 100x 001%02d.jpg', base_dir, level * 3); 

        I = imresize(imread(filename),image_downsample); 

        nucleus(:,:,level) = double(I) / 256; 

        filename = sprintf('%s\\cell_002\\STW01-02 100414 Synthetic 

VSMC 100x 001%02d.jpg', base_dir, level * 3 - 2); 

        I = imresize(imread(filename),image_downsample); 

        actin(:,:,level) = double(I) / 256; 

        membrane(:,:,level) = double(I) / 256; 

        dims = [82 82 0.20*size(nucleus,3)]; 

    end 

end 

  

if id==3 

    for level = 1:36 

        filename = sprintf('%s\\cell_003\\STW01-03 Synthetic & 

Contractile VSMCs 60x 001 Deconvolved%03d.jpg', base_dir, level * 

3); 

        I = imresize(imread(filename),image_downsample); 

        nucleus(:,:,level) = double(I) / 256; 

        filename = sprintf('%s\\cell_003\\STW01-03 Synthetic & 

Contractile VSMCs 60x 001 Deconvolved%03d.jpg', base_dir, level * 

3 - 2); 

        I = imresize(imread(filename),image_downsample); 

        actin(:,:,level) = double(I) / 256; 
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        filename = sprintf('%s\\cell_003\\STW01-03 Synthetic & 

Contractile VSMCs 60x 001 Deconvolved%03d.jpg', base_dir, level * 

3 - 1); 

        I = imresize(imread(filename),image_downsample); 

        membrane(:,:,level) = double(I) / 256; 

        dims = [137 137 0.20*size(nucleus,3)];  

    end 

end 

  

if id==4 

    image_downsample = 1; 

    for level = 1:36 

        filename = 

sprintf('%s\\cell_004\\Deconvolved\\Cell4_DAPI_Deconvolved_%03d.T

IF', base_dir, (level+54) + 100);  

        I = imresize(imread(filename),image_downsample); 

        nucleus(:,:,level) = double(I) / 256; 

        filename = 

sprintf('%s\\cell_004\\Deconvolved\\Cell4_FITC_Deconvolved_%03d.T

IF', base_dir, (level+54) + 100); 

        I = imresize(imread(filename),image_downsample); 

        actin(:,:,level) = double(I) / 256; 

        membrane(:,:,level) = double(I) / 256; 

    end       

    dims = [80 80 0.20*size(nucleus,3)];  

end 

  

if id==5 

    image_downsample = 1; 

    for level = 1:25 

        filename = sprintf('%s\\cell_005\\20110911_Cell1_60X_w2Camera -

FW- DAPI_Deconvolved%03d.TIF', base_dir, (level+108));  

        I = imresize(imread(filename),image_downsample); 

        nucleus(:,:,level) = double(I) / 256; 

        filename = sprintf('%s\\cell_005\\20110911_Cell1_60X_w1Camera -

FW- FITC_Deconvolved%03d.TIF', base_dir, (level+108)); 

        I = imresize(imread(filename),image_downsample); 

        actin(:,:,level) = double(I) / 256; 

        membrane(:,:,level) = double(I) / 256; 

    end       

    dims = [137 137 0.20*size(nucleus,3)];  

end 

  

if id==6 

    image_downsample = 1; 

    for level = 1:25 
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        filename = sprintf('%s\\cell_006\\20110911_Cell2_60X_w2Camera -

FW- DAPI_Deconvolved%03d.TIF', base_dir, (level+121));  

        I = imresize(imread(filename),image_downsample); 

        nucleus(:,:,level) = double(I) / 256; 

        filename = sprintf('%s\\cell_006\\20110911_Cell2_60X_w1Camera -

FW- FITC_Deconvolved%03d.TIF', base_dir, (level+121)); 

        I = imresize(imread(filename),image_downsample); 

        actin(:,:,level) = double(I) / 256; 

        membrane(:,:,level) = double(I) / 256; 

    end       

    dims = [137 137 0.20*size(nucleus,3)];  

end 

  

if id==7 

    image_downsample = 1; 

    for level = 1:23 

        filename = sprintf('%s\\cell_007\\20111010_VSMC_S-

_Cell1_60x_DAPI_Deconvolved%02d.TIF', base_dir, (level+17));  

        I = imresize(imread(filename),image_downsample); 

        nucleus(:,:,level) = double(I) / 256; 

        filename = sprintf('%s\\cell_007\\20111010_VSMC_S-

_Cell1_60x_FITC_Deconvolved%02d.TIF', base_dir, (level+17)); 

        I = imresize(imread(filename),image_downsample); 

        actin(:,:,level) = double(I) / 256; 

        membrane(:,:,level) = double(I) / 256; 

    end       

    dims = [137 137 0.20*size(nucleus,3)];  

end 

  

if id==8 

    image_downsample = 1; 

    for level = 1:19 

        filename = sprintf('%s\\cell_008\\20111010_VSMC_S-

_Cell2_60x_DAPI_Deconvolved%02d.TIF', base_dir, (level+30));  

        I = imresize(imread(filename),image_downsample); 

        nucleus(:,:,level) = double(I) / 256; 

        filename = sprintf('%s\\cell_008\\20111010_VSMC_S-

_Cell2_60x_FITC_Deconvolved%02d.TIF', base_dir, (level+30)); 

        I = imresize(imread(filename),image_downsample); 

        actin(:,:,level) = double(I) / 256; 

        membrane(:,:,level) = double(I) / 256; 

    end       

    dims = [137 137 0.20*size(nucleus,3)];  

end 

  

if id==9 

    image_downsample = 1; 
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    for level = 1:18 

        filename = sprintf('%s\\cell_009\\20111010_VSMC_S-

_Cell3_60x_DAPI_Deconvolved%02d.TIF', base_dir, (level+19));  

        I = imresize(imread(filename),image_downsample); 

        nucleus(:,:,level) = double(I) / 256; 

        filename = sprintf('%s\\cell_009\\20111010_VSMC_S-

_Cell3_60x_FITC_Deconvolved%02d.TIF', base_dir, (level+19)); 

        I = imresize(imread(filename),image_downsample); 

        actin(:,:,level) = double(I) / 256; 

        membrane(:,:,level) = double(I) / 256; 

    end       

    dims = [137 137 0.20*size(nucleus,3)];  

end 

  

if id==10 

    image_downsample = 1; 

    for level = 1:23 

        filename = sprintf('%s\\cell_010\\20111010_VSMC_S-

_Cell4_60x_DAPI_Deconvolved%02d.TIF', base_dir, (level+16));  

        I = imresize(imread(filename),image_downsample); 

        nucleus(:,:,level) = double(I) / 256; 

        filename = sprintf('%s\\cell_010\\20111010_VSMC_S-

_Cell4_60x_FITC_Deconvolved%02d.TIF', base_dir, (level+16)); 

        I = imresize(imread(filename),image_downsample); 

        actin(:,:,level) = double(I) / 256; 

        membrane(:,:,level) = double(I) / 256; 

    end       

    dims = [137 137 0.20*size(nucleus,3)];  

end 

  

if id==11 

    image_downsample = 1; 

    for level = 1:21 

        filename = sprintf('%s\\cell_011\\20111010_VSMC_S-

_Cell5_60x_DAPI_Deconvolved%02d.TIF', base_dir, (level+16));  

        I = imresize(imread(filename),image_downsample); 

        nucleus(:,:,level) = double(I) / 256; 

        filename = sprintf('%s\\cell_011\\20111010_VSMC_S-

_Cell5_60x_FITC_Deconvolved%02d.TIF', base_dir, (level+16)); 

        I = imresize(imread(filename),image_downsample); 

        actin(:,:,level) = double(I) / 256; 

        membrane(:,:,level) = double(I) / 256; 

    end       

    dims = [137 137 0.20*size(nucleus,3)];  

end 

  

if id==12 
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    image_downsample = 1; 

    for level = 1:23 

        filename = sprintf('%s\\cell_012\\20111010_VSMC_S-

_Cell6_60x_DAPI_Deconvolved%02d.TIF', base_dir, (level+16));  

        I = imresize(imread(filename),image_downsample); 

        nucleus(:,:,level) = double(I) / 256; 

        filename = sprintf('%s\\cell_012\\20111010_VSMC_S-

_Cell6_60x_FITC_Deconvolved%02d.TIF', base_dir, (level+16)); 

        I = imresize(imread(filename),image_downsample); 

        actin(:,:,level) = double(I) / 256; 

        membrane(:,:,level) = double(I) / 256; 

    end       

    dims = [137 137 0.20*size(nucleus,3)];  

end 

  

if id==13 

    image_downsample = 1; 

    for level = 1:21 

        filename = sprintf('%s\\cell_013\\20111010_VSMC_S-

_Cell7_60x_DAPI_Deconvolved%02d.TIF', base_dir, (level+20));  

        I = imresize(imread(filename),image_downsample); 

        nucleus(:,:,level) = double(I) / 256; 

        filename = sprintf('%s\\cell_013\\20111010_VSMC_S-

_Cell7_60x_FITC_Deconvolved%02d.TIF', base_dir, (level+20)); 

        I = imresize(imread(filename),image_downsample); 

        actin(:,:,level) = double(I) / 256; 

        membrane(:,:,level) = double(I) / 256; 

    end       

    dims = [137 137 0.20*size(nucleus,3)];  

end 

  

if id==14 

    image_downsample = 1; 

    for level = 1:22 

        filename = sprintf('%s\\cell_014\\20111010_VSMC_S-

_Cell8_60x_DAPI_Deconvolved%02d.TIF', base_dir, (level+20));  

        I = imresize(imread(filename),image_downsample); 

        nucleus(:,:,level) = double(I) / 256; 

        filename = sprintf('%s\\cell_014\\20111010_VSMC_S-

_Cell8_60x_FITC_Deconvolved%02d.TIF', base_dir, (level+20)); 

        I = imresize(imread(filename),image_downsample); 

        actin(:,:,level) = double(I) / 256; 

        membrane(:,:,level) = double(I) / 256; 

    end       

    dims = [137 137 0.20*size(nucleus,3)];  

end 
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% Add 5 blank z levels to the top 

z_levels = size(nucleus,3); 

for i = 1:5 

    nucleus(:,:,z_levels+i) = zeros; 

    actin(:,:,z_levels+i) = zeros; 

    membrane(:,:,z_levels+i) = zeros; 

end 

dims(3) = dims(3) * (z_levels + 5) / z_levels; 

  

for level=1:size(nucleus,3) 

    nucleus(:,:,level) = nucleus(:,:,level)'; 

end 

for level=1:size(actin,3) 

    actin(:,:,level) = actin(:,:,level)'; 

end 

for level=1:size(membrane,3) 

    membrane(:,:,level) = membrane(:,:,level)'; 

end 

  

end 

A.3. extract_nucleus.m 

NOTES 

This file generates the mesh for the nucleus. 

MATLAB CODE 

function [Faces, Vertices, Voxelmap] = extract_nucleus(nucleus, 

downsample) 

  

disp(sprintf('Segmenting nucleus')); 

[R, C, L] = size(nucleus); %R: Rows, C: Columns, L: Levels - 3D matrix 

  

  

% EXTRACT IMAGE 

  

% Segment based on simple thresholding 

max_intensity = max(max(max(nucleus))); 

min_intensity = min(min(min(nucleus))); 
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threshold = min_intensity + 0.25 * (max_intensity - min_intensity); 

%cutoff pixel intensities at 25% (empirically chosen) of max 

Voxelmap = nucleus > threshold; 

  

% Dilate the image twice (hopefully closing boundary gaps)  

Voxelmap = imdilate(Voxelmap, ones(3,3,3)); 

Voxelmap = imdilate(Voxelmap, ones(3,3,3)); 

  

% Fill interior gaps 

Voxelmap = imfill(Voxelmap, 'holes'); 

  

% Remove connected components touching borders in x and y 

mask = zeros(3,3,3); mask(:,:,2) = ones; 

Voxelmap = imclearborder(Voxelmap, mask); 

  

% Erode image to smooth out its boundary 

Voxelmap([1 R],:,:) = zeros; %zero out top and bottom rows 

Voxelmap(:,[1 C],:) = zeros; %zero out right and left columns 

Voxelmap(:,:,[1 L]) = zeros; %zero out top and bottom levels - allows 

smoothing to work along borders 

mask = ones(3,3,3); mask(1:2:3, 1:2:3, 1:2:3) = zeros; %diamond-shaped 

erosion element (all corners = 0) 

Voxelmap = imerode(Voxelmap, mask); 

Voxelmap = imerode(Voxelmap, mask); 

Voxelmap = imerode(Voxelmap, mask); 

Voxelmap = imerode(Voxelmap, mask); 

Voxelmap = imerode(Voxelmap, mask); 

  

% Find connected components and retain only the largest one 

Voxelmap = retain_largest_component(Voxelmap); 

  

  

% COMPUTE MESH OUTLINE 

  

% smooth3 applies gaussian filter, takes everything > 0.5 to apply 

isosurface  

new_dims = round(downsample .* size(Voxelmap)); 

temp = zeros(new_dims(1)+2, new_dims(2)+2, new_dims(3)+2); 

temp(2:new_dims(1)+1,2:new_dims(2)+1,2:new_dims(3)+1) = 

smooth3(downsample_matrix(Voxelmap, new_dims)); 

fv = isosurface(temp, 0.1);  

%fv = reducepatch(fv, 0.05, 'fast'); 

Faces = fv.faces; %list of image faces, n by 3, each row has indices 

(into fv.vertices) of points around a triangular face 

Vertices = fv.vertices; %list of all points in mesh, one per row (n by 

3), each row x,y,z of one point 

Vertices = Vertices - 1; 
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end 

A.4. extract_cell_boundary.m 

NOTES 

This file generates the mesh for the cell boundary. 

MATLAB CODE  

function [Faces, Vertices, Voxelmap] = extract_cell_boundary(actin, 

membrane, nvoxels, downsample) 

  

disp(sprintf('Segmenting cell boundary')); 

[R, C, L] = size(actin); 

  

% FILL DOWNWARD 

Voxelmap = actin + membrane; 

Voxelmap = smooth3(Voxelmap); %gaussian smoothing 

%fill in vertical holes by taking brightest point and filling with 

equal 

%intensity downward (no overhangs) 

for r=1:R 

    for c=1:C 

        for l=1:L 

            Voxelmap(r,c,l) = max(max(max(Voxelmap(r,c,l:L)))); 

        end 

    end 

end 

  

% EXTRACT IMAGE 

% segment based on simple thresholding 

max_intensity = max(max(max(Voxelmap))); 

min_intensity = min(min(min(Voxelmap))); 

threshold = min_intensity + 0.05 * (max_intensity - min_intensity); 

Voxelmap = double(Voxelmap > threshold) + nvoxels - double(Voxelmap > 

threshold) .* nvoxels; %make sure nucleus is inside cell 

  

% Dilate the image (hopefully closing boundary gaps) 

Voxelmap = imdilate(Voxelmap, ones(3,3,3)); 
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add_room_at_top = zeros(3,3,3); add_room_at_top(2,2,2) = 1; 

add_room_at_top(2,2,3) = 1; 

Voxelmap = imdilate(Voxelmap, add_room_at_top); Voxelmap = 

imdilate(Voxelmap, add_room_at_top);  

Voxelmap = imdilate(Voxelmap, add_room_at_top); Voxelmap = 

imdilate(Voxelmap, add_room_at_top);  

  

  

% Fill interior gaps 

Voxelmap = imfill(Voxelmap, 'holes'); 

for i=1:L 

    Voxelmap(:,:,i) = imfill(Voxelmap(:,:,i), 'holes'); 

end 

  

% Remove connected components touching borders in x and y 

mask = zeros(3,3,3); mask(:,:,2) = ones; 

Voxelmap = imclearborder(Voxelmap, mask); 

  

% Erode image to smooth out its boundary 

Voxelmap([1 R],:,:) = zeros; 

Voxelmap(:,[1 C],:) = zeros; 

Voxelmap(:,:,[1 L]) = zeros; 

mask = ones(3,3,3); mask(1:2:3, 1:2:3, 1) = zeros; 

Voxelmap = imerode(Voxelmap, mask); 

Voxelmap = imerode(Voxelmap, mask); 

  

% Find connected components and retain only the largest one 

Voxelmap = retain_largest_component(Voxelmap > 0); 

  

% COMPUTE MESH OUTLINE 

new_dims = round(downsample .* size(Voxelmap)); 

temp = zeros(new_dims(1)+2, new_dims(2)+2, new_dims(3)+2); 

temp(2:new_dims(1)+1,2:new_dims(2)+1,2:new_dims(3)+1) = 

smooth3(downsample_matrix(Voxelmap, new_dims)); 

[Faces Vertices] = isosurface(temp, 0.1);  

Vertices = Vertices - 1; 

  

end 
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A.5. compute_actin_fibers.m 

NOTES 

This file generates the mesh for the actin fibers. 

MATLAB CODE 

function [fibers, fverts] = compute_actin_fibers(id, cfaces, cverts, 

nfaces, nverts, num_potential_fibers) 

  

filename = sprintf('fiber_cache_%d.txt', id); 

fid = fopen (filename, 'r'); 

if fid ~= -1 

    fclose (fid); 

    disp(sprintf('Reading cached actin fiber matrix from %s', 

filename)); 

    fibers = load(filename); 

    filename = sprintf('fiber_coordinates_%d.txt', id); 

    fverts = load(filename); 

    disp(sprintf('Matrix contains %d geometrically feasible fibers', 

sum(sum(fibers)))); 

    return; 

end 

  

averts = [cverts; nverts];  

afaces = [cfaces; nfaces+size(cverts,1)]; 

  

fprintf('Computing all potential actin fibers (this takes a 

while...)\n'); 

tic; 

N = size(cverts,1); 

fibers = zeros(N,N); 

  

nucleus_centroid = mean(nverts); 

  

fprintf ('      '); 

for v1=1:N 

    fprintf ('\b\b\b\b\b\b%5.1f%%', v1*100 / N); 

    for v2=v1+1:N 

        if rand < num_potential_fibers / (N*(N-1)/2), 
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            fibers(v1,v2) = actin_fiber_score(v1, v2, afaces, averts, 

nucleus_centroid); 

        end 

    end 

end 

fprintf ('\b\b\b\b\b\b%.1f%%\n', 100); 

  

disp(sprintf('Saving cache of actin fiber matrix in %s', filename)); 

save(filename,'fibers','-ascii'); 

  

filename = sprintf('fiber_coordinates_%d.txt', id); 

disp(sprintf('Saving cache of actin fiber endpoint coordinates in %s', 

filename)); 

save(filename,'cverts','-ascii'); 

fverts = cverts; 

  

toc 

  

end 

A.6. write_lp.m 

NOTES 

This file generates the linear program that is used to compute the actin fiber scores. 

MATLAB  CODE 

function write_lp(id, cvoxels, nvoxels, actin, fibers, fverts, 

avg_fiber_len, rescale_factor, translate_amt, voxel_density) 

  

% Parameters 

Ndirs = 8;          % number of (2d) directions at each voxel 

  

disp('Writing humongous linear program'); 

  

% Compute sampled voxel grid 

num_voxels = 0; 

vox_i = []; 

vox_j = []; 

vox_k = []; 
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vox_d = []; 

vox_m = []; 

tic 

  

% set up the colormap for a figure  

function set_colormap(fig_number, reds, greens, blues) 

    cmap = zeros(256,3); 

    cmap(:,1) = reds; 

    cmap(:,2) = greens; 

    cmap(:,3) = blues; 

    set(fig_number, 'Colormap', cmap); 

end 

  

for k=1:voxel_density:size(cvoxels,3) 

    for i=1:voxel_density:size(cvoxels,1) 

        for j=1:voxel_density:size(cvoxels,2) 

            if cvoxels(i,j,k) - nvoxels(i,j,k) > 0, 

                I = 0; 

                for d=0:Ndirs-1, 

                    num_voxels = num_voxels + 1; 

                    vox_i(num_voxels) = i; 

                    vox_j(num_voxels) = j; 

                    vox_k(num_voxels) = k; 

                    vox_d(num_voxels) = d; 

                    %First two lines are the "eye candy" version: 

                    %[vox_m(num_voxels), I2] = 

measure_directional_voxel_withgraphics(actin(:,:,k), i, j, d, 

Ndirs); 

                    %I = I + I2; 

                    %Following one line is for no "eye candy" 

                    vox_m(num_voxels) = 

measure_directional_voxel(actin(:,:,k), i, j, d, Ndirs); 

                end 

                %Following 4 lines are for "eye candy" version 

                %figure(3); 

                %bw_color_curve = linspace(0,1,256) .^ 0.5;  % add 

small amount of gain 

                %set_colormap(3, 0*bw_color_curve, bw_color_curve, 

0*bw_color_curve); 

                %imagesc(I); 

            end 

        end 

    end 

end 

toc 
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disp(sprintf('Subsampled voxel grid for LP has %d voxels * %d 

directions = %d total dvoxels', num_voxels / Ndirs, Ndirs, 

num_voxels)); 

  

filename = sprintf('actin%d.lp', id); 

fid = fopen(filename, 'w'); 

if fid < 0, 

    disp(sprintf('Error opening file %s for writing', filename)); 

    return; 

end 

  

fprintf (fid, 'Minimize '); 

for i=1:num_voxels 

    if i>1, fprintf (fid,'+'); end 

    fprintf (fid, 'z%d', i); 

end 

fprintf (fid, '\n'); 

         

fprintf (fid, 'Such that\n'); 

for i=1:num_voxels 

    fprintf (fid, '-y%d - z%d <= -%.4f\n', i, i, vox_m(i)); 

    fprintf (fid, 'y%d - z%d <= %.4f\n', i, i, vox_m(i)); 

end 

  

tic; 

fimage = 0*actin; 

num_fibers = sum(sum(fibers)); 

coeffs = sparse(num_fibers, num_voxels); 

f = 1; 

fprintf ('      '); 

for i=1:size(fibers,1) 

    for j=1:size(fibers,2) 

        if fibers(i,j)>0  

            fprintf ('\b\b\b\b\b\b%5.1f%%', 100 * f / num_fibers); 

            p1 = (fverts(i,:)+translate_amt)./rescale_factor; 

            p2 = (fverts(j,:)+translate_amt)./rescale_factor; 

            tmp = p1(2); p1(2) = p1(1); p1(1) = tmp; 

            tmp = p2(2); p2(2) = p2(1); p2(1) = tmp; 

            [I,J,K,vals] = draw_one_actin(p1, p2); 

            for r=1:length(I) 

                if I(r)>=1 && I(r)<=size(fimage,1) && J(r)>=1 && 

J(r)<=size(fimage,2) && K(r)>=1 && K(r)<=size(fimage,3), 

                    fimage(I(r),J(r),K(r)) = vals(r); 

                end 

            end 

            for v=1:num_voxels 
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                if dist_pt_to_segment([vox_i(v) vox_j(v) vox_k(v)], p1, 

p2) < 8 

                    coeff = 

measure_directional_voxel(fimage(:,:,vox_k(v)), vox_i(v), 

vox_j(v), vox_d(v), Ndirs); 

                    if coeff > 0.001, coeffs(f, v) = coeff * 1000; end 

                end 

            end 

            for r=1:length(I) 

                if I(r)>=1 && I(r)<=size(fimage,1) && J(r)>=1 && 

J(r)<=size(fimage,2) && K(r)>=1 && K(r)<=size(fimage,3), 

                    fimage(I(r),J(r),K(r)) = 0; 

                end 

            end     

            f = f + 1; 

        end 

    end 

end 

fprintf ('\b\b\b\b\b\b%5.1f%%\n', 100); 

toc 

  

[fibers_i, fibers_j] = find(fibers); 

for v=1:num_voxels 

    fprintf (fid, '-y%d', v); 

    f = 1; 

    [I, J, vals] = find(coeffs(:,v)); 

    k = 1; 

    for r=1:length(fibers_i) 

        i = fibers_i(r); 

        j = fibers_j(r); 

        if k<=length(I) 

            if I(k)==f 

                fprintf (fid, '+%.3fx%dx%d', vals(k), i, j); 

                k=k+1; 

            end 

        end 

        f = f + 1; 

    end 

    fprintf (fid, ' = 0\n'); 

end 

  

first = 1; 

for i=1:size(fibers,1) 

    for j=1:size(fibers,2) 

        if fibers(i,j)>0 

            L = norm(fverts(i,:) - fverts(j,:)); 

            if first==0 && L-avg_fiber_len>=0, fprintf(fid,'+'); end 
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            first = 0; 

            fprintf (fid,'%.3fx%dx%d',L-avg_fiber_len, i, j); 

        end 

    end 

end 

fprintf (fid, ' >= 0\n'); 

                 

fprintf (fid, 'Bounds\n'); 

for i=1:size(fibers,1) 

    for j=1:size(fibers,2) 

        if fibers(i,j)>0 

            fprintf (fid, ' 0 <= x%dx%d <= 1\n', i, j); 

        end 

    end 

end 

  

fprintf (fid, 'End\n'); 

  

fclose (fid); 

  

end 

A.7. solve_lp.m 

NOTES 

This file solves the linear program and computes the actin fiber scores. 

MATLAB  CODE 

function solve_lp(id) 

  

f = fopen ('run_cplex.txt', 'w'); 

fprintf (f, 'read actin%d.lp\n', id); 

fprintf (f, 'opt\n', id); 

fprintf (f, 'disp sol var x*\n', id); 

fprintf (f, 'quit\n', id); 

fclose (f); 

  

disp('Running CPLEX now...'); 
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cmd = sprintf ('cplex < run_cplex.txt | grep "^x" | tr "x" " " > 

actin%d.sol', id); 

system(cmd); 

disp('Finished running CPLEX'); 

  

end 

A.8. write_stl.m 

NOTES 

This file generates a .stl mesh for the nucleus and cell boundary. STL files are simple 

mesh files of 3 node triangles and are a universal type of mesh file and are therefore 

useful for testing a mesh in a new computer aided engineering (CAE) software or for 

printing on a 3D rapid prototyping printer. 

MATLAB CODE 

function write_stl(filename, faces, verts) 

  

f = fopen(filename, 'w'); 

  

fprintf (f, 'solid %s\n', filename); 

  

for i=1:size(faces,1) 

    fprintf (f, ' facet normal 0.0 0.0 0.0\n'); 

    fprintf (f, '  outer loop\n'); 

    v1 = faces(i,1); 

    v2 = faces(i,2); 

    v3 = faces(i,3); 

    fprintf (f, '   vertex %.1f %.1f %.1f\n', verts(v1,1), verts(v1,2), 

verts(v1,3)); 

    fprintf (f, '   vertex %.1f %.1f %.1f\n', verts(v2,1), verts(v2,2), 

verts(v2,3)); 

    fprintf (f, '   vertex %.1f %.1f %.1f\n', verts(v3,1), verts(v3,2), 

verts(v3,3)); 

    fprintf (f, '  endloop\n'); 

    fprintf (f, ' endfacet\n'); 



190 

 

end 

  

fprintf (f, 'endsolid\n'); 

  

fclose (f); 

A.9. sample_actin_fibers_bycutoff.m 

NOTES 

This file samples all generated actin fibers and assigns only those fibers that are 

greater than the cutoff value, cutoff (assigned in reconstruct_whole_cell.m), to the 

model. 

MATLAB  CODE 

function s = sample_actin_fibers_bycutoff(all_fibers, cutoff) 

  

s = []; 

if size(all_fibers,1) > 0 

    s = all_fibers(find(all_fibers(:,3)>=cutoff),:); 

    disp(sprintf('Selected %d actin fibers (with scores at least %.4f) 

from %d in total distribution', size(s,1), cutoff, 

size(all_fibers,1))); 

end 

  

end 

A.10. sample_actin_fibers.m 

NOTES 

This file samples all generated actin fibers and randomly assigns a specific number of 

fibers,  Nfibers (assigned in reconstruct_whole_cell.m), to the model from the 
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probabilistic distribution of their fiber scores. By selecting fibers in this manner, the 

fibers are weighted so that those with higher scores are more likely to be chosen. This 

code was not used for the final analysis, but rather for studies where a specific number of 

fibers were desired for model validation purposes. 

MATLAB CODE 

function s = sample_actin_fibers(all_fibers, Nfibers) 

  

N = size(all_fibers,1); 

  

if Nfibers > N, 

    disp(sprintf('Warning: %d fibers requested, when only %d exist to 

sample from!', Nfibers, N)); 

    s = all_fibers; 

    return; 

end 

  

x = zeros(N,1); 

  

for i=1:Nfibers 

    while 0<1 

        r = rand * sum(all_fibers(:,3)); 

        j = 1; 

        while 0<1 

            r = r - all_fibers(j, 3); 

            if r < 0, break; end 

            j = j + 1; 

        end 

        if x(j) == 0, break; end 

    end 

    x(j) = 1; 

end 

  

s = all_fibers(find(x),:); 

  

disp(sprintf('Sampled %d actin fibers from %d in total distribution', 

Nfibers, N)); 

  

end 
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A.11. write_patran_session.m 

NOTES 

This file generates a session file (.ses) that is read by Patran to import the meshes 

generated in MATLAB into the finite element software. This file organizes meshes into 

groups that can be used to easily select individual components of the cell. It also defines 

linear elastic material properties for the actin, cytoplasm, and nucleus and assigns those 

properties to the actin fibers. Material properties are not automatically assigned to the 

cytoplasm and nucleus due to the unpredictable nature of the way Patran converts their 

2D mesh outlines into 3D mesh solids. This file also automatically generates the 

geometry for the AFM probe and places it 0.25 µm above the highest node of the cell 

boundary as well as defining the parameters for movement of the AFM probe. Finally, 

this file sets up the analysis parameters (solver type, number of increments, analytical 

time, adaptive meshing, etc.) used in the model. Each of these parameters may be 

changed to fit various analysis types either in Patran or in this file, should such changes 

be desired. 

MATLAB  CODE 

function write_patran_session(patran_dir, nfaces, nverts, cfaces, 

cverts, fverts, volmesh_size, fibers, probe_speed, probe_indent, 

id, fcross, frad) 

  

filename = sprintf('%s\\build_cell%d.ses', patran_dir, id); 

f = fopen(filename, 'w'); 

  

%% Initial Setup 

% Header stuff 



193 

 

fprintf (f, 'uil_file_new.go( 

"C:\\MSC.Software\\Patran_x64\\20102\\md_template.db", 

"%s\\Cell%d.db" )\n', patran_dir, id); 

fprintf (f, 'set_current_dir( "%s" )\n', patran_dir); 

fprintf (f, 'uil_pref_analysis.set_analysis_preference( "MSC.Marc", 

"Structural", ".dat",  ".t16", "No Mapping" )\n'); 

fprintf (f, 'ui_exec_function( "mesh_seed_display_mgr", "init" )\n'); 

  

% Isometric View 

fprintf (f, 'ga_view_aa_set( -67., 0., -34. )\n'); 

  

% Increase Node Size 

fprintf (f, 'node_size( 9 )\n'); 

  

% Create all groups 

fprintf (f, 'ga_group_create( "nimport" )\n'); 

fprintf (f, 'ga_group_create( "cimport" )\n'); 

fprintf (f, 'ga_group_create( "cimport_base" )\n'); 

fprintf (f, 'ga_group_create( "AFMprobe" )\n'); 

fprintf (f, 'ga_group_create( "ntet" )\n'); 

fprintf (f, 'ga_group_create( "ctet" )\n'); 

fprintf (f, 'ga_group_create( "actin" )\n'); 

  

%% Properties (Part 1/3) 

%%% Isotropic 

%%%%%% Actin 

fprintf (f, 'material.create( "Analysis code ID", 20, "Analysis type 

ID", 1, "actin_mat", @\n'); 

fprintf (f, '0, "Date: 23-Aug-11           Time: 13:39:16", 

"Isotropic", 1, @\n'); 

fprintf (f, '"Directionality", 1, "Linearity", 1, "Homogeneous", 0, 

"Elastic", 1, @\n');  

fprintf (f, '"ModelOptions & IDs", ["Entered Values", "", "", "", ""], 

[139, 0, 0, 0, 0], @\n');  

fprintf (f, '"Active Flag", 1, "Create", 10, "External Flag", FALSE, 

"Property IDs", @\n'); 

fprintf (f, '["Elastic Modulus", "Poisson Ratio"], [2, 5, 0], "Property 

Values", @\n'); 

fprintf (f, '["1.9e3", "0.49", ""] )\n'); 

%%%%%% Nucleus 

fprintf (f, 'material.create( "Analysis code ID", 20, "Analysis type 

ID", 1, "nucleus_mat", @\n'); 

fprintf (f, '0, "Date: 23-Aug-11           Time: 13:39:16", 

"Isotropic", 1, @\n'); 

fprintf (f, '"Directionality", 1, "Linearity", 1, "Homogeneous", 0, 

"Elastic", 1, "Model @\n'); 
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fprintf (f, 'Options & IDs", ["Entered Values", "", "", "", ""], [139, 

0, 0, 0, 0], "Active @\n'); 

fprintf (f, 'Flag", 1, "Create", 10, "External Flag", FALSE, "Property 

IDs", ["Elastic @\n'); 

fprintf (f, 'Modulus", "Poisson Ratio"], [2, 5, 0], "Property Values", 

["3.3e-3", "0.49", ""] )\n'); 

%%%%%% Cytoplasm 

fprintf (f, 'material.create( "Analysis code ID", 20, "Analysis type 

ID", 1, "cytoplasm_mat"@\n'); 

fprintf (f, ', 0, "Date: 23-Aug-11           Time: 13:39:16", 

"Isotropic", 1, @\n'); 

fprintf (f, '"Directionality", 1, "Linearity", 1, "Homogeneous", 0, 

"Elastic", 1, "Model @\n'); 

fprintf (f, 'Options & IDs", ["Entered Values", "", "", "", ""], [139, 

0, 0, 0, 0], "Active @\n'); 

fprintf (f, 'Flag", 1, "Create", 10, "External Flag", FALSE, "Property 

IDs", ["Elastic @\n'); 

fprintf (f, 'Modulus", "Poisson Ratio"], [2, 5, 0], "Property Values", 

["2.25e-3", "0.49", ""] )\n'); 

%%% Create 1D Actin Beam Cross Section 

fprintf (f, 'beam_section_create( "actin_xsection", "ROD", ["%d"] )\n', 

frad); 

  

%% Geometry 

% Add all nodes for nucleus 

fprintf (f, 'ga_group_current_set( "nimport" )\n'); 

fprintf (f, 'STRING fem_create_nodes__nodes_created[VIRTUAL]\n'); 

for i=1:size(nverts,1) 

    x = nverts(i,1); 

    y = nverts(i,2); 

    z = nverts(i,3); 

    fprintf (f, 'fem_create_nodes_1( "Coord 0", "Coord 0", 3, "#", 

"[%.3f %.3f %.3f]", fem_create_nodes__nodes_created )\n', x, y, 

z); 

end 

nucleus_min_node = 1; nucleus_max_node = size(nverts,1); 

  

% Add all nodes for cell and identify coordinates of the highest one 

fprintf (f, 'ga_group_current_set( "cimport" )\n'); 

highest_z = 0; 

for i=1:size(cverts,1) 

    x = cverts(i,1); 

    y = cverts(i,2); 

    z = cverts(i,3); 

    if z > highest_z 

       highest_x = x; 

       highest_y = y; 
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       highest_z = z; 

    end 

    fprintf (f, 'fem_create_nodes_1( "Coord 0", "Coord 0", 3, "#", 

"[%.3f %.3f %.3f]", fem_create_nodes__nodes_created )\n', x, y, 

z); 

end 

cell_min_node = nucleus_max_node+1; cell_max_node = 

nucleus_max_node+size(cverts,1); 

  

% Make a group out of the base vertices 

base_cutoff = highest_z/10; 

fprintf (f, 'ga_group_current_set( "cimport_base" )\n'); 

z_plane = min(cverts(:,3)); % min z plane of cell boundary mesh 

base_verts = find(cverts(:,3) <= z_plane + base_cutoff); 

for i=1:size(base_verts,1) 

    fprintf (f, 'ga_group_entity_add( "cimport_base", "Node %d" )\n', 

size(nverts,1)+base_verts(i)); 

end 

  

% Decrease Node Size 

fprintf (f, 'node_size( 0 )\n'); 

  

% Add Elements for nucleus 

fprintf (f, 'ga_group_current_set( "nimport" )\n'); 

fprintf (f, 'STRING fem_create_elemen_elems_created[VIRTUAL]\n'); 

count = 1; 

count_node = 1; 

nucleus_min_elt = 1;  

nucleus_min_node = 1;  

for i=1:size(nfaces,1) 

    n1 = nfaces(i,1); 

    n2 = nfaces(i,2); 

    n3 = nfaces(i,3); 

    fprintf (f, 'fem_create_elems_1( "Tri ", "Tria6", "%d", "Standard", 

3, "Node %d", "Node %d", "Node %d", "", "", "", "", "", 

fem_create_elemen_elems_created )\n', count, n1, n2, n3); 

    count = count + 1; 

    count_node = count_node + 6; 

end 

nucleus_max_elt = count-1; 

nucleus_max_node = count_node - 1; 

  

% Add Elements for base of cell 

fprintf (f, 'ga_group_current_set( "cimport_base" )\n'); 

cell_min_elt = count; 

cell_min_node = count_node; 

for i=1:size(cfaces,1) 
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    n1 = cfaces(i,1); 

    n2 = cfaces(i,2); 

    n3 = cfaces(i,3); 

    face_max_z = max([cverts(n1,3) cverts(n2,3) cverts(n3,3)]); 

    if face_max_z <= z_plane + base_cutoff 

        fprintf (f, 'fem_create_elems_1( "Tri ", "Tria6", "%d", 

"Standard", 3, "Node %d", "Node %d", "Node %d", "", "", "", "", 

"", fem_create_elemen_elems_created )\n', count, 

n1+size(nverts,1), n2+size(nverts,1), n3+size(nverts,1)); 

        count = count + 1; 

        count_node = count_node + 6; 

    end 

end 

cell_max_base_elt = count - 1; 

cell_max_base_node = count_node - 1; 

  

% Add Elements for top of cell 

fprintf (f, 'ga_group_current_set( "cimport" )\n'); 

fprintf (f, 'ga_group_entity_add( "cimport", "Element %d:%d" )\n', 

nucleus_max_elt+1, count); 

for i=1:size(cfaces,1) 

    n1 = cfaces(i,1); 

    n2 = cfaces(i,2); 

    n3 = cfaces(i,3); 

    face_max_z = max([cverts(n1,3) cverts(n2,3) cverts(n3,3)]); 

    if face_max_z > z_plane + base_cutoff 

        fprintf (f, 'fem_create_elems_1( "Tri ", "Tria6", "%d", 

"Standard", 3, "Node %d", "Node %d", "Node %d", "", "", "", "", 

"", fem_create_elemen_elems_created )\n', count, 

n1+size(nverts,1), n2+size(nverts,1), n3+size(nverts,1)); 

        count = count+1; 

    end 

end 

cell_max_elt = count-1; 

  

%Add AFM probe 

fprintf (f, 'ga_group_current_set( "AFMprobe" )\n'); 

fprintf (f, 'STRING asm_create_cord_3po_created_ids[VIRTUAL]\n'); 

probe_offset = 0.25; %um 

fprintf (f, 'asm_const_coord_3point( "1", "Coord 0", 1, "[%d %d %d]", 

"[%d %d %d]", "[%d %d %d]", asm_create_cord_3po_created_ids )\n', 

highest_x,highest_y,highest_z+2.5+probe_offset, 

highest_x,highest_y,highest_z+4.5, 

highest_x+1,highest_y,highest_z+3.5); 

  

fprintf (f, 'STRING sgm_create_curve_2d_created_ids[VIRTUAL]\n'); 
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fprintf (f, 'sgm_const_curve_2d_arc2point_v2( "1", 1, 0., FALSE, FALSE, 

1, "Coord 1.1",  @\n'); 

fprintf (f, '"[0 0 0]", "[0 2.5 0]", "[0 0 -2.5]", FALSE, 

sgm_create_curve_2d_created_ids )\n'); 

fprintf (f, 'STRING sgm_sweep_surface_r_created_ids[VIRTUAL]\n'); 

fprintf (f, 'sgm_const_surface_revolve( "1", "Coord 1.3", 360., 0., 

"Coord 0", "Curve 1",  @\n'); 

fprintf (f, 'sgm_sweep_surface_r_created_ids )\n'); 

fprintf (f, 'STRING asm_delete_any_deleted_ids[VIRTUAL]\n'); 

fprintf (f, 'asm_delete_coord( "Coord 1", asm_delete_any_deleted_ids 

)\n'); 

  

%%% Add fibers 

fiber_min_elt = count; 

num_divisions = 10; 

fiber_max_elt = count-1+num_divisions; 

fprintf (f, 'ga_group_current_set( "actin" )\n'); 

for i=1:size(fibers,1) 

    node1_id = fibers(i,1); 

    node2_id = fibers(i,2); 

    node1_pos = fverts(node1_id, :); % node1_pos = [x y z] 

    node2_pos = fverts(node2_id, :); % node2_pos = [x y z] 

    node1_pos_shrunk = 0.1 * node2_pos + 0.9 * node1_pos; 

    node2_pos_shrunk = 0.1 * node1_pos + 0.9 * node2_pos; 

    fprintf (f, 'STRING asm_line_2point_created_ids[VIRTUAL]\n'); 

    fprintf (f, 'asm_const_line_2point( "#", "[%.3f %.3f %.3f]", "[%.3f 

%.3f %.3f]", 0, "", 50., 1, asm_line_2point_created_ids )\n', 

node1_pos_shrunk(1), node1_pos_shrunk(2), node1_pos_shrunk(3), 

node2_pos_shrunk(1), node2_pos_shrunk(2), node2_pos_shrunk(3)); 

    fprintf (f, 'ui_exec_function( "mesh_seed_display_mgr", "init" 

)\n'); 

    fprintf (f, 'mesh_seed_create( "Line %d", 1, %d, 0., 0., 0. )\n', 

i+1, num_divisions); 

    fprintf (f, 'INTEGER fem_create_mesh_curve_num_nodes\n'); 

    fprintf (f, 'INTEGER fem_create_mesh_curve_num_elems\n'); 

    fprintf (f, 'STRING fem_create_mesh_c_nodes_created[VIRTUAL]\n'); 

    fprintf (f, 'STRING fem_create_mesh_c_elems_created[VIRTUAL]\n'); 

    len = norm(node1_pos_shrunk - node2_pos_shrunk) / num_divisions; 

    fprintf (f, 'fem_create_mesh_curv_1( "Line %d", 16384, %.5f, 

"Bar2", "#", "#",  @\n', i+1, len); 

    fprintf (f, '"Coord 0", "Coord 0", fem_create_mesh_curve_num_nodes,  

@\n'); 

    fprintf (f, 'fem_create_mesh_curve_num_elems, 

fem_create_mesh_c_nodes_created,  @\n'); 

    fprintf (f, 'fem_create_mesh_c_elems_created )\n'); 

%% Properties (Part 2/3) 

    %Actin beam properties 
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%     %General Beam 

%     fprintf (f, 'elementprops_create( "actin%d", 117, 35, 42, 11018, 

1, 20, [39, 13, 6, 1,  @\n', i); 

%     fprintf (f, '30, 31, 11, 12, 10, 3019, 3026, 3028, 3006, 3008, 

3020, 3027, 3029, 3007,  @\n'); 

%     fprintf (f, '3009, 3021, 3003, 3061, 3056, 3999], [12, 5, 2, 1, 

1, 1, 1, 1, 1, 6, 1, 1, 6,  @\n'); 

%     fprintf (f, '6, 6, 6, 6, 6, 6, 6, 6, 1, 4, 4], ["actin_xsection", 

"m:actin_mat",  @\n'); 

%     fprintf (f, '"Construct 2PointVector(Evaluate Geometry([0 0 

0]))(Evaluate Geometry([%.3f %.3f %.3f]))",  @\n', node1_pos(1), 

node1_pos(2), node1_pos(3)); 

%     fprintf (f, '"3.8484512E-005", "3.8484512E-005", "3.8484512E-

005", "1.1785882E-010",  @\n'); 

%     fprintf (f, '"1.1785882E-010", "2.3571764E-010", "", "", "", "", 

"", "", "", "", "",  @\n'); 

%     %fprintf (f, '"", "", "", "", "", ""], "Curve %d" )\n', i); 

%doesn't work in current form 

%     fprintf (f, '"", "", "", "", "", ""], "Element %d:%d" )\n', 

fiber_min_elt, fiber_max_elt); 

     

    %Truss 

    fprintf (f, 'elementprops_create( "actin%d", 20, 25, 37, 1, 1, 15, 

[13, 1, 3061, 3056, 3999],  @\n', i); 

    fprintf (f, '[5, 1, 1, 4, 4], ["m:actin_mat", "%d", "", "", ""], 

"Element %d:%d" )\n', fcross, fiber_min_elt, fiber_max_elt); 

     

    fiber_min_elt = fiber_max_elt + 1;  

    fiber_max_elt = fiber_max_elt + num_divisions; 

     

end 

  

%Count edges on base (since each one turns into a new tria6 node 

%count = 0; 

%for i=1:size(cfaces,1) 

%    n1 = cfaces(i,1);  

%    n2 = cfaces(i,2); 

%    n3 = cfaces(i,3); 

%    face_max_z = max([cverts(n1,3) cverts(n2,3) cverts(n3,3)]); 

%    if face_max_z <= z_plane + 0.0001 

%        count = count + 3; 

%    end 

%    n = 0; 

%    if cverts(n1,3) <= z_plane + 0.0001, n = n + 1; end 

%    if cverts(n2,3) <= z_plane + 0.0001, n = n + 1; end 

%    if cverts(n3,3) <= z_plane + 0.0001, n = n + 1; end 

%    if n == 2 
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%        count = count + 1; 

%    end 

%end 

%count = count / 2; 

%tria6_base_min = size(nverts,1) + size(cverts,1) + 1; 

%tria6_base_max = size(nverts,1) + size(cverts,1) + count; 

  

%Convert to tri6's for cell 

%fprintf (f, 'ga_group_current_set( "cimport_base" )\n'); 

%fprintf (f, 'STRING fem_modify_elem__elems_modified[VIRTUAL]\n'); 

%fprintf (f, 'fem_modify_elems( "", "Tri", "Tria6", "", "", "Elm 

%d:%d", [0, 1, 0, 0, 0, 0, 0, 0, 0, 0], 

fem_modify_elem__elems_modified )\n', cell_min_elt, 

cell_max_base_elt); 

%fprintf (f, 'ga_group_current_set( "cimport" )\n'); 

%fprintf (f, 'fem_modify_elems( "", "Tri", "Tria6", "", "", "Elm 

%d:%d", [0, 1, 0, 0, 0, 0, 0, 0, 0, 0], 

fem_modify_elem__elems_modified )\n', cell_max_base_elt+1, 

cell_max_elt); 

%fprintf (f, 'ga_group_entity_add( "cimport", "Node %d:%d" )\n', 

tria6_base_min, tria6_base_max); 

  

% Convert to tri6's for nucleus 

%fprintf (f, 'ga_group_current_set( "nimport" )\n'); 

%fprintf (f, 'STRING fem_modify_elem__elems_modified[VIRTUAL]\n'); 

%fprintf (f, 'fem_modify_elems( "", "Tri", "Tria6", "", "", "Elm 

%d:%d", [0, 1, 0, 0, 0, 0, 0, 0, 0, 0], 

fem_modify_elem__elems_modified )\n', nucleus_min_elt, 

nucleus_max_elt); 

  

%% Meshing 

% Mesh inside of nucleus 

fprintf (f, 'ga_group_current_set( "ntet" )\n'); 

fprintf (f, 'INTEGER fem_create_mesh_solid_num_nodes\n'); 

fprintf (f, 'INTEGER fem_create_mesh_solid_num_elems\n'); 

fprintf (f, 'STRING fem_create_mesh_s_nodes_created[VIRTUAL]\n'); 

fprintf (f, 'STRING fem_create_mesh_s_elems_created[VIRTUAL]\n'); 

fprintf (f, 'fem_create_mesh_sol_5( "Elm %d:%d", "TetHybrid", "Tet10", 

4, ["%.2f", "0.1", "0.2", "0.0"], 49232, 0, 1, 0, 1, 0.005, "", 

"#", "#", @\n', nucleus_min_elt, nucleus_max_elt, volmesh_size); 

fprintf (f, '"Coord 0", "Coord 0", fem_create_mesh_solid_num_nodes, 

fem_create_mesh_solid_num_elems, fem_create_mesh_s_nodes_created, 

fem_create_mesh_s_elems_created )\n'); 

  

% Mesh inside of cell 

fprintf (f, 'ga_group_current_set( "ctet" )\n'); 

fprintf (f, 'STRING fem_modify_elem__elems_reversed[VIRTUAL]\n'); 
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fprintf (f, 'fem_mod_elem_reverse( "Elm %d:%d", 

fem_modify_elem__elems_reversed )\n', nucleus_min_elt, 

nucleus_max_elt); 

fprintf (f, 'INTEGER fem_create_mesh_solid_num_nodes\n'); 

fprintf (f, 'INTEGER fem_create_mesh_solid_num_elems\n'); 

fprintf (f, 'STRING fem_create_mesh_s_nodes_created[VIRTUAL]\n'); 

fprintf (f, 'STRING fem_create_mesh_s_elems_created[VIRTUAL]\n'); 

fprintf (f, 'fem_create_mesh_sol_5( "Elm %d:%d", "TetHybrid", "Tet10", 

4, ["%.2f", "0.1", "0.2", "0.0"], 49232, 0, 1, 0, 1, 0.005, "", 

"#", "#", @\n', nucleus_min_elt, cell_max_elt, volmesh_size); 

fprintf (f, '"Coord 0", "Coord 0", fem_create_mesh_solid_num_nodes, 

fem_create_mesh_solid_num_elems, fem_create_mesh_s_nodes_created, 

fem_create_mesh_s_elems_created )\n'); 

  

%Delete Tri elements 

fprintf (f, 'fem_delete_elem_and_node( "Elm %d:%d", 

fem_delete_element_deleted_ids )\n', nucleus_min_elt, 

cell_max_elt); 

  

%% Properties (Part 3/3) 

%%% 3D Solid 

%%%%%% Nucleus 

%fprintf (f, '?\n'); 

%%%%%% Cytoplasm 

%fprintf (f, '?\n'); 

  

% Can't do these ones - don't know how many tet elements Patran will 

create! 

  

%% Loads/BCs 

%%% Fix position of bottom plane 

% fprintf (f, 'loadsbcs_create2( "fixed", "Displacement", "Nodal", "", 

"Static", [ @\n'); 

% fprintf (f, '"Node %d:%d"], "FEM", "Coord 0", "1.", ["<0 0 0>",  

@\n', cell_min_node, cell_max_base_node); 

% fprintf (f, '"<     >", "<     >", "<     >"], ["", "", "", ""] 

)\n'); 

  

% Doesn't select the correct nodes. Not sure why. 

  

%%% Create Movement Field 

fprintf (f, 'fields_create( "movement", "Non-Spatial", 1, "Scalar", 

"Real", "", "", "Table" @\n'); 

fprintf (f, ', 1, "t", "", "", "", "", "", FALSE, [0., %.2f, %.2f, 

%.2f, %.2f], [0.], [0.], [[[ @\n', probe_offset / probe_speed, 

(probe_offset + probe_indent) / probe_speed, (probe_offset + 2 * 
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probe_indent) / probe_speed, (2 * probe_offset + 2 * 

probe_indent) / probe_speed); 

fprintf (f, '0.]][[%.2f]][[%.2f]][[%.2f]][[0.]]] )\n', probe_offset, 

probe_offset + probe_indent, probe_offset); 

  

%%% Rigid Contact Body (Probe) 

fprintf (f, 'elementprops_create( "Lbc_probe_contact", 99, 25, 66, 28, 

2, 14, [38], [4], [ @\n'); 

fprintf (f, '"probe_contact"], "Surface 1" )\n'); 

fprintf (f, 'fields_create_general( "._Lbc_probe_contact2", 2, 5, 2, 

"Real", "Coord 0", "", @\n'); 

fprintf (f, ' 0, 0, 0, 0 )\n'); 

fprintf (f, 'fields_create_general_term( "._Lbc_probe_contact2", 0, 0, 

0, 17,  @\n'); 

fprintf (f, '"[1_contact_lbc()]" )\n'); 

fprintf (f, 'fields_create_general_term( "._Lbc_probe_contact2", 0, 1, 

1, 351,  @\n'); 

fprintf (f, 

'"contact_lbc(54|11|22|43|44|45|57|58|59|61|62|63|64|65|66|67|69|

76|77|78|7" // @\n'); 

fprintf (f, 

'"9|92|93|94|95|96|97|98|99|100|101|103|104|102|105|109|606|607|6

08|609|610" // @\n'); 

fprintf (f, 

'"|611|612|613|614|615|110|111|112|113|114|115|422|622|623|Lbc_pr

obe_contac" // @\n'); 

fprintf (f, '"t|||0|1||||-1.|Position||<0., 0., -

1.,>|||f:movement:f|0|-1.|||||||||-1.|" // @\n'); 

fprintf (f, '"<0., 0., 0.,>||-1.|60.0||||0|-

1.|||||||||||||||||1/1/1/||)" )\n'); 

fprintf (f, 'loadsbcs_create2( "probe_contact", "Contact[Rigid Body]", 

"Element Uniform",  @\n'); 

fprintf (f, '"2D", "Static", ["Surface 1"], "Geometry", "Coord 0", 

"1.", ["-1.", "1.0", "", @\n'); 

fprintf (f, ' "", "<1.,1.,0.>", "<0.,0.,1.>", "<0., 0., -1.,>", "", "",  

@\n'); 

fprintf (f, '"f:._Lbc_probe_contact2"], ["", "", "", "", "", "", "", 

"", "", ""] )\n'); 

  

%%% Deformable Contact Body (Cell) 

% Can't do this one - don't know how many tet elements Patran will 

create 

  

  

%% Analysis 

% Post only groups necessary for analysis 
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fprintf (f, 'uil_viewport_post_groups.posted_groups( 

"default_viewport", 3, ["AFMprobe", "ctet", "ntet", "actin"] 

)\n'); 

  

% Adaptive Meshing 

% fprintf (f, 'analysis_create.job_char_param( "MSC.Marc", "test", 

"ADAPTIVITY TYPE",  @\n'); 

% fprintf (f, '"Global" )\n'); 

% fprintf (f, 'analysis_create.job_int_param( "MSC.Marc", "test", 

"NUMBER OF ZONES", 1 )\n'); 

% fprintf (f, 'analysis_create.job_char_param( "MSC.Marc", "test", 

"ZONE 1",  @\n'); 

% fprintf (f, '"amesh,Global,cell_contact,Tetrahedral,Previous Mesh 

Size, , , , ,TRUE,0.2" // @\n'); 

% fprintf (f, '"5, ,FALSE, , , ,FALSE, , , , , ,FALSE, , , ,100,60,1.5, 

, ,FALSE, " )\n'); 

  

% Can't do this one without being able to create deformable contact 

body 

% for the cell: "cell_contact" in the example above 

  

% Load Increment Parameters 

fprintf(f, 'analysis_create.step( "MSC.Marc", "Default Static Step",  

@\n'); 

fprintf(f, '"This is a default static analysis step." )\n'); 

fprintf(f, '$# Question from application APP INTERFACES\n'); 

fprintf(f, '$#     The stepname (Default Static Step) is already 

defined in the database. \n'); 

fprintf(f, '$#  Do you wish to overwrite?\n'); 

fprintf(f, '$? YES 6016028 \n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"LOAD CASE", "Default" )\n'); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 

fprintf(f, '"LBCS WITH NO FIELDS", 0 )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"SOLUTION TYPE", "NONLINEAR STATIC" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"GEOMETRIC", "Large Displacement/Large Strains" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"LOADS FOLLOW", "OFF" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 
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fprintf(f, '"FORCES FOLLOW", "OFF" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"TYPE OF LOAD", "TOTAL" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"INCREMENT TYPE CODE", "FXDSTAT" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"INCREMENT TYPE", "Fixed" )\n'); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 

fprintf(f, '"INCREMENTS", %d )\n', (probe_offset + 

probe_indent)/0.005); 

fprintf(f, 'analysis_create.step_real_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"TOTAL TIME", %.2f )\n', (2 * probe_offset + 2 * 

probe_indent) / probe_speed); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 

fprintf(f, '"CONSTANT TIME STEP", 0 )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"AUTO TIME STEP CUTBACK", "ON" )\n'); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 

fprintf(f, '"MAX NUM CUTBACKS", 10 )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"CONVERGED", "OFF" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"NON-POSITIVE DEFINITE", "OFF" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"INITIAL STRESS STIFFNESS", "Full" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"ITERATION METHOD", "Full Newton-Raphson" )\n'); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 

fprintf(f, '"ITERATIONS", 20 )\n'); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 

fprintf(f, '"MINIMUM ITERATIONS", 0 )\n'); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 
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fprintf(f, '"DESIRED ITERATIONS", 5 )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"TOLERANCE METHOD", "Residual" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"ERROR TYPE", "Relative" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"MATRIX UPDATE METHOD", "Automatic" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"AUTOMATIC SWITCHING", "ON" )\n'); 

fprintf(f, 'analysis_create.step_real_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"TRANS TOLERANCE", 0.1 )\n'); 

fprintf(f, 'analysis_create.step_real_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"ROT TOLERANCE", 0. )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"CONTACT DETECTION", "Default(by body #)" )\n'); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 

fprintf(f, '"CONTACT-SETS-COUNT", 1 )\n'); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 

fprintf(f, '"CONTACT-PAIR-NUM-PROPS-COUNT", 20 )\n'); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 

fprintf(f, '"CONTACT-PAIR-NUM-SETTINGS-COUNT", 6 )\n'); 

fprintf(f, 'analysis_create.step_int_list_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"CONTACT-TABLE-SETS-COUNT", "0 " )\n'); 

fprintf(f, 'analysis_create.step_int_list_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"CONTACT-LBC-SETS", "1 " )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"CONTACT-LBC-SET-NAMES", "probe_contact " )\n'); 

fprintf(f, 'analysis_create.step_int_list_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"CONTACT-TABLE-LBC-SETS", "" )\n'); 

fprintf(f, 'analysis_create.step_real_list_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"CONTACT-TABLE-DATA", "" )\n'); 
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fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"CONTACT-TABLE-DATA2", "" )\n'); 

fprintf(f, 'analysis_create.step_int_list_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"CONTACT-TABLE-SETS-COUNT-GLUE", "0 " )\n'); 

fprintf(f, 'analysis_create.step_int_list_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"CONTACT-LBC-SETS-GLUE", "1 " )\n'); 

fprintf(f, 'analysis_create.step_int_list_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"CONTACT-TABLE-LBC-SETS-GLUE", "" )\n'); 

fprintf(f, 'analysis_create.step_real_list_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"CONTACT-TABLE-DATA-GLUE", "" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"CONTACT-TABLE-DATA2-GLUE", "" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"CONTACT-LBC-SETS-RELEASE", "N " )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"CONTACT-LBC-SETS-RELEASE-VALUES", "0 " )\n'); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 

fprintf(f, '"RESULTS INTERVALS", 1 )\n'); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 

fprintf(f, '"PRINT INTERVALS", 1 )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"WRITE ENERGY DATA", "OFF" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"SKIP INCREMENT ZERO", "OFF" )\n'); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 

fprintf(f, '"NORMALIZATION ID", 0 )\n'); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 

fprintf(f, '"NORMALIZATION COMPONENT", 1 )\n'); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 

fprintf(f, '"NORMALIZATION FROM MODE", 0 )\n'); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 
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fprintf(f, '"NORMALIZATION THRU MODE", 0 )\n'); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 

fprintf(f, '"INTEGRATION PTS", 5 )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"WRITE MEMBRANE", "ON" )\n'); 

fprintf(f, 'analysis_create.step_int_list_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"WRITE INTEGRATION PTS", " 1 2 3 4 5" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"STRAIN, TOTAL COMPONENTS (301)", "ON,LayerOption ,Default" 

)\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"STRESS, COMPONENTS (global system) (411)", "ON,LayerOption 

,Default" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"WRITE ITERATIVE DATA", "OFF" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"EXCLUDE GLUE FORCES", "OFF" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"MARC Nodal POST CODE Defaults", "ON" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"POST FILE NODE SELECTION FILTER", "Geometry" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"POST FILE NODE LIST", "" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"PRINT NODE", "NONE" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"PRINT ELEMENT", "NONE" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step", "SUMMARY", @\n'); 

fprintf(f, ' "OFF" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"INPUT FILE ECHO", "OFF" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 
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fprintf(f, '"CONNECTIVITY ECHO", "OFF" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"COORDINATES ECHO", "OFF" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"PRINT CONVERGENCE", "ON" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"ERROR ESTIMATE", "None" )\n'); 

fprintf(f, 'analysis_create.step_char_param( "MSC.Marc", "Default 

Static Step",  @\n'); 

fprintf(f, '"WRITE HISTORY TEXT INPUT AT", "End" )\n'); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 

fprintf(f, '"HISTORY INPUT 0", 0 )\n'); 

fprintf(f, 'analysis_create.step_int_param( "MSC.Marc", "Default Static 

Step",  @\n'); 

fprintf(f, '"NUMBER OF GLOBAL ADAPTIVE ZONES", 0 )\n'); 

  

  

fclose (f); 

  

%% Mentat Insertion "Card" 

filename = sprintf('%s\\cell%d_insert_card.dat', patran_dir, id); 

f = fopen(filename, 'w'); 

  

fprintf(f, 'DEFINE    ELEMENT   SET       insert1_host_elements\n'); 

% Danger -- mesh on mesh will change the elt ranges in the next line!\ 

fprintf(f, '%6d    to%6d\n', -1, -1); % "-1"s Should be the range of 

IDs from the tet mesh 

fprintf(f, 'DEFINE    ELEMENT   SET       insert1_embed_elements\n'); 

fprintf(f, '%6d    to%6d\n', fiber_min_elt, fiber_max_elt); 

fprintf(f, 'INSERT\n'); 

fprintf(f, '\n'); 

fprintf(f, '         1         1           5.00000-2         0\n'); 

fprintf(f, 'insert1_host_elements\n'); 

fprintf(f, 'insert1_embed_elements\n'); 

  

fclose (f); 

  

end 
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A.12. cell_3D_vis.m 

NOTES 

This file generates three MATLAB figures showing the results of the image analysis 

in top, front, and side views. 

MATLAB  CODE 

function cell_3d_vis(nfaces, nverts, fverts, cfaces, cverts, sol, 

fignum) 

  

figure(fignum); 

clf; 

  

%Draw nucleus 

% vx = nverts(:,1); 

% vy = nverts(:,2); 

% vz = nverts(:,3); 

%FVn.vertices = [vy vx vz]; FVn.faces = nfaces; 

FVn.vertices = nverts; FVn.faces = nfaces; 

pn = patch(FVn); 

set(pn, 'facecolor', [0.5 0.7 1]); %[R G B] 

set(pn, 'facealpha', 0.5); %translucency 

set(pn, 'linestyle', 'none'); 

  

%Draw cell boundary 

% vx = cverts(:,1); 

% vy = cverts(:,2); 

% vz = cverts(:,3); 

%FVc.vertices = [vy vx vz]; FVc.faces = cfaces; 

FVc.vertices = cverts; FVc.faces = cfaces; 

pc = patch(FVc); 

set(pc, 'facecolor', [0.4 0.4 0.4]); 

set(pc, 'facealpha', 0.2); %translucency 

set(pc, 'linestyle', 'none');  % uncomment to hide mesh 

  

hold on 

  

% View ALL actin that I've previously sampled 

for i=1:size(sol,1) 
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     v1 = sol(i, 1); 

     v2 = sol(i, 2); 

     p1 = fverts(v1, :); 

     p2 = fverts(v2, :); 

     %p1b = 0.1 * p2 + 0.9 * p1; 

     %p2b = 0.1 * p1 + 0.9 * p2; 

     p1b = p1; 

     p2b = p2; 

     %h = line([p1b(2) p2b(2)], [p1b(1) p2b(1)], [p1b(3) p2b(3)]); 

     h = line([p1b(1) p2b(1)], [p1b(2) p2b(2)], [p1b(3) p2b(3)]); 

     set(h, 'color', [0 0.5+sol(i,3)/2 0]); 

     set(h, 'linewidth', 1); 

end 

  

daspect([1 1 1]); 

axis xy; 

camlight; 

lighting phong; 

  

end 

A.13. print_cell.m 

NOTES 

This file generates three image files (in .png format) showing the results of the image 

analysis in top, front, and side views. 

MATLAB CODE 

function print_cell(filename, size_x, size_y, fignum) 

% size_x and size_y are size in inches of image printout 

  

p = get(fignum,'Position'); 

set(fignum, 'PaperUnits', 'inches'); 

set(fignum, 'PaperSize', [p(3)/100 p(4)/100]); 

set(fignum, 'PaperPositionMode', 'manual'); 

set(fignum, 'PaperPosition', [0 0 p(3)/100 p(4)/100]); 

set(fignum, 'renderer', 'OpenGL'); 

print(fignum, '-dpng', '-r300', filename); 
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end 
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APPENDIX B 

ADDITIONAL AFM DATA 

B.1. Concurrent Visualization and Characterization of Single Cell 

Mechanical Properties 

B.1.1. BACKGROUND 

The mechanical properties of cells and tissues are directly related to their shapes 

(Figure B.1). Fibroblasts are the most common cell type in the heart and are constantly 

under dynamic load in normal healthy conditions. In response to injurious mechanical 

loading, fibroblasts can undergo significant cytoskeletal remodeling through 

differentiation to a myofibroblast phenotype, leading to changes in mechanical properties 

that may eventually contribute to heart failure [1]. Prediction of cell behavior using 

structural properties of nanoscale components could elucidate mechanisms behind many 

tissue mechanical properties, which could lead to ability to development of more 

effective medical therapies [2]. Atomic Force Microscopy (AFM) and Confocal 

Microscopy are both useful individually for analysis of mechanical properties and 

nanoscale structures of cells but are much more powerful when used in conjunction with 

each other. 
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Figure B.1. Relationship between shape and stiffness of rat aortic vascular smooth 

muscle cells (VSMCs); f-actin labeled with AlexaFluor 488 phalloidin [3] 

B.1.2. METHODS 

An Olympus IX81 Inverted Microscope with Spinning Disc Confocal Microscope 

and Asylum Research MFP-3D Extended Head Atomic Force Microscope were used as 

shown in Figure B.2. NIH 3T3 Fibroblasts are seeded at 7 × 10 
3
 cells/cm

2
 on glass-

bottom Petri dishes coated with 50 µL of 1 mg/mL Type I Collagen (Rat Tail) 1 hr prior 

to cell seeding and allowed to grow for 2 – 3 days in DMEM with 10% FBS. The live 

cells were then stained with DAPI (25 µg/mL in DMEM with 10% FBS) to visualize the 

nucleus and CellMask™ Deep Red (7.5 µg/mL in DMEM with 10% FBS) to visualize 

the plasma membrane. Cells are then incubated at 37 °C, 5 % CO2 in DAPI/CellMask 

solution for 1 hour immediately prior to concurrent experimentation and visualization. 
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The DAPI/CellMask solution is then removed and replaced with standard media at the 

start of the experiment. 

 

Figure B.2. (a) Olympus IX81 Inverted Microscope with: Spinning Disc Confocal 

Microscope: Disc Spinning Unit (DSU, purple circle) and Atomic Force 

Microscope: Asylum Research MFP-3D Extended Head (orange circle) (b) block 

diagram of experimental setup 

During mechanical characterization with the AFM, the cells are maintained at 37 °C. 

A 2.5 µm radius borosilicate spherical-tipped probe with a spring constant of 0.2 N/m is 

utilized for all mechanical measurements. First, a stress relaxation test is performed using 

an indentation depth of 5 µm, indentation velocity of 100 µm/sec, and an indentation 

dwell time of 5 minutes. After obtaining stress relaxation data for the cell, a force map is 

obtained using indenting to 150 nm of cantilever deflection (representing approximately 

1 – 5 µm of cell depth), and an indentation velocity of 5 µm/sec. Measurements are taken 
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every 2.5 µm to satisfy the Nyquist criterion. Scan times for force maps are 

approximately 1 hour. 

B.1.3. RESULTS 

Results are shown in Figures B.3 through B.9. 

 

Figure B.3. (a) Fluorescent Image of 3T3 fibroblast, scale bar: 20 µm (b) View of 

same cell from (a) and AFM tip as seen in AFM software; both images taken prior 

to conducting AFM experiments 

 

Figure B.4. Deflection of AFM probe during stress relaxation experiment 
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Figure B.5. (a) Overlay of confocal images of nucleus ~ 500 ms before, ~ 300 ms 

after, and 6 min after indentation. Notice that the green channel is dominant 

indicating a bulging of the nucleus immediately following indentation. (b) 

Overlay of confocal images of cell membrane ~ 500 ms before, ~ 300 ms after, 

and 6 min after indentation. Notice that the cell appears white indicating a lack of 

movement, however the shadow of the AFM probe is visible as being in the same 

location before and after indentation (purple) but is in a different location 

immediately following indentation. 

  

(R) t
0
: Just Before Indentation 

(G) t
1
: Just After Indentation 

(B) t
2
: 6 min After Indentation 
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Figure B.6. Correlation Plots comparing pixel intensities in G and B channels 

relative to R channels of images in Fig 5. Plots for images of: (a) nucleus just 

after indentation (b) nucleus 6 min after indentation (c) cell membrane just after 

indentation (d) cell membrane 6 min after indentation (e) Graph of percentage 

difference between each correlation coefficient from the plots in Fig. 6 relative to 

the correlation coefficient for t0. The values for the cell membrane images are 

most likely higher due to the movement of the shadow of the AFM probe as seen 

in Fig 5. This problem can be solved by utilizing a stain with a higher signal-to-

noise ratio than CellMask™ Deep Red. Error bars show 9 % confidence interval. 

 

Figure B.7. (a) Fluorescent image of 3T3 fibroblast; (b) top: 2D AFM height 

profile of same cell, bottom: 3D version of same plot; (c) overlay  of (a) onto (b) 
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and multiplication of pixel  intensities resulting in the higher areas of the cell 

being brighter and the lower areas being darker 

 

Figure B.8. (a) Force-Indentation curve taken along cell periphery (b) Force-

Indentation curve taken in the middle of the cell 

 

Figure B.9. (a) Fluorescent image of 3T3 fibroblast, (b) Hertzian modulus map of 

same cell, (c) overlay  of (a) onto (b) showing the stiffer areas of the cell as darker 

and the softer areas as lighter 
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B.1.4. DISCUSSION 

The concurrent use of AFM nanoindentation with confocal microscopy provides a 

useful novel method for the visualization of the effects of AFM nanoindentation on cell 

shape and structure. This technique is particularly interesting due to its ability to observe 

these effects in live cells that actively respond to AFM nanoindentation as images could 

be taken in real time if so desired. Cells did not try to move away from the AFM probe 

during stress relaxation measurements as expected. AFM Height measurements can 

compensate for low z-axis resolution of 3D confocal data to more accurately determine 

cell height. Cells were found to be stiffer when indenting over the nucleus than the area 

surrounding the nucleus, and the cells were stiffest at the periphery due to substrate 

effects. In future studies, the force maps and confocal images generated in these 

experiments will be incorporated into a 3D structure-based finite element model in order 

to provide a unique and compelling method of validation for our model. 
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APPENDIX C 

ADDITIONAL FEM DATA 

C.1. Mesh Sensitivity Analysis 

Mesh sensitivity analysis was performed on the 2D axisymmetric version of the 

model from Chapter 4 in Patran/Marc, with results of the model compared at varying 

element densities. 

C.1.1. MESH 1 

 Created Quad8  Paver Mesh with no mesh seed 

o Global Edge Length = 0.25 

o 122 Elements 

 

Figure C.1. Mesh 1 Prior to Indentation 

o 4 Elements Failed 
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 Skew: 2 

 

Figure C.2. Mesh 1 Skew Element Quality Prior to Indentation 

 Taper: 2 

 

Figure C.3. Mesh 1 Taper Element Quality Prior to Indentation 

 Mesh not smoothed in hopes that intial mesh will match final mesh 

 Results 

o Solution Time: 13 sec 

o Mesh at 500 nm indentation 
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Figure C.4. Mesh 1 at 500 nm Indentation 

 

 157 Elements 

o Mesh after retraction 

 

Figure C.5. Mesh 1 After Retraction 

 169 Elements 

 Not identical to initial mesh 

o Indentation Curve 
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Figure C.6. Mesh 1 Indentation Curve 

 12.2% Hysteresis 

o Will try refining mesh next to see if that gets rid of hysteresis 

C.1.2. MESH 2 

 Created Quad8  Paver Mesh with no mesh seed 

o Global Edge Length = 0.20 

o 201 Elements 
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Figure C.7. Mesh 2 Prior to Indentation 

o 5 Elements Failed 

 Skew: 3 Failed 

 Max = 38.4 

 

Figure C.8. Mesh 2 Skew Element Quality Prior to Indentation 

 Taper: 2 Failed 

 Min = 0.785 

 

Figure C.8. Mesh 2 Taper Element Quality Prior to Indentation 

 Mesh not smoothed in hopes that intial mesh will match final mesh 



224 

 

 Results 

o Solution Time: 34 sec 

o Mesh at 500 nm indentation 

 

Figure C.9. Mesh 2 at 500 nm Indentation 

 257 Elements 

o Mesh after retraction 

 

Figure C.10. Mesh 2 After Retraction 

 263 Elements 

 Not identical to initial mesh 
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o Indentation Curve 

 

Figure C.11. Mesh 2 Indentation Curve 

 10.7% Hysteresis 

C.1.3. MESH 3 

 Created Quad8  Paver Mesh with no mesh seed 

o Global Edge Length = 0.15 

o 337 Elements 
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Figure C.12. Mesh 3 Prior to Indentation 

o 12 Elements Failed 

 Skew: 8 Failed 

 Max = 33.6 

 

Figure C.13. Mesh 3 Skew Element Quality Prior to Indentation 

 Taper: 4 Failed 

 Min = 0.726 

 

Figure C.14. Mesh 3 Taper Element Quality Prior to Indentation 

 Results 
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o Solution Time: 44 sec 

o Mesh at 500 nm indentation 

 

Figure C.15. Mesh 3 at 500 nm Indentation 

 398 Elements 

o Mesh after retraction 

 

Figure C.16. Mesh 3 After Retraction 

 384 Elements 

 Not identical to initial mesh 

o Indentation Curve 
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Figure C.17. Mesh 3 Indentation Curve 

 8.1% Hysteresis  

C.1.4. MESH 4 

 Created Quad8  Paver Mesh with no mesh seed 

o Global Edge Length = 0.10 

o 787 Elements 
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Figure C.18. Mesh 4 Prior to Indentation 

o 25 Elements Failed 

 Skew: 17 Failed 

 Max = 36.0 

 

Figure C.19. Mesh 4 Skew Element Quality Prior to Indentation 

 Taper: 8 Failed 

 Min = 0.740 

 

Figure C.20. Mesh 4 Taper Element Quality Prior to Indentation 
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 Results 

o Solution Time: 78 sec 

o Mesh at 500 nm indentation 

 

Figure C.21. Mesh 4 at 500 nm Indentation 

 868 Elements 

o Mesh after retraction 

 

Figure C.22. Mesh 4 After Retraction 

 868 Elements 

o Indentation Curve 



231 

 

 

Figure C.23. Mesh 4 Indentation Curve 

 3.6% Hysteresis 

C.1.5. MESH 5 

 Created Quad8  Paver Mesh with no mesh seed 

o Global Edge Length = 0.05 

o 3,055 Elements 
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Figure C.24. Mesh 5 Prior to Indentation 

o 66 Elements Failed 

 Skew: 30 Failed 

 Max = 38.8 

 

Figure C.25. Mesh 5 Skew Element Quality Prior to Indentation 

 Taper: 36 Failed 

 Min = 0.650 

 

Figure C.26. Mesh 5 Skew Element Quality Prior to Indentation 

 Results 
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o Would not solve past Cycle 5 

 Read Log file and noticed that Adaptive Meshing was set to 

remesh every 5 cycles (under Increment Frequency), and it was 

freezing the first time it tried to remesh 

 Unchecked the Increment Frequency  box  

 Changed remeshing criteria (under Advanced) to Element 

Distortion 

 Did not need to remesh at all 

o Solution Time: 496 sec = 8 min 16 sec 

o Indentation Curve 

 

Figure C.27. Mesh 5 Indentation Curve 

 No Hysteresis 

C.1.6. ELEMENT SENSITIVITY RESULTS 
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 Based on Global Adaptive Remeshing 

o Remeshed based on Increment Frequency  = 5 for Mesh 1 through 4 

o Remeshed based on Element Distortion for Mesh 5 (did not remesh) 

 

Figure C.28. Element Sensitivity Analysis Results 
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APPENDIX D 

PROTOCOLS 

D.1. Patran Protocols 

D.1.1. RUNNING THE FiNAL VERSION OF THE FINITE ELEMENT MODEL AS 

PRESENTED IN CHAPTER 6 

 Select File>Session>Play… from the top menu 

o Uncheck Commit Commands check box 

 Leaving this box checked will result in very slow playing of the 

session file 

o Select the appropriate session file (e.g. build_cell6.ses) and click the -

Apply- button 

o Patran will then reconstruct the geometry as written in 

write_patran_session.m from Appendix A 

 When the session file stops playing, select Group>Post… from the top menu 

o Select the following groups: cimport, cimport_base, nimport and click 

Apply 

 In the ribbon menu, select the Meshing tab 

o In the Meshing menu, select Delete>Element 
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o Place the cursor in the Element List dialog box and then use the mouse to 

select all elements visible in the viewport (they should all be green) 

o Make a note of which elements are being deleted, then click Apply 

 Select Group>Post… from the top menu again and post the group ntet 

 In the ribbon menu, select the Properties tab 

o In the Properties menu, select Create>3D>Solid 

o In the Property Set Name dialog box, type a name for the nucleus (e.g. 

nsolid) 

o Click the Input Properties … button 

 In the Value Type for the [Formulation Options] selection, click 

the drop menu that says String and select Assumed Strain 

 In the Value Type for the Material Name selection, click the  

button, select nucleus_mat, and click OK 

o Click the Select Application Region … button  

 Click the Tet element  button in the tool bar, then select all the 

elements visible in the viewport (they should be purple). 

 Make note of which elements are in the nucleus group (listed in the 

Select Members dialog box), then click the Add, OK, and Apply 

buttons 

o Select Group>Post… from the top menu, post the group ctet, and repeat 

the procedure for the cytoplasm elements (making sure to note which 

elements are in this group as well) 
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 Make a note of which elements are in the actin group  

o The lowest element number will be one greater than the highest element 

number deleted above 

o The highest element number will be one less than the lowest element in 

the ntet group 

o The element numbers for the actin, ntet, and ctet groups will be used later 

to insert the actin elements into the solid elements 

 In the ribbon menu, select the Loads/BCs tab 

o In the Load/Boundary Conditions menu, select 

Create>Displacement>Nodal 

o In the New Set Name dialog box, type a name for your fixed boundary 

condition (e.g. fixed) 

o Click the Input Data… button 

 In the Translations <T1 T2 T3> dialog box, type <0,0,0> and 

click OK 

o Click the Select Application Region… button 

 In the ribbon menu, select the Home tab 

 Click the Bottom View   button 

 In the Select Application Region menu, click the drop menu next 

to Select: and chose FEM 

 Click in the Select Nodes dialog box, then select all of the bottom-

most layer of nodes in the current group of elements in the 
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viewport (representing the points in contact with the glass 

coverslip), then click Add, OK, -Apply- 

 In the ribbon menu, select the Loads/BCs tab 

o In the Load/Boundary Conditions menu, click the Deformable button 

o In the New Set Name dialog box, give the deformable contact body a 

name (e.g. cell_contact) 

o Click the Select Application Region… button and then select all visible 

elements in the viewport for the Select 3D Elements dialog box, then 

click Add, OK, -Apply- 

 In the ribbon menu, select the Analysis tab 

o In the Analysis menu, click the Job Parameters… button, then the 

Adaptive Meshing… button 

 For Adaptivity Type, select Global 

 Give the adaptive mesh a name (e.g. amesh) in the Zone Name 

dialog box 

 Select the deformable contact body that was just created in the 

Select a Deformable Contact LBC box 

 For Adaptive Mesh Criteria, select 3D 

 Uncheck the Increment Frequency check box 

 Click the Advanced… button 

o Uncheck the Volume Control check box 
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o Check the Strain Change (Max) check box and 

type the desired strain at which to remesh (e.g. 

0.25), then click OK, OK, OK 

o If the solver type, analysis time, or number of increments for analysis are 

desired to be changed, do so in the Load Step Creation…>Solution 

Parameters…>Load Parameters… button menus 

o In the Analysis menu, select Analyze>Entire Model>Analysis Deck, then 

click Apply 

 This will write a “Job Name”.dat file in the Patran directory 

 Insert the actin elements into the solid elements 

o Open the file in the same directory named cellX_insert_card.dat in 

WordPad, where X is the id of the cell from reconstruct_whole_cell.m in 

Appendix A 

 On the second line of the file, replace the first -1 term with the 

lowest element number of the nucleus group that was noted above 

and the second -1 term with the highest element number of the 

cytoplasm group 

 Be sure to pay attention to spaces, as they do matter to 

Marc. For every character inserted, be sure to delete the 

same number of spaces. 

 Repeat this process on the fourth line of the file, this time using the 

lowest and highest element numbers of the actin group 
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 Press Ctrl-A to select all of the text in the file and press Ctrl-C to 

copy it 

o Open the “Job Name”.dat file in Notepad 

 Press Ctrl-F to bring up the Find dialog box, type CONTACT in 

the Find dialog box, and press Enter 

 Place the cursor directly in front of the first instance of the word 

and press Ctrl-V to paste the INSERT card into the file 

 Save, then close the file 

 To solve the model, open the Windows Command Prompt 

o Run cmd.exe for Windows Command Prompt prompt 

o Type: cd C:\MSC.Software\Marc\2010.2\marc2010\tools 

o Type: run_marc.bat 

o Type: cd working directory, where working directory is the directory that 

the “Job Name”.dat file is located 

o In university assist folder, 

 Copy/paste marc_submit.bat to working directory 

 Right-click>Edit to change the model name after the –j parameter 

 Double click to submit 

o The model is now solving and can be monitored in Patran 

 In the Analysis menu, select Monitor>Running Job and click 

Apply  
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 After the model has successfully finished solving (Exit Number: 3004), results 

may be obtained by following the protocol in Appendix D.1.2.8. 

D.1.2. GENERAL PATRAN INSTRUCTIONS FOR CREATING AND SOLVING A 

SIMPLE 2D AXISYMMETRIC AFM INDENTATION SIMULATION USING THE MARC 

NONLINEAR SOLVER 

D.1.2.1.  LEARNING THE BASICS 

 Tutorial videos available at www.youtube.com/simulatemore 

 Help files, Reference Manual, and MSC online forums (forums.mscsoftware.com) 

are useful resources 

 The following exercises in the Marc help file documentation illustrate useful 

concepts: 

o Exercise 1 - Build a Cantilever Beam 

o Exercise 2 - A Simple Static Load 

o Exercise 5 - A Simple Contact Problem 

o Exercise 10 - Transient Dynamic Analysis 

 Axisymmetry convention for Marc is listed in the forums as (I am currently 

unsure if this is still true for newer versions such as ours): 

o X-axis = Axial 

o Y-axis = Radial 

D.1.2.2.  GENERAL NOTES 

 Patran doesn’t like using units of 1 
-6

 (e.g. micron-scale geometries in a model 

using standard SI units) 

http://www.youtube.com/simulatemore
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 Patran does not support units for conversion purposes, therefore the user must be 

very careful to keep units consistent throughout the analysis 

 Since geometries must be modeled in microns, be sure to use microns in all other 

measurements (e.g.      
 

  
 
    

     
   

      
     

  

     
 ) 

 When starting a new file: 

o Select Model Dimension = 10 

 This tells Patran to make the viewport the appropriate size for a 

geometry with a max dimension size of 10 units 

o Select Analysis Code:>MSC.Marc 

o Click OK 

D.1.2.3.  GEOMETRY TAB 

 Make a curve for the lower boundary of the cell body using 

Create>Curve>Point  

 Make a curve for the upper boundary of the cell body using 

Create>Curve>Conic 

o Use the Sum of the Starting and Ending Point Lists for the Focal Point 

List, e.g. if the starting point is [2,0,0] and the ending point is [0,5,0], the 

the focal point is [2,5,0]  

o Under Conic Section Classification, enter a value between 0 and 0.5 

 I use Conic Altitude for Ellipse = 0.33  

 Create the cell body surface using Create>Surface>Curve>2 Curve 
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 Create the AFM probe geometry using Create>Curve>2D Arc2Point 

D.1.2.4.  MESHING TAB 

 Create a mesh seed on the upper boundary of the cell body to generate an 

increasing mesh size using Create>Mesh Seed>One Way Bias>L1 and L2 

o Pay attention to the arrow direction on the surface of interest 

o A good starting point, assuming the arrow points from the center of the 

cell outward and the geometry is in microns, is: 

 L1 = 0.05 

 L2 = 0.5 

 Create the mesh using Create>Mesh and check the box for Automatic 

Calculation in the Global Edge Length section 

 The resulting mesh should look similar to that below 
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Figure D.1. Mesh of 2D Axisymmetric finite element model 

D.1.2.5.  PROPERTIES TAB 

D.1.2.5.1. CREATING THE MATERIAL PROPERTIES 

 Click the Isotropic button on the left-hand side of the toolbar ribbon 

 Give the material a name, e.g. contractile_continuum 

 Click Input Properties 

o Enter material properties 

 15.3 kPa = 1.53e-2 
  

     
 

 1.9 GPa = 1.9e3 
  

     
 (for actin filaments) 

 Click Apply 

D.1.2.5.2. ASSIGNING THE MATERIAL PROPERTIES 
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 Note: The following instructions apply to a simple linear elastic continuum model 

only. 

 In the toolbar ribbon, click 2D Properties>2D Solid  

 Enter a name in the Property Set Name field, e.g. cell_body  

 Select Options>Axisymmetric 

 Click Input Properties 

o For [Formulation Options], select Assumed Strain 

o For Material Name, click the  button and select a material name 

o Click OK 

 Click Select Application Region 

o Make sure the cursor is in the Select Members field and click on the 

appropriate region of the geometry 

o Click Add 

o Click OK 

 Once all material properties have been properly assigned, click Apply 

D.1.2.6.  LOADS/BCS TAB 

D.1.2.6.1. CREATE THE BOUNDARY CONDITIONS 

 Under Create>Displacement>Nodal, New Set Name = fixed 

 Click Input Data 

o Translations <T1 T2 T3> = <0,0,0> 

o Click OK 
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 Click Select Application Region 

o Make sure the cursor is in the Select Members field and click on the 

appropriate region of the geometry (bottom boundary of the cell) 

o Click Add 

o Click OK 

 Under Create>Displacement>Nodal, New Set Name = axisymmetric 

 Click Input Data 

o Translations <T1 T2 T3> = < ,0,0> 

o Click OK 

 Click Select Application Region 

o Make sure the cursor is in the Select Members field and click on the 

appropriate region of the geometry (axial boundary of the cell) 

o Click Add 

o Click OK 

D.1.2.6.2. CREATE THE CONTACT PARAMETERS 

 Select Create>Contact 

o Under Option, select Deformable Body 

o Under Target Element Type, select the appropriate number of dimensions 

for the cell body (e.g. 2D) 

o Under New Set Name, give the contact parameter a name (e.g. 

cell_contact) 

o Click Select Application Region 
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 In the Application Region box, select the geometry for the cell 

 Click Add 

 Click OK 

 In the LBC Fields section on the toolbar ribbon, click the Create Non-Spatial 

button  

o In the Field Name box, type movement 

o In the Table Definition box, make sure that only the Time check box is 

selected, then click the Input Data button 

 Define the movement vs. time here: put each time measurement in 

the t column, and each movement measurement in the Value 

column, e.g.: 

t Value 

0 0 

x Indentation depth 

2x 0 

Table D.1. AFM Probe Movement 

 Click OK 

o Click -Apply- 

 Select Create>Contact 

o Under Option, select Rigid Body 

o Under Target Element Type, select the appropriate number of dimensions 

for the probe geometry (e.g. 1D) 
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o Under New Set Name, give the contact parameter a name (e.g. 

probe_contact) 

o Click Input Data 

 Under Motion Control, select Position 

 Under Displacement (vector), type <-1., 0., 0.,>  

 Click in the Displacement vs. Time field box to put the cursor 

there, then select movement from the Time-Dependent Fields box 

 Click OK 

 Make sure the lines that now appear on the probe face away from 

the contact side, as shown in Figure D.1. 

 If they are on the wrong side, click the Input Data button again 

and select the Flip Contact Side check box. 

o Click Select Application Region 

 In the Application Region box, select the geometry for the cell 

 Click Add 

 Click OK 

o Click -Apply- 

D.1.2.7.  ANALYSIS TAB 

Note: The following instructions are for solving a simple linear elastic continuum 

model with local adaptive meshing. 

 Make sure Analyze>Entire Model>Full Run is selected 

 Give the analysis a name in the Job Name field 
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 Click the Job Parameters button 

o Click the Adaptive Meshing button 

 Select Adaptivity Type:>Local 

 Give the adaptive mesh a name (e.g. amesh_loc)in the Zone Name 

box 

 Select the Snap to Geometry check box 

 In the Select a Group box, select default_group 

 Click Apply 

 Click OK 

o Click OK 

 Click the Load Step Creation button 

o Click the Solution Parameters button 

o Select Linearity:>NonLinear 

o Select Nonlinear Geometric Effects:> Nonlinear Geometric 

Effects:>Large Displacement/Large Strains 

o Click the Load Increment Params button 

 Select Increment Type:>Fixed 

 Tell it the appropriate Number of Increments 

 I’ve been indenting a total of  .75 µm and want 

measurements every 5 nm so I’ve been using     

increments 

 Tell it the appropriate Total Time 
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 Equal to the largest value in your movement table 

 Click OK 

o Click OK 

o Click Apply 

o When the message pops up, click Yes 

 Click Apply to solve the model 

 Select Monitor>Running Job at the top of the right-hand menu, then click 

Apply 

o If the Exit Number is 3004, the model has solved correctly 

 Select Read Results>Result Entities>Attach 

o Select the appropriate job from the Available Jobs box 

o Click the Select Results File button and select the appropriate *.t16 

results file 

o Click the Translation Parameters button 

 Select the Import Results check box and make sure the 

increments you are interested in are selected in the Available 

Increments box 

 Click OK 

o Click Apply 

 Select Read Results>Result Entities>Import 

o Click the Select Results File button and select the appropriate *.t16 

results file 
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o Click Apply 

 The results are now ready to be viewed in the Results tab  

D.1.2.8.  RESULTS TAB 

 After you attach the .t16 results in Patran, do the following: 

 To Create a Graph of Results: 

o Select Group > Post and pick all the desired groups named similarly to 

Mesh Set: A1-1 Incr 1:17  

 Note here that the group name could be slightly different 

depending on the number of increments – in this example it is 17. 

o From the Results tab, select Create > Graph > Y vs X  

o In the Select Results  menu 

 Select all desired increments from the Select Result Cases field 

 Y: Global Variable  

 Variable: Pick the deformable contact body, Force (or force 

or moment component that you want to plot) 

o E.g. Body cell_contact, Force X 

 X: Global Variable  

 Variable: Pick another "Global Variable"  

o Choose Time, Increment, rigid contact body 

Position, etc. 

 E.g. Body probe_contact, Position 
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o Format the graph axes in the Display Attributes  menu 

o In the Plot Options  menu 

 Input the appropriate Scale Factor 

 -1000 for all of my models so far 

 Input a name for the plot if desired 

 E.g. Save Graph Plot As: indent or retract 

o Click Apply – at this point you should see the graph of the X and Y 

entities. 

 

Figure D.2. Indentation Results of Finite Element Model 

 To Export Results Data to ASCII file from Graph: 
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o From the XY Plots  box on the menu ribbon, Select Modify  

o Select Modify > Curve 

o Pick the curve to be exported (Usually the curves will be named as 

following “Default_graph  ” or appended with Node number) 

o Click Data from Keyboard 

 In the menu that opens, select either XY Pairs or Y Data as the 

data type 

 XY Pairs will export data from the X and Y axes 

 Y Data will only export data from the Y axis 

 Check the Write XY Data to File box 

 Click Apply and enter a filename and optional title 

 The default file type here is *.xyd, so end the file name 

with .txt to save as a *.txt file 

o *.xyd  and *.txt are both ASCII Files 

D.1.3. MAKING IMPORTED .STL MESHES USABLE IN PATRAN 

D.1.3.1.  USEFUL INFORMATION 

 Search for “convert tria6 mesh to solid” on http://simcompanion.mscsoftware.com 

o Find video: “how to convert a cylinder of tria elements to a solid with tet 

elements (matching the tria mesh)” 

http://simcompanion.mscsoftware.com/
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o Saved as C:\Documents and Settings\finou\My 

Documents\Scott\Research\Image Conversion\Mesh 

Conversion\Convert Mesh To Solid (Patran).avi on lab desktop 

computer 

 You can also find helpful tips at http://www.eng-

tips.com/viewthread.cfm?qid=240225&page=1  

o Forums  >  Engineering Computer Programs  >  General 

Engineering Programs  >  MSC.Software: Patran Forum 

 To confirm element form,  found good image showing node placement on each 

type of mesh element  

o https://visualization.hpc.mil/wiki/EnSight_Gold_-_Geometry_Files 

 

Figure D.3. Types of Elements Supported by Patran 

D.1.3.2.  PROCEDURE FOR PROCESSING IMPORTED .STL MESHES FOR USE IN 

PATRAN 

 Import the mesh from .stl file 

http://www.eng-tips.com/viewthread.cfm?qid=240225&page=1
http://www.eng-tips.com/viewthread.cfm?qid=240225&page=1
https://visualization.hpc.mil/wiki/EnSight_Gold_-_Geometry_Files
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o File > Import, Source: STL 

o Note: STL files are imported as 3 node triangle (tria3) elements, but 

Patran requires 6 node triangle elements (tria6) for converting to 10 node 

tetrahedral elements (tet10) 

 Create a group for the imported elements by selecting Group > Create from the 

menu bar at the top 

o Under New Group Name, give the new group a name (e.g. stl) 

o Click the box for Entity Selection and then select the entire mesh and click 

Apply 

o Select Action: Post, then select only default_group and click Apply 

D.1.3.2.1. UNDER MESHING TAB 

 Verify mesh quality using Verify > Element > Boundaries 

o Select Free Edges, Click Apply 

 There should be nothing showing, indicating no free edges (i.e. 

completely closed geometry) 

 If there are any free edges at all, the mesh will fail 

o Click Reset Graphics, then select Free Faces and click Apply again 

 All faces of the geometry should be highlighted (gold) 

 Click Reset Graphics again 

IF MESH APPEARS TO BE OF GOOD QUALITY VISUALLY AND HAS NO FREE EDGES: 

 Select Modify > Element > Edit 

o Element Attributes: Select Type 
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o New Topology: Tria6 

o Element List: Select entire mesh, click Apply 

 Create > Mesh > Solid 

o Select the Tri Element button  from the toolbar shown to the right 

 This allows the user to select the mesh 

o Input List Select entire mesh 

o Give an appropriate Global Edge Length and click Apply 

 Select Group > Create from the menu bar at the top 

o Enter a New Group Name (e.g. tet) 

o Select the FEM Entity   > Element    > Tet Element  

button from the toolbar shown to the right 

 This allows the user to select only the newly created 

tetrahedral elements 

o Select all of the mesh in the Entity Selection box and click Apply 

o Select Action > Post  

 Select only the newly created group (e.g. tet) and click 

Apply  

 The mesh is now ready for assigning material properties, loads, boundary 

conditions, etc. 

IF MESH DOES NOT APPEAR TO BE OF GOOD QUALITY VISUALLY OR HAS FREE EDGES: 

 Select Group > Create from the menu bar at the top 

o Enter a New Group Name (e.g. stl) 
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o Select all of the mesh in the Entity Selection box and click Apply 

o Select Action > Post  

 Select only default_group and click Apply  

 Select Create > Mesh > On Mesh  to create a new mesh over the old mesh 

o DO NOT select Delete Elements 

 Will cause unwanted random edge deletion 

o Element Shape: Select desired shape 

 Triangle or Quadrilateral 

o Seed Option 

 Uniform: The mesher will create new boundary nodes based on 

input global edge length. 

 Existing Boundary: All boundary edges on input mesh will be 

preserved. 

 Defined Boundary: The mesher will use all the nodes selected in 

the data box Boundary Seeds to define the boundary of the output 

mesh. No other boundary nodes will be created. 

 Boundary Seeds data box = Boundary Hard Nodes data 

box under Feature Selection 

 Both Uniform and Existing Boundary seem to work equally well 

for me so far 

o Check the Feature Recognition box 
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 If checked, the features on the input mesh will be defined 

automatically based on feature edge angles and vertex angles, and 

be preserved on the output mesh. 

 Edge Angle 

 If Feature Recognition is on, an edge on the input mesh will 

be defined as a feature edge and be preserved if the angle 

between the normals of two adjacent triangles is greater 

than the feature edge angle. 

 Vertex Angle 

 If Feature Recognition is on, a node on a feature line will 

be defined as a feature vertex and be preserved if the angle 

of two adjacent edges is less than the feature vertex angle. 

 Mesh on Mesh does not preserve original shape without using 

feature recognition 

o Check the Use Selection Values box if using Defined Boundary or if 

otherwise needed, but so far it has not been necessary for me 

o Select all desired parts of the mesh in the 2D Elem List box 

o Give an appropriate Global Edge Length and click Apply  

 Select Group > Post from the menu bar at the top 

o Post only the group created above (e.g. stl) 

o Either delete the imported mesh or move it out of the way of the new mesh  
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 If the new mesh appears to be of good quality visually and has no free edges, 

follow the directions above, otherwise continue here 

o It may be more easily visualized using the Hidden Line  or Smooth 

Shaded  displays in the Home tab than in the default Wireframe  

mode 

o Mesh on Mesh is sometimes not very good at creating efficient meshes, 

e.g.: 

 

Figure D.4. Difference in Results between Using a Paver Mesher for Mesh on 

Mesh and Using the Default IsoMesh Mesher in Patran 

 Mesh on Mesh appears to use the Advancing Front mesher, 

whereas native Patran geometry seems to be meshed using the 

Delauney Triangulation mesher 
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 See Marc
®
 2010 Volume A: Theory and User Information, 

Chapter 4 Introduction to Mesh Definition, pp. 92 – 93  

 If the new mesh does not appear to be of good quality visually, it will need to be 

remeshed using Global Adaptive Remeshing during Analysis 

 D.2. ASYLUM AFM PROTOCOL 

D.2.1. GETTING STARTED 

1. Open the most recent version of Igor on the desktop 

o Click File>Load AFM Software 

o Close all the windows that open except the Master and Heater panels  

2. In the Main tab of the Master Panel, put the AFM in Contact Mode 

o Should see the following: 

 Sum 

 Deflection 

 Lateral 

 Z Voltage 

3. Make sure AFM is laterally level 

4. Find the probe using the mirror knobs in the very back (and using focus wheel if 

necessary), find the laser, put the laser at the tip of the probe 

5. Use the dials on the back and right side of the AFM to move the laser and 

Maximize the Sum 
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6. Use the dial on the left side of the AFM to Zero out the Deflection 

7. Hit Engage and use the dial on the front of the AFM to move down toward the 

surface 

8. It should ‘ding’ when the deflection hits one 

o Continue to move down very slowly and center out the Z voltage 

D.2.2. APPROXIMATE SEPARATION DISTANCE 

 The distance between the tip and the top of the sample 

 

1
 

 

Figure D.5. AFM Indentation Curve Demonstrating Approximate Separation 

Distance 

D.2.3. CONTROL/FORCE CURVES 

                                                
1
 Hemmer, J.D., et al., Role of Cytoskeletal Components in Stress-Relaxation Behavior of Adherent Vascular Smooth 

Muscle Cells. Journal of Biomechanical Engineering-Transactions of the ASME, 2009. 131(4): p. 9. 
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 Go to the Force Panel of the Master Tab 

 Set Force Dist = 10 µm 

 Set Velocity = 5 µm/s 

 In the Save tab 

o Uncheck Save to Disk 

o Give Base Name as “Control” 

o Click the Path button  Browse  Browse  Select folder for data  

OK  Close with  

 In the Misc. tab 

o Set Trigger Channel to Deflection 

o Set Trigger Point = 100 nm 

 Click Single Force 

o After it finishes, if it didn’t find the surface slide the red bar on the left to 

try to find the surface 

 Make sure neither axis is reversed 

 Once the surface has been found, set Trigger Channel to None and keep 

tweaking the red bar and using Single Force until the curves look good 

 Once a good curve has been obtained, click on the force graph, then press Ctrl-I 

o Drag the A circle to the bottom of the linear portion of the red line and the 

B square to the top 
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Figure D.6. Diagram of Deflection Sensitivity Calibration Markers 

 In the Cal. Tab 

o Input the Spring Constant 

o Click Set Sensitivity  DeflInVOLS 

 In the Save tab 

o Check Save to Disk 

 Click Continuous 

o When suffix reaches 0004, click Stop Forces 

o Should have 5 control curves 

 For Force Curves, change Base Name and, if needed, Path 

D.2.4. STRESS RELAXATION 

 Use Ctrl-I to see depth with circle and square (dX = depth) 

 Dwell FB Z sensor 

 Dwell Toward Surface 

 Set Dwell Time 
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 Use checked box for Dwell Rate 

 Trigger Channel: Raw Z Sensor 

 Trigger Point = square x-position 

  

D.3. Solution Preparations 

D.3.1. VSMC MEDIA 

10% FBS, 1% Anti/Anti (or Pen/Strep if antifungal agent must be avoided) 

Into 500 mL High Glucose DMEM, add: 

 56.2 mL FBS 

 5.6 mL Anti/Anti 

o 2.8 mL Penicillin/Streptomycin  

o 2.8 mL Amphotericin B 

D.3.2. SERUM-FREE VSMC MEDIA (FOR INDUCTION OF CONTRACTILE 

PHENOTYPE) 

1% Anti/Anti (or Pen/Strep if antifungal agent must be avoided) 

Into 500 mL High Glucose DMEM, add: 

 5.05 mL Anti/Anti 

o 2.525 mL Penicillin/Streptomycin  

o 2.525 mL Amphotericin B 
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D.3.3. COLLAGEN 

50 µg/mL 

From stock solution of 8.58 mg/mL: 5.83 µL per mL PBS 

 To 5 mL PBS, add 29.14 µL stock solution 

1 mg/mL 

From stock solution of 8.58 mg/mL: 116.55 µL per mL PBS 

 To 5 mL PBS, add 582.8 µL stock solution 

D.3.4. CELLMASK™ DEEP RED PLASMA MEMBRANE STAIN 

5 µg/mL – For Live Cells (let sit on cells at 37°C for 5 min) 

From stock solution of 5 mg/mL: 1 µL per mL cell media 

 To 5 m  media, add 5 µ  CellMask™ stock solution 

7 µg/mL – For Live Cells (let sit on cells at 37°C for 5 min) 

From stock solution of 5 mg/mL: 1.4 µL per mL cell media 

 To 5 mL media, add 7 µ  CellMask™ stock solution 

D.3.5. DAPI 

25 µg/mL – For Live Cells (let sit on cells at 37°C for 1 hr) 

From stock solution of 5 mg/mL DAPI: 5 µL DAPI stock solution per mL cell media 

 To 5 mL media, add 25 µL DAPI stock solution 

300 nM DAPI (1:50,000) – For Fixed Cells 

From stock solution of 5 mg/mL DAPI: 0.02105 µL DAPI stock solution per mL PBS 

 To 50 mL PBS, add 1.05 µL DAPI stock solution 
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 To 100 mL PBS, add 2.11 µL DAPI stock solution 

Stock solution 

5 mg DAPI powder per mL water 

D.4. Staining Cells for Actin, Nucleus, and Microtubules 

1. 30 min PBS/0.01 M Glycine/0.1% Triton-X 

 To make 50 mL: 50 mL PBS/0.0375 g Glycine/ 0.05 mL Triton-X 

2. 15 min 5% BSA/PBS 

3. 15 min 5% Normal Serum (1% BSA/PBS) 

4. Overnight Primary Antibody (1% BSA/PBS) @ 4°C (1:100) 

**************** DON’T THROW PRIMARY AWAY! **************** 

5. 2 x 15 min Rinse with 1% BSA/PBS 

6. 15 min 5% Normal Donkey Serum (1% BSA/PBS) 

*********************** COVER WITH FOIL *********************** 

7. 2 hours Secondary Antibody (1% BSA/PBS) @ 37°C (1:100) 

8. 15 min Rinse with 1% BSA/PBS 

9. 2 x Rinse with PBS 

10. 15 min 488 Phalloidin in PBS Shaking at RT (1:100) 

11. 3 x Rinse with PBS 

9.  

10. If not mounting for microscopy: 

12. 5 min DAPI in PBS Shaking at RT (300 nM) 

13. 3 x Rinse with PBS 
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11.  

12. If mounting for microscopy 

13. Mount with SlowFade
®
 Gold antifade reagent with DAPI (Invitrogen: S36939) 
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APPENDIX E 

ROLE OF CYTOSKELETAL COMPONENTS IN STRESS 

RELAXATION BEHAVIOR OF ADHERENT VASCULAR 

SMOOTH MUSCLE CELLS  

E.1. Introduction 

The results presented in this appendix were part of a study published in the Journal of 

Biomechanical Engineering [1]. The published study investigated the role of various 

cytoskeletal components play in the stress relaxation behavior of adherent VSMCs by 

treating VSMCs with various agents that either enhance or prevent polymerization of 

specific cytoskeletal filaments. The work presented in this appendix pertains specifically 

to the qualitative analysis of the effects of those cytoskeletal agents and is presented here 

directly from the published study. 

E.2. Materials and Methods 

Smooth muscle cells isolated from adult male Sprague-Dawley rat aortal explants 

were cultured in Dulbecco’s Modified Eagle’s Medium (DMEM) (Mediatech, Herndon, 

VA) supplemented with fetal bovine serum (FBS) (10 %) (Sigma, St. Louis, MO) and 

antibiotic/antimycotic (1 %) (Sigma). Cells were maintained in a humidified, 37 ºC, 5% 

CO2, 95% air environment. Prior to AFM experiments, cells were seeded onto 22 x 22 
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mm glass coverslips coated with type I collagen (Vitrogen 100, Cohesion Technologies, 

Palo Alto, CA) at a density of 150,000 cells per coverslip. Seeded coverslips were 

incubated in 6-well plates with DMEM (10% FBS) at 37 ºC with 5% CO2 for 3 to 5 days 

prior to AFM experimentation. Cells were used in experiments between passages 5 and 8. 

E.2.1. CYTOSKELETAL AGENTS 

To assess the role of actin filaments in VSMC stress relaxation behavior, cells were 

treated with either 1 μM cytochalasin D (Sigma, St. Louis, MO) or  .1 μm jasplakinolide 

(Fisher Scientific, Pittsburgh, PA) at 37 °C for 1 hour prior to tests. Cytochalasin D is an 

actin depolymerizing agent that caps the barbed end of F-actin, while jasplakinolide is an 

actin stabilizing agent that binds to both ends of actin filaments, preventing 

depolymerization. Likewise, to determine the role of microtubules in stress relaxation 

behavior, groups of cells were treated with either 2  μm nocodazole or 1  μM paclitaxel 

(both from Sigma) at 37 °C for 1 hour to induce microtubule depolymerization or 

hyperpolymerization, respectively. Both nocodazole and paclitaxel bind to β-tubulin; 

however, the former disrupts and the latter stabilizes microtubules. Concentrations of all 

cytoskeletal agents were chosen based on published research [2-4] or based on our own 

experience, as in the case of cytochalasin D, where we chose the maximum concentration 

that can be used without inducing cell detachment. Control groups for each experiment 

consisted of cells treated only with the equivalent amount of vehicle (DMSO) for these 

cytoskeletal agent treatments. 
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E.2.2. IMMUNOFLUORESCENCE.  

Immunofluorescence staining was used to visualize actin filaments and microtubules. 

Cells were fixed in 4% paraformaldedyde at room temperature for 30 minutes following 

cytoskeletal-agent treatments at the same time points as the cells for the corresponding 

AFM experiments. The cells were then incubated with blocking solution consisting of 

PBS (90%) (Sigma), bovine serum albumin (3.8%) (Sigma), donkey serum (3.0%) 

(Sigma), and Triton-X (0.2%) (Sigma) for 30 minutes. This was followed by incubation 

with either Alexa Fluor 488 conjugated phalloidin (Sigma) at room temperature for 15 

minutes for actin staining or alpha- and beta-tubulin primary antibodies (Hybridoma 

Bank, U. of Iowa) at 4°C overnight for microtubule staining. The microtubule-stained 

cells were further incubated with a TRITC-conjugated secondary antibody (Invitrogen, 

Inc., Carlsbad, CA) the following day for 2 hours and then with DAPI for 5 minutes 

(Invitrogen, Carlsbad, CA). All samples were viewed using an Olympus IX71 inverted 

microscope (Olympus, Tokyo, Japan); images were subsequently collected and processed 

using HCImage software (Hamamatsu Corp., Bridgewater, NJ). 

E.3. Results 

Untreated VSMCs exhibited normal actin (Figure E.1(a)) and microtubule structure 

(Figure E.1(b)). Immunofluorescence imaging of actin (Figure E.1(c)) and microtubules 

(Figure E.1(d)) in cytochalasin D-treated VSMCs revealed significant disruption of actin 

stress fibers and no identifiable changes to microtubule structure. Nocodazole-treated 

VSMCs showed significant microtubule disruption (Figure E.1(f)) without any changes  



272 

 

 

Figure E.1. Immunofluorescence images of untreated VSMC (a ) actin and (b) 

microtubules; cytochalasin D-treated VSMC (c) actin and (d) microtubules; 

nocodazole-treated VSMC (e) actin and (f) microtubules; paclitaxel-treated 

VSMC (g) actin and (h) microtubules; jasplakinolide-treated VSMC (i) actin and 

(j) microtubules. Scale bars represent 5  μm. 

to actin structure (Figure E.1(e)). No consistent visual differences were observed with 

actin or microtubule structure in paclitaxel-treated VSMCs (Figure E.1(g) and 5(h)), 

although some cells did appear to exhibit denser microtubule content with less free 
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tubulin. No visual differences were observed in actin or microtubules (Figure E.1(i) and 

5(j)) of jasplakinolide-treated VSMCs. 
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